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Welcome 
Thank you for purchasing a LeCroy product. We're certain you'll be 
pleased with the detailed features so unique to our instruments. 

This WaveRunner 6 Zi Online Help file may be accessed from your 
oscilloscope with the intention of Operator's Manual usage. Sections can 
be printed and the file itself can be saved to a USB memory device. 

The information/content in this help file is arranged in the following 
manner: 

WaveRunner 6 Zi Features 

First, we cover the hardware and software features of your instrument in 
the following sections: 

 Hardware 

 Basic Controls 

 Probe and Signal Connection Interfaces 

 Display Dashboard 

 Turning on Channels and Traces 

Core Oscilloscope Functions 

This section covers the core functions of LeCroy oscilloscopes. 

Compatible Options and Accessories 

Subsequent sections demonstrate the related Options and Accessories 
available for your product. 

Reference 

The Reference section is set aside and covers items like Technical 
Support contact information and Safety Requirements. The LeCroy 
website at www.lecroy.com always maintains the most current 
specification information. The website should always be checked for 
frequent updates. 

Support 

When your product is delivered, verify that all items on the packing list or 
invoice copy have been shipped to you. 

http://www.lecroy.com/
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Contact your nearest LeCroy customer service center or national 
distributor if anything is missing or damaged. If there is something 
missing or damaged, and you do not contact us immediately, we cannot 
be responsible for replacement. 

Thank You 

We truly hope these materials provide increased comprehension when 
using LeCroy's fine products. 

Sincerely, 

 

David C. Graef 

LeCroy Corporation 
Vice President and Chief Technology Officer 

Safety Requirements 

This section contains information and warnings that must be observed to 
keep the instrument operating in a correct and safe condition. You are 
required to follow generally accepted safety procedures in addition to 
the safety precautions specified in this section. 

Safety Symbols 

Where the following symbols appear on the instrument’s front or rear 
panels, or in this manual, they alert you to important safety 
considerations. 

 

This symbol is used where caution is required. Refer to the 
accompanying information or documents in order to protect against 
personal injury or damage to the instrument. 

 

This symbol warns of a potential risk of shock hazard. 
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This symbol is used to denote the measurement ground connection. 

 

This symbol is used to denote a safety ground connection. 

 

On (Supply). This is the AC mains connect/disconnect switch at the back 
of the instrument (if provided). 

 

Off (Supply). This is the AC mains connect/disconnect switch at the back 
of the instrument (if provided). 

 

This symbol shows that the switch is a Standby (power) switch located on 
the front of the oscilloscope. Pressing this button toggles the 
oscilloscope’s state between operating and Standby mode. This switch is 
not a disconnect device. The instrument can only be placed in a complete 
Power Off state by flipping the main power switch on the rear of the 
instrument (if provided) to the off (Zero) position or by removing the 
power cord. In cases where no main power switch is provided, removing 
the main power cord is the disconnect device. 

 

This symbol is used to denote Alternating Current. 
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CAUTION 

The CAUTION sign indicates a potential hazard. It calls attention to a 
procedure, practice or condition which, if not followed, could possibly 
cause damage to equipment. If a CAUTION is indicated, do not proceed 
until its conditions are fully understood and met. 

WARNING 

The WARNING sign indicates a potential hazard. It calls attention to a 
procedure, practice or condition which, if not followed, could possibly 
cause bodily injury or death. If a WARNING is indicated, do not proceed 
until its conditions are fully understood and met. 

CAT I 

Installation (Overvoltage) Category rating per EN 61010-1 safety 
standard and is applicable for the oscilloscope front panel measuring 
terminals. CAT I rated terminals must only be connected to source 
circuits in which measures are taken to limit transient voltages to an 
appropriately low level. 

Operating Environment 

The instrument is intended for indoor use and should be operated in a 
clean, dry environment. Before using this product, ensure that its 
operating environment is maintained within these parameters: 

Temperature: 5 to 40 °C. 

Humidity: Maximum relative humidity 80 % for temperatures up to 31 °C 
decreasing linearly to 50 % relative humidity at 40 °C (or at the upper 
operational temperature limit). 

Altitude: Up to 10,000 ft (3,048 m) at or below 25 °C. 

Note: Direct sunlight, radiators, and other heat sources should be taken 
into account when assessing the ambient temperature.  
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 WARNING 

The oscilloscope must not be operated in explosive, dusty, or wet 
atmospheres. 

 CAUTION 

Protect the oscilloscope's display touch screen from excessive impacts 
with foreign objects. 

 CAUTION 

Do not exceed the maximum specified front panel terminal voltage 
ratings. Refer to Specifications for more details. The specifications for 
maximum allowable voltages are located on a label on the front of the 
oscilloscope.  

Safety Certification 

The design of the instrument has been verified to conform to applicable 
EN 61010-1, UL 61010-1 2nd Edition and CSA C22·2 No·61010-1-04 safety 
standards for the following limits: 

 Installation (Overvoltage) Categories II (Mains Supply Connector) 
& I (Measuring Terminals). 

 Pollution Degree 2. 

 Protection Class I. 

PLEASE NOTE THE FOLLOWING: 

 Installation (Overvoltage) Category II refers to local distribution 
level, which is applicable to equipment connected to the mains 
supply (AC power source).  

 Installation (Overvoltage) Category I refers to signal level, which is 
applicable to equipment measuring terminals that are connected 
to source circuits in which measures are taken to limit transient 
voltages to an appropriately low level. 
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 Pollution Degree 2 refers to an operating environment where 
normally only dry non-conductive pollution occurs. Conductivity 
caused by temporary condensation should be expected. 

 Protection Class 1 refers to grounded equipment, in which 
protection against electric shock is achieved by Basic Insulation 
and by means of a connection to the protective ground conductor 
in the building wiring. 

Cooling 

The instrument relies on forced air cooling with internal fans and 
ventilation openings. Care must be taken to avoid restricting the airflow 
around the apertures (fan holes) on any side of the oscilloscope. For 
sides and rear apertures, ensure adequate ventilation by leaving the 
required 10 cm (4 inch) minimum gap around the sides and rear of the 
instrument. For bottom apertures, the oscilloscope feet (up or down) 
provide adequate clearance. Ensure at least the minimum feet clearance 
is achieved as paper or light objects can be drawn to and obstruct the 
opening(s). 

 CAUTION  

Do not block oscilloscope ventilation holes. For models with bottom 
apertures, always keep items like sheets of paper clear of the 
oscilloscope bottom. 

The instrument also has internal fan control circuitry that regulates the 
fan speed based on the ambient temperature. This is performed 
automatically after start-up with no manual intervention required. 

 CAUTION 

Do not allow any foreign matter to enter the oscilloscope through the 
ventilation holes, etc. 

AC Power Source 

100 to 240 VAC (+/-10%) at 45-66 ; 100-120 VAC at 380-420 Hz; 
Automatic AC voltage selection; Installation Category: 300V CAT II  
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No manual voltage selection is required because the instrument 
automatically adapts to line voltage. 

Power Consumption 
Power Consumption (Nominal): 400 Watts (400 VA) 
Max Power Consumption (with all PC peripherals, active probes connected to 4 
channels, and MSO active): 500 Watts (500 VA) 
Power consumption (in Standby Mode): 15 Watts 

Power and Ground Connections 

The instrument is provided with a 10A/250V 18AWG rated grounded 
cord set containing a molded three-terminal polarized plug and a 
standard IEC320 (Type C13) connector for making line voltage and safety 
ground connections. The AC inlet ground terminal is connected directly 
to the frame of the instrument. For adequate protection against 
electrical shock hazard, the power cord plug must be inserted into a 
mating AC outlet containing a safety ground contact. Ensure that the 
disconnect device is readily accessible. 

 WARNING - Electrical Shock Hazard 

Only use the power cord provided with your instrument. 

Any interruption of the protective conductor inside or outside of the 
oscilloscope, or disconnection of the safety ground terminal creates a 
hazardous situation. Intentional interruption is prohibited. 

In Standby mode, the oscilloscope is still connected to the AC supply. The 
instrument can only be placed in a complete Power Off state by flipping 
the main power switch on the rear of the instrument (if provided) to the 
off (Zero) position or by removing the power cord. In cases where no 
main power switch is provided, removing the main power cord is the 
disconnect device. 

 CAUTION  
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Always use the Power Switch or File → Shutdown command in the 
software to properly shut down your instrument. 
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Never substitute this practice by pulling the instrument power cord from 
the socket or shutting down a connected power strip. 

 CAUTION 

The outer conductors of the front panel BNC or ProBus terminals for all 
input channels are connected to the instrument’s chassis and therefore 
to the safety ground. 

Standby (Power) Switch and Oscilloscope Operational 
States 

On some models, the Standby (Power) switch controls the operational 
state of the oscilloscope. This toggle switch is activated by momentarily 
pressing and releasing it. 

Also on certain models, the color of the LED below the switch indicates 
the status of the oscilloscope as follows: 

 On (LED Green)* – oscilloscope is fully powered and operational 

 Standby (LED off)* – oscilloscope is powered off (except for some 
housekeeping circuits) 

 Standby (LED Blinks Green) – oscilloscope’s computer subsystems 
(hard drive, etc.) are in Standby (reduced Power mode). All other 
oscilloscope subsystems are fully powered. 

* Factory Settings 

The oscilloscope’s factory settings result in only two basic oscilloscope 
states: On or Standby. In the case of Standby, the oscilloscope is 
powered off with the exception of some housekeeping circuitry. The 
oscilloscope can only be placed in a complete power off state by flipping 
its main power switch to the Off (zero) position, or by unplugging the 
instrument’s power cord from the primary power source (AC outlet). It is 
recommended that the power cord be unplugged from the AC outlet if 
the oscilloscope is not being used for an extended period of time.  
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Changes can be made to the oscilloscope's original factory settings via 
the Power Options Properties menu in Windows under Control Panel → 
Power Options. A Windows Power Option named Standby provided 
control of only the oscilloscope’s computer subsystems (CPU, hard drive, 
etc.) and did not affect the other subsystems within the oscilloscope. In 
general, these other subsystems remain fully powered. For additional 
information on setting these Power Options, see the Windows Help 
menu or other related technical documentation. In terms of control 
buttons, this oscilloscope uses only a power button/switch and therefore 
references to a sleep button are not applicable. 

The oscilloscope can always be placed in the Standby state (LED Off) – 
Power Off (except for some housekeeping circuits) by pressing and 
holding in the Standby toggle switch for approximately 5 seconds. 

 CAUTION 

Hibernate mode is not supported by the Power button. Therefore, 
Windows® Power Options must not be changed from the default Never 
setting to System Standby or System Hibernate modes. 

 CAUTION 

Always use the Power Switch or File → Shutdown command in the 
software to properly shut down your instrument. Never substitute this 
practice by pulling the instrument power cord from the socket or 
shutting down a connected power strip. 

Calibration 

The recommended calibration interval is one year. Calibration should be 
performed by qualified personnel only. 

Cleaning 

Clean only the exterior of the instrument, using a damp, soft cloth. Do 
not use chemicals or abrasive elements. Under no circumstances allow 
moisture to penetrate the instrument.  
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Avoid electrical shock hazard by unplugging the power cord from the AC 
outlet before cleaning. 

 WARNING - Electrical Shock Hazard 

 No operator serviceable parts inside. 

 Do not remove covers. 

 Refer servicing to qualified personnel. 

Abnormal Conditions 

Operate the instrument only as intended by the manufacturer.  

If you suspect the oscilloscope’s protection has been impaired, 
disconnect the power cord and secure the instrument against any 
unintended operation. 

The oscilloscope’s protection is likely to be impaired if, for example, the 
instrument shows visible damage or has been subjected to severe 
transport stresses. 

Proper use of the instrument depends on careful reading of all 
instructions and labels. 

 WARNING 

Any use of the oscilloscope in a manner not specified by the 
manufacturer may impair the instrument’s safety protection. 
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Hardware 

Front Panel 

Numbered labels on this image correspond with descriptions on the 
following table. 

 

Number and Description  

1. Power Button 
2. Channel Inputs 
3. EXT Input and 

AUX Output 
connectors 

4. Ground 
Connector and 
Probe 
Calibration Hook 

5. USB Connections 
and LeCroy Bus 
Port 

6. Front Panel 

7. Rotating 
Display Release 
Switch 

8. Touch Screen 
Stylus 
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Rotating and Tilting the Display 

The display panel allows for Rotation and Tilting adjustments. These 
adjustments allow you to position your instrument with unmatched 
versatility. 

Rotate and Tilt your display using the following instructions: 

Note: Your oscilloscope should always be firmly planted on a solid 
supporting surface at all times. 

ROTATING THE DISPLAY 

Rotate the display by firmly grasping the left side of the display. Use your 
thumb to push upward on the release switch (on the front-left side of the 
display), and then use your wrist to forcibly rotate the display in an 
upward, clockwise twisting motion until the display locks into portrait 
position. 

 
Rotating the display from landscape (horizontal) to portrait (vertical) 

positioning. 
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The user interface then adjusts its layout from landscape (horizontal) to 
portrait (vertical). This setup is ideal for viewing high-amplitude signals. 

 
The Rotating Display shown in portrait layout position. 

Reverse the process by grasping the now upper side of the display. Again, 
use your thumb to push upward on the release switch; but, now use your 
wrist to forcibly rotate the display in a downward, counter-clockwise 
twisting motion until the display locks back into landscape position. 

The user interface then adjusts the layout back from portrait (vertical) to 
landscape (horizontal). 

TILTING THE DISPLAY 

The display can be tilted (while in either Landscape or Portrait mode) 
into Upward or Downward positioning for convenience. 
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Tilt the display by firmly grasping the far left side of the display and the 
far right side of the front panel. Use your wrists to forcibly tilt the display 
by pushing the upper-portions forward (to tilt upward) or the lower-
portions backward (to tilt downward) until the desired positioning is 
reached. 

 
Tilting the display by pushing the upper-portions of the display/front panel 

forward - tilting the display from downward to upward positioning. 
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I/O Panel 

The I/O Panel is located on the right side (facing) of the instrument as 
follows: 

 

Note: A LeCroy Bus (LBUS) connection is located on the Front Panel (on 
page 13). 

   

Numbered labels on the following I/O Panel image correspond with 
descriptions on the following table. 

Number and Description 

1. USB488 
Connection 

2. USB A 
Connections 

3. Ethernet Port 

4. Microphone 
Connection 

5. Speaker 
Connection 

6. Line In 
Connection 

7. External VGA 
Monitor 
Connection 
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Note: Contact a system administrator when connecting to any internal 
LAN. 

Back Panel 

The AC Power Plug is located on the back panel of your instrument. 

 

Note: The WaveRunner 6 Zi has a removable hard drive option. Contact 
your LeCroy representative for details using Contact LeCroy for 
Support (on page 188). 
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Basic Controls 

Hardware and Software Controls 

The following Basic Control topics cover the general usage of the 
hardware buttons located on the oscilloscope's front panel and the 
screen control interface elements of the software. 

Front Panel Controls 

Note: Many front panel controls directly correspond with screen layout 
controls. For example, the Print front panel general control button 
corresponds with the Hardcopy function at Utilities → Utilities Setup 
→ Hardcopy. 

The following picture shows the front panel. 
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Front Panel Groupings 

The front panel is divided into sections based on various functions. The 
following topics explain these sections in more detail. 

Miscellaneous Setup Controls and WaveStream Indicator 

This topmost section of the front panel provides the following functions: 

 

 Touch Screen -  By default this button's blue backlit LED is ON and 
the touch screen is enabled. By pressing this button and turning 
off the LED, the touch screen is then disabled. 

 Print - Press this button and it automatically executes the based 
on the settings you've made as described in Printing and 
Hardcopy Functions (on page 161). 

You can set the oscilloscope to automatically spool directly to a 
printer, to a file, an email (with attachment), or to the clipboard.  

 Scope Setup - Press once and the Scope Setup flyout menu is 
shown. The Scope Setup flyout menu quickly provides access to 
Auto Setup, C1 Find Scale, C2 Find Scale, C3 Find Scale, C4 Find 
Scale, and Default Setup buttons. These functions perform various 
automatic setup configurations to your instrument. This 
corresponds to the Auto Setup... selection on the menu bar from 
the Vertical, Timebase, or Trigger menus. 

 

Press the Auto Setup... button on the flyout menu to perform a 
full auto setup. Press a Channel Find Scale button on the flyout 
menu to perform a quick auto setup for that channel only. Press 
the AUTO SETUP... front panel button twice to perform the last 
selection from the Auto Setup... flyout menu (the default is to 
perform a full auto setup). 
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If Auto Setup is run when no channels are turned on, all channels 
are affected. When more than one channel is turned on, the first 
channel with a signal applied to it is automatically set up for edge 
triggering. 

Perform an autosetup of all these functions together by pressing 
the Auto Setup... front panel button. 

 Clear Sweeps - Press to clear data from multiple sweeps 
(acquisitions) including: persistence trace displays, averaged 
traces, parameter statistics, and Histicons. During waveform 
readout, cancels readout. This is the same as pressing Clear 
Sweeps on the Measure → Measure Setup... or Math → Math 
Setup dialogs. 

 WaveStream - Indicates when WaveStream mode is ON. Refer to 
WaveStream Mode (on page 96) for more information. 

 Intensity - Press to toggle between WaveStream OFF and ON for 
Analog Persistence and WaveStream ON for Color Persistence. 
When you turn the knob, if WaveStream is ON, the WaveStream 
display intensity changes. When you turn the knob, if WaveStream 
is OFF, changes the Intensity setting. Corresponds with the screen 
menu selection: Display → Display Setup (on page 89). 

Trigger Front Panel Controls 

 

 Level - Press to toggle between 50% trigger level and the previous 
level setting. Turn to change the trigger threshold level. This level 
is indicated on the Trigger label. 
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 READY and TRIG'D Indicators - The READY indicator is lit when the 
trigger is armed. TRIG'D is lit momentarily when a trigger occurs. A 
fast trigger rate causes the light to stay lit continuously.  

 Setup - Press once to open the Trigger Setup... dialog. 
Corresponds with screen menu selection: Trigger → Trigger 
Setup.... Press the Trigger SETUP front panel button again to close 
the Trigger Setup... dialog. 

 Trigger Scan - Pressing the Trigger Scan button opens the 
TriggerScan dialog to help you quickly find rare waveform glitches 
and anomalies. 

 Source - This button directly selects through the available Source 
field values (C1, C2, C3, C4, Dig, EXT, and Line) usually accessed on 
the Setup section of the main Trigger dialog. 

 Slope - This button directly selects through the available Slope 
field values (Positive, Negative, or Either) usually accessed on the 
Setup section of the main Trigger dialog. 

 Coupling - This button directly selects through the available 
Coupling field values - DC, AC, LFR (Low-Frequency Rejection), or 
HFR (High-Frequency Rejection) - usually accessed on the Setup 
section of the main Trigger dialog. 

 Auto - Press to turn on Auto Trigger mode, which triggers the 
oscilloscope after a time-out, even if the trigger conditions are not 
met. 

 Normal  - Press to turn on Normal Trigger mode, which triggers 
the oscilloscope each time a signal is present that meets the 
conditions set for the type of trigger selected. 

 Single  - Press to turn on Single Trigger mode, which arms the 
oscilloscope to trigger once (single-shot acquisition) when the 
input signal meets the trigger conditions set for the type of trigger 
selected. If the scope is already armed, it will force a trigger. 

 Stop - Press to prevent the scope from triggering on a signal. If 
you boot up the instrument with the trigger in Stop mode, a no 
trace available message is shown. Press the Trigger AUTO front 
panel button to display your trace. 
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Horizontal Front Panel Controls 

Note: Horizontal front panel controls can be applied to signals, Math, 
Zoom, or Memory traces. See Math, Zoom, and Memory Indicators 
and Controls (on page 24) for more information. 

 

 Delay - Press to toggle between a zero horizontal delay value and 
the previous horizontal delay value. Turn to change the horizontal 
delay value. 

 Time/Div - Turn to set the time/division of the oscilloscope 
timebase (acquisition system). When using this Horizontal control 
on a Math, Zoom, or Memory trace, you can press this button to 
toggle between fixed and variable adjustments. Turn the knob to 
change the value. 

Vertical Front Panel Controls 

Note: Vertical front panel controls can be applied to signals, Math, 
Zoom, or Memory traces. See Math, Zoom, and Memory Indicators 
and Controls (on page 24) for more information. 
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 Channels - The channel buttons (1 - 4 and Digital) control both 
channel ON/OFF and which channel is active for the Vertical Offset 
and Volts/Div knobs controls. If a channel is OFF, pressing that 
channel button turns it on and makes it active. If a channel button 
is ON, pressing that channel button makes it active, and then 
pressing it a second time turns it OFF. 

 Offset - Press to toggle between a zero vertical offset value and 
the previous vertical offset value for the selected channel. Turn to 
change the vertical offset value for the selected channel.  

 Gain - Press to toggle between fixed and variable gain adjustment. 
Turn to change the gain value. 

Math, Zoom, and Memory Indicators and Controls 

 

 When pressed, the Zoom automatically creates a Zoom trace of all 
active channels. Math and Memory traces must first be enabled 
on their respective dialogs in Math → Math | Memory Setup... for 
use by the front panel controls. 

 When Math, Zoom, or Memory traces are enabled - see Math → 
Math | Zoom | Memory Setup..., respectively - the corresponding 
indicator light illuminates and the Horizontal and Vertical controls 
specifically control the Math, Zoom, or Memory trace. 

 The Push - Variable function on the Time/Div front panel control 
for Horizontal only applies to Math, Zoom, or Memory traces and 
not Channels. Press the button to toggle between fixed and 
variable adjustments or turn the knob to change the value. 
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The WavePilot Control Area and The SuperKnob 

THE WAVEPILOT CONTROL AREA AND THE SUPERKNOB OVERVIEW 

The WavePilot Control Area contains buttons that correspond to specific 
functions.  

These function buttons are used together with the SuperKnob to provide 
increased instrument control at your fingertips. 

The SuperKnob is a joystick-like knob in the center of the WavePilot 
Control Area used to make selections or provide specific values. 

 
The SuperKnob shown on the WavePilot Control Area. 

SuperKnob Field Control and the Adjust Help Flyout Menu 

Whenever you access a non-text entry or file browsing control on a 
dialog, the Adjust Help Flyout menu is shown. 

 
The Probe Attenuation control value being changed using the SuperKnob. 
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Control values can be adjusted using the touch screen, a connected 
mouse, or by use of the SuperKnob. Turning the SuperKnob moves 
through available control values and, as indicated by the Help Flyout 
menu, pressing the SuperKnob provides Toggle Variable functionality; 
meaning, fine and coarse adjustments (if available for the particular 
control) may be selected for use. 

The WavePilot Control Area provides powerful control of Cursors, 
Decode, WaveScan, History, LabNotebook, and Spectrum by their 
respective function buttons on the front panel. Based on the function 
button selected, additional functions are then available on the 
SuperKnob. 

PLEASE NOTE THE FOLLOWING:  

 Not all functions have a function assigned to each (or any) left, 
right, up, or down SuperKnob control. Some only have one or 
two controls. Deactivated SuperKnob control directions are 
shown as un-labeled and grayed-out on respective Help Flyout 
menus. 

 The name of the current mode being used is shown vertically on 
the left side of the Help Flyout menu. 

 When a function button is pressed and the SuperKnob control 
changes, a corresponding clearly-labeled, Help Flyout menu 
indicates additional functions available when using the 
SuperKnob to joystick in left, right, up, or down directions. 

 
The Table Mode Help Flyout menu for the Spectrum Function button. 
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 Some models have Table and Zoom LED indicators along with 
Adjust. Others have only an Adjust LED with Zoom and Table 
buttons containing backlit LEDs. 

ZOOM AND TABLE BUTTONS 

The Zoom and Table buttons may (or may not) provide additional control 
for a specific WavePilot funciton you have selected. 

Zoom Button 

With the Zoom button selected (for a function that has the Zoom 
control) you can twist the SuperKnob dial to adjust the zoom value for 
your displayed waveform. 

Table Button 

With the Table control selected (for a function that has the Table control) 
you can joystick up or down to Page Up or Down through the table 
results. You can also twist the SuperKnob dial to sequentially navigate 
each row of the table results. 

The remaining topics in this section provide more detail when operating 
specific function buttons on the WavePilot Control Area and when using 
the SuperKnob. 

CURSORS 

Use the SuperKnob to adjust Cursors by pressing the Cursors function 
button. Once pressed, the Cursors Help Flyout menu is shown. 

Note: For more information about the use of Cursors, see Measuring 
with Cursors (on page 102). 

Horizontal, Off, and Vertical 

Pressing the Cursor Function button moves through states for Horizontal 
Absolute, Horizontal Relative, Vertical Absolute, Vertical Relative, and 
Off. 

LED's surrounding the SuperKnob provide visual indication of cursor 
status as follows: 

 When opposing LED's (Top/Bottom and Left/Right) are lit, the 
cursors are in a Relative state. 
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 When no LED's surrounding the SuperKnob are lit, the cursors are 
in an Absolute or Off state. 

Using the SuperKnob with Cursors 

The SuperKnob joystick is used for cursor control while in Horizontal and 
Vertical states in the following manner: 

 Horizontal - Cursors Help Flyout menu is shown with instructions 
for left and right joystick use of the SuperKnob described as 
Leftmost and Rightmost. When either is selected, you can twist 
the SuperKnob to adjust the respective cursor. 

 Vertical - Cursors Help Flyout menu is shown with instructions for 
left and right joystick use of the SuperKnob described as Topmost 
and Bottommost. When either is selected, you can twist the 
SuperKnob to adjust the respective cursor. 

 Pushing the SuperKnob button changes the cursor control from 
the two available states with the added state of tracking (moving 
the pair together in parallel). 

 You can force cursors to swap identities in the event where one is 
adjusted past the level of its other extreme. Meaning, if you were 
to adjust a bottommost cursor above its respective topmost 
cursor, the bottommost would then become the topmost and vice 
versa. 

Note: Zoom and Table buttons are not used for Cursors. 

DECODE 

When first pressing the Decode function button, the Serial Decode dialog 
is shown. Subsequent presses of the Decode function button produce the 
following results: 

 If you haven't enabled a Decode signal, it Closes the Serial Decode 
dialog. 

 If you have enabled a Decode signal, it Closes the Serial Decode 
dialog and disables the Decode signal. 

 If you have enabled a Decode signal, and the Serial Decode dialog 
is closed or a different dialog is currently opened (say, the Zoom 
dialog), the Serial Decode dialog is Opened. 
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Zoom and Table Buttons for Decode 

The Zoom and Table buttons are used as described in The WavePilot 
Control Area and The SuperKnob Overview (on page 25). Decode tables 
are shown beneath the main display area. 

WAVESCAN 

When first pressing the WaveScan function button, the WaveScan dialog 
is shown with table data showing in a column to the left of the main 
display area. Subsequent presses of the WaveScan function button 
produce the following results: 

 WaveScan is turned On and you click Close on the WaveScan 
dialog or open a different dialog (say, the Zoom dialog), and then 
click the WaveScan function button, the WaveScan dialog is 
Opened. 

 WaveScan is turned Off and the WaveScan dialog is Closed. 

Zoom and Table Buttons for WaveScan 

The Zoom and Table buttons are used as described in The WavePilot 
Control Area and The SuperKnob Overview (on page 25). 

HISTORY 

When first pressing the History function button, the History dialog is 
shown with table data showing in a column to the left of the main display 
area. Subsequent presses of the History function button produce the 
following results: 

 History is turned On and you click Close on the History dialog or 
open a different dialog (say, the Zoom dialog), and then click the 
History function button, the History dialog is Opened. 

 History is turned Off and the History dialog is Closed. 

On the History dialog, a Capacity control is provided. 

Note: A default value for the Capacity control is generated based on 
your instrument's specific Acquisition Memory Setting (it also varies 
based on specific setups, configurations, and settings at any given 
time). 
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Zoom and Table Buttons for History 

The Zoom and Table buttons are used as described in The WavePilot 
Control Area and The SuperKnob Overview (on page 25). 

LABNOTEBOOK 

When first pressing the LabNotebook function button, the LabNotebook 
dialog is shown. The button toggles between opening and closing the 
LabNotebook dialog - unless you already have LabNotebook entries 
stored. With LabNotebook entries already stored subsequent presses of 
the LabNotebook function button: 

 opens the LabNotebook dialog and your first My Notebook Entry 
is shown on the display area in Preview mode. 

 closes the LabNotebook dialog and the My Notebook Entry 
preview. 

Using the SuperKnob with LabNotebook 

As mentioned, with LabNotebook entries already stored a subsequent 
press of the LabNotebook function button shows the preview along with 
the dialog. You can then turn the SuperKnob to move through entries 
shown in My Notebook Entries on the LabNotebook dialog. Pushing the 
SuperKnob performs a Flashback (Recall) of the stored entry selected in 
the My Notebook Entries on the LabNotebook dialog. 

Note: Zoom and Table buttons are not used for LabNotebook. 

SPECTRUM 

When first pressing the Spectrum function button, the Spectrum dialog is 
shown with table data showing in a column to the left of the main display 
area. Subsequent presses of the Spectrum function button produce the 
following results: 

 Spectrum Analysis is turned Off and the SpectrumAnalyzer dialog 
is Closed. 

 Spectrum Analysis is turned On and you click Close on the 
SpectrumAnalyzer dialog or open a different dialog (say, the Zoom 
dialog), and then click the Spectrum function button, the 
SpectrumAnalyzer dialog is Opened. 
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Zoom and Table Buttons for Spectrum 

Zoom and Table buttons are used as described in The WavePilot Control 
Area and The SuperKnob Overview (on page 25). In addition, a 
spectrum-specific Table control functionality Centers the Frequency of 
your displayed waveform when the SuperKnob is pressed based on the 
particular Frequency row you have selected from the Spectrum table 
displayed to the left of the main display area. 

 
The Table Help Flyout menu for the Spectrum Function button.  
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Probe and Signal Connection 

Interfaces 

Probe and Signal Connection Interfaces 
Overview 

LeCroy oscilloscopes are equipped with a variety of connection interfaces 
to allow connection of cables directly to the oscilloscope channels, or to 
allow probe connections to the oscilloscope. When probes are 
connected, a probe interface is used to power the probe (as necessary), 
to recognize the probe type and its characteristics, and to communicate 
to and from the probe to completely integrate the probe with the 
oscilloscope channel in a number of ways. For instance, active single-
ended and differential voltage probes and current probes use these 
interfaces upload gain and offset correction factors from the probe 
EEPROM's and, in some cases, automatically compensates responses to 
achieve fully-calibrated measurements. 

Some oscilloscope product series support multiple probe and connection 
interfaces. This can be an advantage when the highest speed signal on a 
design requires the use of a high-bandwidth oscilloscope, yet it is also 
highly desired to view other low-speed signals in conjunction with the 
highest-speed signals so as to debug or analyze a complicated embedded 
design. An example would be a high-speed serial data interface, such as 
PCIe, that may interoperate with low-speed signals, such as I2C or power 
supply lines. In this case, the multiple connection interfaces in a single 
high-bandwidth oscilloscope would allow connection of passive voltage 
probes, current probes, and high-bandwidth differential probes without 
the use of additional adapters that cost extra money and may be easily 
lost or misplaced. Multiple probe and connection interfaces also provide 
users the ability to connect two probes to the circuit on a single channel 
and switch between them without disconnecting and re-connecting 
probes from the circuit. This function is remotely programmable allowing 
the interface to operate like a switch, and the ability to select four out of 
eight inputs provides unheard of connection flexibility. 
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Note: AUX INPUT and AUX OUTPUT connections are also typically 
located on the Front Panel. Refer to the Auxiliary Output Signals (on 
page 169) topic for Auxiliary Output dialog details. 

Probe Interfaces 

Probe Interfaces Overview 

LeCroy oscilloscopes utilize one or more proprietary probe interfaces 
providing a complete measurement solution from probe tip to 
oscilloscope display. Compared to standard BNC and Probe Ring 
interfaces, this intelligent interconnection between your instrument and 
the probe or accessory eliminates the guesswork and errors that occur 
when probe settings are made manually, and also offers the following 
important signal fidelity advantages: 

 Upon connection to the oscilloscope channel, the probe is 
recognized and some setup information, such as input coupling 
and attenuation, is performed automatically. 

 System (probe plus oscilloscope) gain settings are automatically 
calculated and displayed based on the probe attenuation. 

 Active probes typically provide automatic matching of probe to 
oscilloscope response using probe response data stored in an on-
board EEPROM. This ensures the best possible combined probe 
plus oscilloscope channel frequency response without requiring 
the user to perform any de-embedding procedure. 

Probe interfaces differ in bandwidth, so the interfaces contained on your 
oscilloscope depend on the bandwidth rating of the oscilloscope model 
you purchased.
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Note: The lowest bandwidth oscilloscopes contain only a BNC and 
perhaps a Probe Ring interface; whereas, the highest bandwidth 
oscilloscopes may contain every type of probe interface LeCroy 
supports. 

 
A LeCroy Zi series oscilloscope showing the four sets of ProBus/ProLink probe 

interfaces. Zi oscilloscopes are compatible with all LeCroy probes. 

The following figure shows a typical channel setup dialog on a LeCroy 
oscilloscope containing both ProLink (Input A, Upper) and ProBus (Input 
B, Lower) interfaces. The input selection is on the left-hand side of the 
dialog box. In this case the A input, the ProLink interface is selected. 
When the probe is not connected, there is only a C1 tab selection for 
vertical channel setup and the user has the ability to select input 
coupling and probe attenuation. 
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The channel dialog layout showing Input A's ProLink interface controls setup 
before connection. 

When a probe is connected, it is recognized and an additional tab with 
the probe model name is displayed to the right of the C1 tab. 

 
The channel dialog layout showing Input A's ProLink interface controls setup 

after connection. 

 This additional tab contains specific information on the connected 
probe. In addition, default values for the probes coupling and 
attenuation (which may not be changed) are automatically downloaded 
from the probe, and these settings along with other attributes are shown 
on the corresponding probe dialog. 

 
The dialog showing the connected probe's control attributes. 

ProBus Probe and Cable Connecting Interface 

The ProBus interface contains a 6-pin power and communication 
connection and a BNC signal connection to the probe. It offers both 50 
Ω/1 MΩ input impedance and provides probe power and control for a 
wide range of probes such as high impedance passive probes, high 
impedance active probes, current probes, high voltage probes, and 
differential probes. ProBus also includes sense rings for detecting passive 
probes. The ProBus interface may also have a BNC-terminated cable 
connected directly to it. 



Getting Started Manual 

WR6Zi-GSM-E 36 

ProBus is based on a BNC connector and, depending on the exact BNC 
connector used and the oscilloscope design, is rated for up to 4 GHz with 
50 Ω coupling or up to 1 GHz for 1 MΩ coupling (depending on the exact 
model purchase). 

Probes 

LeCroy offers a variety of passive and active probes for use with your X-
Stream oscilloscope. Visit www.lecroy.com for specifications and 
ordering information. 

 Current Probes - Current Probes measure the current passing 
through a wire; current probes do not use the traditional probing 
style of placing a tip onto a test point. Instead, a wire is placed 
inside the jaw of the probe, which allows the probe to measure 
the current (in Amps). 

 Active Probes - There are two different types of active probes: 
single-ended and differential. 

Single-Ended - A single-ended active probe is associated with 
measuring voltages at high frequencies. Measurement with an 
active probe requires a test point and a ground point. The ground 
(also called earth) acts as a zero reference for the test point 
measurement. 

Differential Probes - Differential active probes are like two probes 
in one. Instead of measuring a test point in relation to a ground 
point (like single-ended active probes), differential probes 
measure the difference in voltage of a test point in relation to 
another test point. 

 Passive Probes - Passive probes measure voltages at lower 
frequencies (<500 MHz). They have higher input capacitance 
(input C) and do not need power to operate (unlike active probes). 
At higher frequencies, higher input capacitance loads the test 
circuit, attenuating the signal. This is why active probes are used in 
high frequency applications. Passive probes also measure voltage 
in reference to ground. 

http://www.lecroy.com/
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 High Voltage Probes - These are active, single-ended probes 
designed to safely measure high voltages. They measure the 
voltage in reference to ground. 

Passive Probe Compensation 

Passive probes must be compensated to flatten overshoot. This is 
accomplished by means of a trimmer at the connector end of the probe. 

1. Attach the connector end of your passive probe to any channel. 
2. Connect the probe end to the CAL output connector at the front of 

the oscilloscope. Ground the probe. 
3. Adjust the trim pot at the connector end of the probe until the 

square wave is as flat as possible. 
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Display Dashboard 

Display Dashboard Overview 

This section covers the various aspects of the user interface shown in the 
display of your instrument. 

Screen Layout, Groupings, and Controls 

 

The instrument's screen is divided into the following main sections: 

 Menu Bar 

 Signal Display Grid 

 Descriptor Labels 

 Dialog(s) 

 The Message Bar 

Note: Many front panel controls directly correspond with screen layout 
controls. For example, the Print front panel general control button 
corresponds with the Hardcopy function set from Utilities → Utilities 
Setup → Hardcopy. 
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Menu Bar 

The top of the screen contains a menu bar of commonly used functions. 
Whenever you touch one of these buttons and make a selection from its 
drop-down menu, the dialog area at the bottom of the screen displays 
the corresponding dialog. 

Specific Menu Bar functions are referenced using arrow-separated path 
descriptions. For example, the Save Setup function is referenced as File 
→ Save Setup....  

PLEASE NOTE THE FOLLOWING:  

For common oscilloscope operations, you don’t need to use the top 
menu bar (since you can access most dialogs from the Front Panel or 
from the Descriptor Labels). However, it is the only way to access setup 
or other dialogs for Display Setup, Save or Recall Waveform, Save or 
Recall Setups, Print Setup, Vertical (Channel), Horizontal, or Trigger 
Status, Memory (Reference Waveform) Setup, Pass/Fail Setup, or 
Utilities and Preferences Setup.... 

The Quick Access Toolbar 

The Quick Access portion of the toolbar is located on the right side of the 
menu bar. It contains the Rotate Display button. 

 

When the display is rotated, touch this button to adjust the user 
interface to a portrait layout. The button toggles from portrait layout 
back to landscape. 

For additional information on rotating and tilting the display, refer to 
Hardware and Software Controls (on page 19). 
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The Signal Display Grid 

The grid area is divided into 8 vertical divisions and 10 horizontal 
divisions just like any other oscilloscope. Set up the signal display area by 
touching Display → Display Setup... from the menu bar. The Display 
dialog offers a choice of grid combinations and can also set the grid 
intensity. 

 

There are several indicators on the grid to help you understand the 
following: 

 Trigger Delay - This indicator is located along the bottom edge of 
the grid. Trigger delay allows you to see the signal prior to the 
trigger time. 

 

All trigger delay values (including post-trigger delay, shown here) 
are displayed in the Timebase Descriptor Label. Zero delay is the 
horizontal center of the oscilloscope display. 
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The default setting (Time) is for delay readout (in seconds) and to 
move proportionately when the timebase knob is turned. If you 
want to set delay (Div) to a fixed position on the grid, and then 
have it stay fixed as the timebase changes, go to Utilities → 
Preference Setup... and select the Acquisition dialog to make the 
setting. 

 Post-trigger Delay - This is indicated by a left-pointing arrow to 
the lower-left of the grid. Pre-trigger delay is indicated by a right-
pointing arrow to the lower-right of the grid. 

 

 Trigger Level - This indicator is located at the right edge of the 
grid. It tracks the trigger level as you reposition the trace up or 
down, or change scale. When triggering is stopped, a hollow arrow 
indicates where the new level ends up when triggering resumes. 

 

Push the LEVEL knob to reset the level to 50%. 

 Zero Volts Level - This indicator is located at the left edge of the 
grid. Change the zero volts level by turning the vertical OFFSET 

knob. Push the knob to reset the indicator to the middle of the 
grid. 
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Signal Display Grid Pop-Up Menu 

On the Signal Display Grid, the Pop-up menu provides assistance while 
using the oscilloscope. 

Clicking on a waveform opens a pop-up menu. From this pop-up menu, 
you can perform the following functions: 

 Open the Setup dialog for the trace 

 Turn the trace descriptor label off 

 Open the Math dialog for the trace 

 Open the Measure dialog for the trace 

 Annotate the selected trace 

Trace Descriptor Labels 

Shown just beneath the grid display, these boxes provide a summary of 
your channel, timebase, and trigger settings. 

When a trace is selected its corresponding descriptor label is shown 
highlighted. 

 
The C1 Trace Descriptor Label is selected; C2 is not. 

Make vertical or horizontal channel adjustments by touching the 
respective label. The setup dialog for the function is shown beneath. 

Channel trace labels show the vertical settings for the trace and cursor 
information (if cursors are in use). The title bar of the label includes 
indicators for (SinX)/X interpolation, waveform inversion (INV), deskew 
(DSQ), coupling (DC/GND), bandwidth limiting (BWL), and averaging 
(AVG). 
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These indicators have a long and short form, respectively. 

 
The long and short forms of trace descriptor indicators. 

Besides channel traces, math and parameter measurement labels are 
also displayed. Labels are displayed only for traces that are turned on. 

Vertical and horizontal trace descriptor (labels) are displayed below the 
grid. They provide a summary of your channel, timebase, and trigger 
settings. Make vertical or horizontal channel adjustments by touching 
the respective label. The setup dialog for the function is shown beneath.  

TimeBase trace descriptor labels show the trigger delay setting, time per 
division, and sampling information. 

 

Trigger trace descriptor labels show the trigger mode (Auto, Normal, or 
Stopped). It also shows the coupling (DC), trigger type (Edge), source 
(C1), level (0 mV), and slope (Positive). 

 

Setup information for horizontal cursors, including the time between 
cursors and the frequency, is shown beneath the TimeBase and Trigger 
trace descriptor labels. 
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Actions for Trace Buttons 

You can access the same functions as the ones produced when using the 
Signal Display Grid Pop-Up menu just by clicking a trace-descriptor label, 
which shows its corresponding dialog. From the respective dialog, you're 
able to access the same functions as Actions for Trace X buttons. 

 Open the Setup dialog for the trace. 

 Open the Math dialog for the trace. 

 Open the Measure dialog for the trace. 

 Annotate the selected trace. 

For more information, see the Actions for Trace Buttons section of Dialog 
Area (on page 46). 

Annotating Traces 

The instrument gives you the ability to add an identifying label, bearing 
your own text, to a waveform display: 

 

For each waveform, you can create multiple labels and turn them all on 
or all off. Also, you can position them on the waveform by dragging or by 
specifying an exact horizontal position. 

Touch the waveform you want to annotate right on the display grid, and 
then touch Set label... on the pop-up menu. A dialog box opens in which 
to create the label. 
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If you are creating a label for the first time for this waveform, Label1 is 
displayed as default text when the Add label button is clicked. 

 

From this pop-up you can edit existing annotations, change the label 
placement on the waveform, add labels, remove labels, and toggle the 
visibility. The following bullets show you how. 

 If you are modifying an existing label, under Labels touch the label 
you want to change. 

Note: If the dialog for the trace you want to annotate is 
currently displayed, you can touch the label button at the 
bottom to display the Trace Annotation setup dialog. 

 
You may place a label anywhere you want on the waveform. 
Labels are numbered sequentially according to the order in 
which they are added, and not according to their placement on 
the waveform. 

 If you want to change the label's text, touch inside the Label Text 
field. A pop-up keyboard appears for you to enter your text. Touch 
O.K. on the keyboard when you are done. The edited text 
automatically appears in the label on the waveform. 
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 Precisely place the label by touching inside the Horizontal Pos. 
field and provide a horizontal value, using the pop-up numeric 
keypad. 

 Add another label by touching the Add label button. Delete a label 
by selecting the label from the list, and then touching the Remove 
label button. 

 Make labels visible by touching the View labels checkbox. 

Dialog Area 

The lower portion is where information is shown, selections are made, 
and data is input. Typically they are organized into tabular displays, 
subtabs, or pop-up dialogs. The dialog area is controlled by Touch Screen 
Controls and Front Panel Controls (on page 19). 

Touch Screen Controls 

Various touch screen user interface controls are provided for easily 
entering data. Their functionality is described in this topic and you'll see 
them referenced throughout the documentation. 

POP-UP SELECTOR CONTROLS 

When Pop-Up selector controls are touched, sometimes a very small box 
is shown right inside the control - as in the following control for Coupling 
on the C1 dialog. 

 
Pop-Up Selector Control for smaller values. 

Other times, a larger box is shown after touching a control. 
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This larger Pop-Up has categorical buttons along the left column along 
with labels (and sometimes descriptions) for the selectable entry values. 

 
Pop-Up Selector Control for values with varied types. 

TEXT ENTRY CONTROLS 

Most controls can be touched once and you can then provide a value 
using an attached (or double-touch/click to use the Virtual, on-screen) 
keyboard. 

 
Text entry field for LabNotebook using the Virtual Keyboard. 
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FOLDER/FILE BROWSING CONTROLS 

These controls allow for navigation to or from folders (on the hard drive 
or memory device) for retrieving or storing items such as waveforms, 
LabNotebook entries, to name a few. 

 
Folder/File Browsing recall waveform controls. 

Note: The instrument's hard disk is partitioned into drive C: and drive 
D:. Drive C: contains the Windows operating system and the instrument 
application software. Drive D: is intended for data files. 

FLYOUT MENU CONTROLS 

Flyout Menus provides a variety of solutions for a particular main area of 
functionality. It does this by providing a set of buttons subdividing the 
control into more specific functions on the right-side of the display. 
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An example of Flyout Menu Controls is seen in the Setup front panel 
button. 

 
Setup Flyout Menu control. 

PRECISION DATA ENTRY CONTROLS 

Certain fields requiring precise value entry assist you by having precision 
entry means. When these controls are selected, you can provide values 
as follows: 

Keyboard 

Touch inside a text entry control and you can manually type the value in 
using an attached (or double-touch/click to use the Virtual, on-screen) 
keyboard. 

 
Text entry field for LabNotebook using the Virtual Keyboard. 
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Slider Bar 

Some models provide what is known as a Slider Bar along the bottom of 
the screen when a keyboard is attached to the instrument. The Slider 
Bar allows you to select your entered value by moving a horizontal slider 
(left to right provides low to high amounts). 

 
The Slider Bar 

Pop-Up Keypad 

Some models provide a pop-up Keypad when you touch twice in the 
same control. A keypad button is also provided on the slider bar (on 
models that have the slider bar) which shows the pop-up keypad when 
touched. 

  

For many controls, once the Pop-Up Keypad is shown the Front Panel 
Controls (on page 19) can be used to adjust the value in the pop-up. The 
Pop-Up contains Up and Down arrow buttons, Set to Max, Default, and 
Min buttons, and the Keypad itself for providing your value. 

The slider bar also has a handy default value button for quickly entering 
the default for the control. 

 

Default and Keypad Buttons on the Slider Bar (only shown on 7 and 8 Zi 
models with a keyboard attached. 

The WaveRunner 6 Zi provides touch-screen interface control in a 
different manner. See The WavePilot Control Area and The SuperKnob 
Overview (on page 25) for more information. 
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Actions for Trace Buttons 

Several dialogs contain common functions accessible from a row of 
buttons that can save you a step or two when using a particular function 
(instead of accessing the respective location from the menu bar or the 
Signal Display Grid Pop-Up Menu).  

For example, at the bottom of the Channel Setup dialog, these buttons 
(sometimes labeled as Actions) perform the following functions: 

 

 Measure - Opens the Measure menu. You can then select a 
parameter from this menu without leaving the Channel Setup 
dialog. The parameter automatically appears below the grid. 

 Zoom - Creates a zoom trace of the channel trace whose dialog is 
currently displayed. 

 Math - Opens the Math menu. You can then select a math 
function from this menu without leaving the Channel Setup dialog. 
A math trace of the channel whose dialog is currently open is 
automatically displayed. 

 Decode - Opens the main Serial Decode dialog where protocol 
option measurements can be applied to signals. 

 Store - Loads the channel trace into the next available memory 
location (M1 to M4). 

 Find Scale - Automatically performs a vertical scaling that fits the 
waveform into the grid. 

 Next Grid - Automatically moves the channel trace whose dialog is 
currently open onto the next grid. If you have only one grid 
displayed, a new grid will be created automatically, and the trace 
moved. 

 Label - Enables you to attach identifying labels to your waveforms. 
The labels are preserved when the waveform is saved as a 
LabNotebook entry and when saved to file. 

 Probe Cal - Cable Deskew - Opens the Probes Cal. dialog where 
various Gain, Offset, Skew, Source, and Advanced controls are 
available for probe signal calibration. 
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Another example is seen in the buttons appearing at the bottom of the 
Measure Px dialogs. The button may be selected in order to display the 
functions named on the buttons (sometimes labeled as Actions):  

 
Actions for Trace buttons on the Cx dialog. 

Using these buttons allow you to remain in the Measure dialog while 
setting up a Math trace on a parameter measurement. 

Message Bar 

At the bottom of the oscilloscope display is a narrow message bar. The 
current date and time are displayed at the far right. Status, error, or 
other messages are also shown in this area. 

Turning on Channels and Traces 

Note: If you want to display each trace on its own grid automatically, 
enable Autogrid by touching Display → Autogrid from the menu bar. 

 On the front panel, press a channel select button to display the 
trace label for that input channel and turn on the channel. 

 Turn on a math function trace by touching Math → Math Setup... 
from the menu bar. Touch the corresponding On checkbox to 
activate the desired trace. 

 You can also quickly create traces (and turn on the trace label) for 
math functions and memory traces, without leaving the Vertical 
Adjust dialog, by touching the icons at the bottom of the Vertical 
Adjust dialog. 
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Whenever you turn on a channel, math, or memory trace using either 
the menu bar or trace descriptor label, the dialog at the bottom of the 
screen automatically switches to the vertical setup or math setup dialog 
for that selection. 

You can configure your traces from here, including math setups. 

The Trace Dialog is shown on the lower (dialog) portion of the screen. 
The tab is labeled with the corresponding channel number as follows: 

 



Getting Started Manual 

WR6Zi-GSM-E 54 

Timebase 

Timebase Overview 

You can access Timebase settings using the front panel Horizontal 
controls, the Timebase → Horizontal Setup... on the menu bar, or by 
touching the Timebase trace descriptor label. The Timebase dialog is 
then shown. 

 

Timebase Setup and Control 

1. With the Timebase dialog showing, touch inside the Time/Division 
data entry control and provide a value using your preferred input 
control method - for more information regarding the touch screen 
controls, refer to Dialog Area (on page 46). 

2. Touch inside the Delay data entry control and provide a value. 
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Sampling Modes 

Sampling Modes Overview 

Depending on your timebase, you can choose Single-shot Sampling 
Mode (below), also known as Real Time mode, Sequence Sampling 
Mode (on page 56), or RIS Sampling Mode (on page 63) mode sampling. 

Some instruments also offer Roll Mode (on page 64). 

 

Selecting a Sampling Mode 

1. Touch Timebase → Horizontal Setup... from the menu bar. 
2. In the Timebase dialog, touch a Sample Mode button. 
3. If you chose Sequence Mode, touch the Sequence tab. The 

Sequence dialog is shown. Use the following controls to provide 
details for controls such as Number of Segments, Enable Timeout, 
Timeout (value), Display Mode, and Show Sequence Trigger 
Times.  

Single-shot Sampling Mode 

Basic Capture Technique 

A single-shot acquisition is a series of digitized voltage values sampled on 
the input signal at a uniform rate. It is also a series of measured data 
values associated with a single trigger event. The acquisition is typically 
stopped a defined number of samples after this event occurs: a number 
determined by the selected trigger delay and measured by the timebase. 
The waveform's horizontal position (and waveform display in general) is 
determined using the trigger event as the definition of time zero. 

You can choose either a pre- or post-trigger delay. Pre-trigger delay is the 
time from the left-hand edge of the display grid forward to the trigger 
event, while post-trigger delay is the time back to the event. You can 
sample the waveform in a range starting well before the trigger event up 
to the moment the event occurs. 
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This is 100% pre-trigger, and it allows you to see the waveform leading 
up to the point at which the trigger condition was met and the trigger 
occurred. (The instrument offers up to the maximum record length of 
points of pre-trigger information.) Post-trigger delay, on the other hand, 
allows you to sample the waveform starting at the equivalent of 10,000 
divisions after the event occurred. 

On fast timebase settings, the maximum single-shot sampling rate is 
used. But for slower timebases, the sampling rate is decreased and the 
number of data samples maintained. 

The relationship between sample rate, memory, and time can be simply 
defined as: 

Capture Interval = 1/Sample Rate X Memory 

and 

Capture Interval/10 = Time Per Division 

Sequence Sampling Mode – Working with 
Segments 

Using Sequence Mode, thousands of trigger events can be stored as 
segments into the oscilloscope's memory (the exact number depends on 
oscilloscope model and memory options). This is ideal when capturing 
many fast pulses in quick succession or when capturing few events 
separated by long time periods. The instrument can capture complicated 
sequences of events over large time intervals in fine detail, while 
ignoring the uninteresting periods between the events. You can also 
make time measurements between events on selected segments using 
the full precision of the acquisition timebase. 

Sequence mode offers a number of unique capabilities: 

 You can acquire up to four channels simultaneously. 

 You can minimize dead time between trigger events for 
consecutive segments. 

 You can view time stamps for acquisitions. 

 You can zoom segments or used them as input to math functions. 
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 You can combine sequence mode with an advanced trigger to 
isolate a rare event, capture all instances over hours or days, and 
view/analyze each afterwards. 

 You can use Sequence mode in remote operation to take full 
advantage of the instrument's high data-transfer capability. 

In Sequence mode, the complete waveform consists of a number of 
fixed-size segments acquired in single-shot mode (see the instrument 
specifications for the limits). The oscilloscope uses the sequence 
timebase setting to determine the capture duration of each segment as 
10 x time/div. With this setting, the oscilloscope uses the desired number 
of segments, maximum segment length, and total available memory to 
determine the actual number of samples or segments, and time or 
points. 

 
How the instrument captures segments 
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Sequence Display Modes 

The instrument gives you a choice of five ways to display your segments: 

 Adjacent 

 
 Waterfall (cascaded) 

 
 Mosaic (tiled) 

 
 Overlay 
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 Perspective 

 

Note: some display modes have limitations on the number of segments 
that can be shown at one time. 

Sequence Mode Setup 

When setting up Sequence Mode, you define the number of fixed-size 
segments acquired in single-shot mode (see the instrument 
specifications for the limits). The oscilloscope uses the sequence 
timebase setting to determine the capture duration of each segment. 
Along with this setting, the oscilloscope uses the number of segments, 
maximum segment length, and total available memory to determine the 
actual number of samples or segments, and time or points. 

 
Setting up Sequence Mode (Adjacent) 

1. Touch Timebase → Horizontal Setup... on the menu bar. 
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2. Click the Sequence tab. 
3. Under Acquisition Settings, touch inside the Num Segments data 

entry control and provide a value using your preferred input 
control method - for more information regarding the touch screen 
controls, refer to Dialog Area (on page 46). 

Note: The number of segments you choose to display can be less 
than the total number of segments in the waveform. For 
example, in the pop-up images above, the number of display 
segments is 10, but the total number of segments entered in the 
timebase dialog's Num Segments control is 100. 

4. Touch the Enable Timeout checkbox. 
5. Touch inside the Timeout data entry control and provide a 

timeout value. 

Note: Use the sequence mode timeout to automatically interrupt the 
sequence acquisition if the timeout value is exceeded without a valid 
trigger. The timeout period accounts for instances when a Num 
Segments miscount occurs for some reason and the oscilloscope waits 
indefinitely for an unforthcoming segment. During that time, no 
oscilloscope functions are accessible. By means of a timeout value, 
however, the acquisition will be completed, the waveform displayed, 
and control of the oscilloscope returned to the user after the timeout 
has elapsed. 

5. Under Display Settings, touch inside the Display mode control, 
and select a sequence mode display from the pop-up menu. 

6. Touch the SINGLE trigger front panel button. 

Note: Once a single acquisition has started, you can interrupt 
the acquisition at any time by pressing the SINGLE front panel 
button a second time or by pressing the STOP front panel button. 
In this case, the segments already acquired will be retained in 
memory. 
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Zooming Segments in Sequence Mode 

You can zoom individual segments easily using the QUICKZOOM front 
panel button. When you zoom, the zoom traces default to Segment 1. 
Channel descriptors indicate the total number of segments acquired. 
Zoom descriptors indicate [Seg #] and #Segments in the Zoom. You can 
scroll through the segments using ZOOM front panel position knob. 

 
Sample Zoom of Segments in Sequence Mode 

1. Touch the front panel Quickzoom button. 

 

2. Turn the ZOOM front panel position knob to scroll through the 
segments. 

3. To vary the degree of zoom, touch the newly created Zx trace 
label. The setup dialog for the zoom (Z1 to Z4) opens. It shows the 
current horizontal and vertical zoom factors. 
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4. If you want to increase or decrease your horizontal or vertical 
zoom in small increments, touch the Var. checkbox to enable 
variable zooming. Now with each touch of the zoom control 
buttons, the degree of magnification changes by small increments. 

 

OR 

If you want to zoom in or out in large standard increments with 
each touch of the zoom control buttons, leave the Var. checkbox 
unchecked. 

OR 

If you want to set exact horizontal or vertical zoom factors, touch 
inside the Horizontal Scale/div data entry control and enter a 
time-per-div value, using the pop-up numeric keypad. Then touch 
inside the Vertical Scale/div control and enter a voltage value. 

Displaying an Individual Segment 
1. Touch Math → Math Setup... on the menu bar. 
2. Touch a function tab Fx showing its corresponding dialog. 
3. On the dialog, touch inside the Operator1 control and select the 

Segment button from the pop-up menu. 

 

4. In the dialog on the right, touch the Select tab. 
5. Touch inside the First Selected data entry control and select the 

first segment you want to display. Use the same method to 
provide a value in the Number of Selected data entry control. 

Note: In Persistence mode, the segments are automatically overlaid 
one on top of the other in the display. In non-Persistence mode, they 
appear separately on the grid. 
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Viewing Time Stamps 

You can view time stamps for each segment. 

 
View Segment Time Stamps 

1. Touch Timebase → Acquisition Status on the menu bar. 
OR 
Touch Vertical → Channel Status on the menu bar. 

2. Touch the Trigger Time tab. 
3. Under Show Status For, touch the Time button. 
4. Touch inside the Select Segment control and enter a segment 

number value (you can also touch the arrow buttons to scroll 
through segment times). 

RIS Sampling Mode - For Higher Sampling Rates 

RIS (Random Interleaved Sampling) is an acquisition technique that 
allows effective sampling rates higher than the maximum single-shot 
sampling rate. It is used on repetitive waveforms with a stable trigger. 
The maximum effective RIS sampling rate is achieved by making multiple 
single-shot acquisitions at maximum real-time sample rate. The bins thus 
acquired are positioned approximately 5 ps (200 GS/s) apart. 
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The process of acquiring these bins and satisfying the time constraint is a 
random one. The relative time between ADC sampling instants and the 
event trigger provides the necessary variation. 

The instrument requires multiple triggers to complete an acquisition. The 
number depends on the sample rate: the higher the sample rate, the 
more triggers are required. It then interleaves these segments (in the 
following graphic) to provide a waveform covering a time interval that is 
a multiple of the maximum single-shot sampling rate. However, the real-
time interval over which the instrument collects the waveform data is 
much longer, and depends on the trigger rate and the amount of 
interleaving required. 

 

Note: RIS mode is not available when the oscilloscope is operating in 
fixed sample or DBI 25 - 45 GHz) modes as covered in Smart Memory 
(available in the online help files) and Combining Channels topics, 
respectively. 

Roll Mode 

Roll mode displays, in real time, incoming points in single-shot 
acquisitions that have a sufficiently low data rate. The oscilloscope rolls 
the incoming data continuously across the screen until a trigger event is 
detected and the acquisition is complete. The parameters or math 
functions connected to each channel are updated every time the roll 
mode buffer is updated, as if new data is available. This resets statistics 
on every step of Roll mode that is valid because of new data. 
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Note: If the processing time is greater than the acquire time, the data 
in memory gets overwritten. In this case, the instrument issues a 
Channel data is not continuous in ROLL mode!!! warning and rolling 
starts over again. 
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Vertical 

Adjusting Sensitivity and Position 

You can make adjustments to both the sensitivity ad the positioning of 
displayed waveforms. 

Adjusting Sensitivity 

1. Press the appropriate channel push button (channel 1, for 
example).  

OR 
Touch Vertical → Channel 1 Setup... from the menu bar.  

2. Touch inside the Trace On checkbox to display the trace. 

 

3. Turn the VERTICAL GAIN front panel knob for the selected channel.  
OR  
Touch inside the Volts/Div field and enter a value. Click the 
keypad button to enter a value using the pop-up keypad, or use 
the up/down arrows. 

The set voltage is shown on the trace descriptor label and in the 
Volts/Div field in the dialog. 

 

Adjusting the Waveform's Position 

Turn the VERTICAL OFFSET adjust front panel knob directly above the 
channel button whose waveform you want to move vertically. Or you can 
touch inside the Offset field and type in a value on the pop-up keypad. 
To set the vertical offset to zero, touch the Zero Offset button directly 
below the Offset field. 
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Coupling 

The choices of coupling are as follows: 

 DC 50 Ω 

 GROUND 

 DC 1 MΩ 

 AC 1 MΩ 

Overload Protection 

The maximum input voltage depends on the input used. Values are 
displayed on the front of the oscilloscope. Whenever the voltage exceeds 
this limit, the coupling mode automatically switches from DC 50 Ω to 
GROUND. You then have to manually reset the coupling to DC 50 Ω, 
described in the steps to follow. 

CAUTION  

While the unit does provide this protection, damage can still occur if 
extreme voltages are applied. 

Setting Coupling 

1. Touch Vertical → Channel X Setup... from the menu bar. 
2. Touch inside the Coupling control and select a coupling mode 

from the pop-up menu. 

Probe Attenuation 

Setting up Probe Attenuation 

LeCroy's ProBus system automatically senses probes and sets their 
attenuation for you. If you want to set the attenuation manually, 

1. In the menu bar, touch Vertical, and then select a channel from 
the drop-down menu. 
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2. Touch inside the Probe Atten. data entry control and provide a 
value using your preferred input control method - for more 
information regarding the touch screen controls, refer to Dialog 
Area (on page 46). 

 

3. Now, touch a divide-by menu selection 

OR 

Touch Var (variable). If you choose Var, type in a value. 

Bandwidth Limits 

Reducing the bandwidth also reduces the signal and system noise, and 
prevents high-frequency aliasing. 

Setting Bandwidth Limits 

Set bandwidth limits as follows: 

1. In the menu bar, touch Vertical, and then select a channel from 
the drop-down menu. 

2. Touch inside the Bandwidth control and provide a Bandwidth 
Limit value using your preferred input control method - for more 
information regarding the touch screen controls, refer to Dialog 
Area (on page 46). Bandwidth filters are available at the following 
levels: 
WaveRunner - 1 GHz, 200 MHz, and 20 MHz. 

PLEASE NOTE THE FOLLOWING:  

 Each oscilloscope contains only the Full selection and those 
bandwidths less than the rated oscilloscope bandwidth. 

 Anti-aliasing filters are applied to limit bandwidth at lower sample 
rates, regardless of bandwidth limit selection. 
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Linear and (SinX)/X Interpolation 

Linear interpolation, which inserts a straight line between sample points, 
is best used to reconstruct straight-edged signals such as square waves. 
(Sinx)/x interpolation, on the other hand, is suitable for reconstructing 
curved or irregular wave shapes, especially when the sample rate is 3 to 
5 times the system bandwidth. 

Interpolation Setup 

1. Touch the button for the channel you want to set up (channel 1, 
for example).  

2. In the dialog area, touch inside the Interpolation data entry 
control under Pre-Processing. Pre-Processing is meant as before 
Math processing. 

3. Touch inside the Interpolation data entry control. A pop-up menu 
appears offering Linear or Sinx/x interpolation. Touch the button 
for the desired interpolation type. 

Inverting Waveforms 

If available on your instrument, touch the Invert checkbox to invert the 
waveform for the selected channel. 

Finding Scale 

You can access the Find Scale button from the channel setup dialog. This 
feature automatically calculates peak-to-peak voltage, and chooses an 
appropriate Volts/Div scale to fully display the waveform. 

Using Find Scale 

1. Touch the trace label for the waveform you desire. 
2. Touch the Find Scale button. 

 

Variable Gain 

Variable Gain lets you change the granularity with which the gain is 
incremented. For example, when Variable Gain is disabled, the gain 
increases or decreases in preset increments each time you touch the 
Up/Down buttons. 
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However, when Variable Gain is enabled, you can increase or decrease 
the gain in increments as small as 0.1 mV/div, depending on the 
waveform scale. 

Enabling Variable Gain 
1. Touch the descriptor label for the waveform whose gain you want 

to vary. 
2. Touch the Variable Gain checkbox. 

 

Channel Deskew 

Unlike the Deskew math function, channel Deskew does no resampling, 
but instead adjusts the horizontal offset by the amount that you enter. 
The valid range is dependent on the current timebase +/- 9 divisions. 

Channel Deskew Setup 
1. In the menu bar, touch Vertical; from the drop-down menu, select 

a channel to set up. 
2. Touch inside the Deskew data entry control and provide a value 

using your preferred input control method - for more information 
regarding the touch screen controls, refer to Dialog Area (on page 
46). 
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Trigger 

Trigger Overview 

Triggering is the way an oscilloscope selects an exact moment in time on 
a signal to then be shown on the screen. If the pattern of a signal 
happens to be repetitive, a continuous waveform pattern is inherently 
visible on the display. 

But without a regular signal pattern, the oscilloscope requires controls to 
determine what specific point in time (when a trigger is met) to show the 
signal on the display. This is accomplished and affected in a variety of 
ways. 

Some trigger settings allow for pre-trigger, post-trigger, and a delay 
between the time of the trigger event and the time when the display is 
refreshed (or sweeped) and the waveform is again shown on the screen. 

The instrument uses many waveform capture techniques that trigger on 
features and conditions that you define. These triggers fall into the 
following major categories: 

 Simple Triggers - activated by basic waveform features or 
conditions such as a positive or negative slope, and hold‐off 

 SMART Triggers - sophisticated triggers that enable you to use 
basic or complex conditions for triggering. Use SMART Triggers for 
signals with rare features, like glitches. 

 Measurement Trigger - triggers that allow you to leverage 
parameter measurements as waveform trigger conditions. A 
measurement trigger is either the only trigger or the final trigger 
in a chain of trigger events including hardware triggers. 

 MultiStage Triggers - varied forms of triggers including Cascaded, 
QualFirst, and Qualified allowing varied combinations of triggers 
and trigger stages. 

Trigger Types 

There are a set of standard Trigger Types. These Triggers are basic 
waveform features or conditions such as a positive or negative slope, and 
hold-off and are available on all oscilloscopes along with tools like 
Software Assisted Trigger and Trigger Scan. 
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In addition, there are more sophisticated triggers for setting basic or 
complex conditions. These include Smart Triggers, Serial Trigger, 
Measurement Triggers, and MultiStage Triggers. 

Learn more and Contact LeCroy for Support (on page 188). 

Edge 

 

A simple trigger, Edge trigger is activated by basic waveform features or 
conditions such as positive or negative slope, and holdoff.  

Width 

 

Width trigger allows you to define a positive- or negative-going pulse 
width bounded by a voltage level, above or below which a trigger will 
occur. Or you can specify a pulse width and voltage range, within or 
outside of which a trigger will occur. 

Pattern (Logic) 

 

Logic trigger enables triggering on a logical combination (pattern) of five 
inputs: CH1, CH2, CH3, CH4, and AUX. You have a choice of four Boolean 
operators (AND, NAND, OR, NOR), and you can stipulate the high or low 
voltage logic level for each input independently. 

Smart 

These are a specific set of sophisticated trigger types. Smart trigger types 
are used to set conditions on signals with rare features, like the glitches 
and others as follows: 
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WINDOW 

 

A smart trigger occurs when a signal enters or exits a window defined by 
adjustable thresholds. 

INTERVAL 

 

While Glitch trigger performs over the width of a pulse, Interval trigger 
performs over the width of an interval - the signal duration (the period) 
separating two consecutive edges of the same polarity: positive to 
positive or negative to negative. Use interval trigger to capture intervals 
that fall short of, or exceed, a given time limit. In addition, you can define 
a width range to capture any interval that is itself inside or outside the 
specified range - an Exclusion trigger by interval. 

GLITCH 

 

Glitch trigger is a simpler form of Width trigger. Use Glitch trigger when 
you want to define a fixed pulse-width time or time range only. Glitch 
trigger makes no provision for voltage levels or ranges. 

DROPOUT 

 

Used primarily in single-shot applications, and usually with a pre-trigger 
delay, Dropout trigger can detect lost signals. The trigger is generated at 
the end of the timeout period following the last trigger source transition. 
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RUNT 

 

The Runt trigger occurs when a pulse crosses a first threshold line, but 
fails to cross a second threshold line before recrossing the first. Other 
defining conditions for this trigger are the edge (triggers on the slope 
opposite to that selected) and runt width. 

SLEW RATE 

 

SlewRate trigger activates a trigger when the rising or falling edge of a 
pulse crosses two threshold levels: an upper level and a lower level. The 
pulse edge must cross the thresholds faster or slower than a selected 
period of time. 

Measurement 

 

This trigger type allows you to leverage parameter measurements as 
waveform trigger conditions. A measurement trigger is either the only 
trigger or the final trigger in a chain of trigger events including hardware 
triggers. 

TV 

 

Not available on all instruments, TV triggers provide stable triggering on 
standard or custom composite video signals. Use them on PAL, SECAM, 
NTSC, or HDTV systems. 
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MulitStage 

 

Touching this MultiStage trigger type shows the additional MultiStage 
types on the dialog. Select from Cascaded, QualFirst, and Qualified as 
follows: 

CASCADED 

 

The Cascaded trigger allows you to define successive trigger Stages 
(referred to as Stage A, B, C, and D) as arm, trigger/arm, trigger/arm, 
trigger criteria, respectively. 

QUALFIRST 

 

In single trigger mode, QualFirst arms the oscilloscope on the A event, 
and then triggers on all subsequent B events. 

Note: This button is enabled when using the sequence sampling mode. 
It is commonly used in sequence mode for disk drive applications with 
the index pulse defined as the A qualifier signal and the servo gate 
signal as the B triggering events. 

QUALIFIED A-B 

 

In single trigger mode, Qualify A-B arms the oscilloscope on the A event, 
and then triggers on the B event. If the oscilloscope is in Normal trigger 
mode, it automatically resets after the B event. Arm trigger events can 
be set for Edge, Pattern, State, and PatState. State is briefly explained as 
follows: 
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State 

 

The State trigger is a level-qualified trigger which requires that the 
qualifying signal remain above or below a specified voltage level for a 
trigger to occur. For State trigger, you specify the time or number of 
events after the signal has gone above or below the voltage level when 
you want the trigger to occur. 

Serial Trigger 

 

Protocol-enabled serial trigger capabilities are available as options on 
several oscilloscope models. 

Clock and Data Recovery (CDR) 

 

80-bit Serial Trigger (without decode capability) is standard on SDA 
model oscilloscopes and optional on WavePro, WaveMaster, and DDA 
model oscilloscopes.  The CDR feature is optional for the WaveRunner Zi 
family, including 8b/10b decode. 

Trigger Settings 

Horizontal and Vertical adjustments are typically made for all trigger 
types using either the Delay or Level knobs on the front panel of the 
instrument or their respective controls on the Timebase setup dialog. 

 Horizontal: Turn the DELAY knob in the HORIZONTAL control group 
to adjust the trigger's horizontal position. Or, touch inside the 
Delay control and provide a value on the Timebase dialog using 
your preferred input control method - for more information 
regarding the touch screen controls, refer to Dialog Area (on page 
46). 
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The trigger location is shown by a marker under the grid. 

 

Post-trigger delay is indicated by a left-pointing arrow at the 
lower-left of the grid. 

 

The time value is given in the title line of the Timebase label at the 
lower-right of the grid. 

 

 Vertical: Turn the LEVEL knob in the TRIGGER control group to 
adjust the trigger's vertical threshold.   

Turn this knob to adjust the level of the trigger source or the 
highlighted trace. Level defines the source voltage at which the 
trigger will generate an event: a change in the input signal that 
satisfies the trigger conditions. 

Alternatively, in the Trigger dialog, you can touch inside the Level 
control and provide a value using your preferred input control 
method - for more information regarding the touch screen 
controls, refer to Dialog Area (on page 46). Quickly set a level of 
zero volts by touching the Zero Level button. 

An arrow on the right side of the grid shows the threshold 
position. This arrow is only visible if the trigger source is displayed. 

Trigger Setup 

Based on your Trigger Type selection, sections of the main Trigger dialog 
and additional dialogs altogether vary. 

Most trigger types have Type, Setup, and Level selections. The following 
sections explain some of the standard setup configurations for different 
trigger types. 
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1. Make your Type selection by touching the button corresponding 
to the desired trigger. 

 

2. Touch inside the trigger Source control for your first Setup 
configuration and select a source on which to trigger. 

 

3. If available, touch inside the Coupling control and select a 
coupling mode. 
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Coupling refers to the type of signal coupling at the input of the 
trigger circuit. Choices of trigger coupling vary by oscilloscope 
model.  

With DC coupling, all of the signal's frequency components are 
coupled to the trigger circuit for high-frequency bursts. 

4. Touch inside the trigger Slope control and choose the direction of 
the trigger voltage transition used for generating a particular 
trigger event. 

 

The selection is then shown to the right of the dialog as follows for 
a Positive Slope selection on an Edge Trigger. 
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Edge trigger works on the selected edge at the chosen level. The slope 

(positive or negative) is specified on the Trigger label permanently 
shown to the lower-right of the grid. 

4. Level defines the source voltage at which the trigger circuit 
generates an event (a change in the input signal that satisfies the 
trigger conditions). The selected trigger level is associated with the 
chosen trigger source. Note that the trigger level is specified in 
volts and normally remains unchanged when the vertical gain or 
offset is modified. 

The Amplitude and Range of the trigger level have limits as 
detailed in the datasheet specifications regularly maintained on 
www.lecroy.com. 

Touch inside the Level data entry control and provide a value 
using your preferred input control method - for more information 
regarding the touch screen controls, refer to Dialog Area (on page 
46). 

 

Provide a voltage level (in millivolts). 

PLEASE NOTE THE FOLLOWING:  

 Once specified, Trigger Level and Coupling are the only 
parameters remaining unchanged as you switch from trigger 
mode to trigger mode for each trigger source. 

http://www.lecroy.com/
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 Some additional controls and dialogs for triggers that differ are 
provided in the following topics as examples. 

Optimize for HF 

The Optimize for HF checkbox can be used on an Edge trigger to reject 
high or low frequencies. 

 

The checkbox is marked by default; meaning, the instrument is optimized 
for high-frequency waveforms. 

Note: If you are measuring a waveform that is 10 MHz or slower, be 
sure to unmark the checkbox to avoid triggering on an incorrect slope. 
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Width Condition is 

Width triggers (and other triggers equipped with conditional logic) have 
conditional logic settings as follows.  

 

Your Width Condition can be specified as Less Than, Greater Than, In 
Range and Out Of Range. 

In Range and Out Of Range conditions can be further set with Upper and 
Lower Values (for Limits). 

OR 

Nominal width and Delta (for Delta). 

Note: Width Condition settings are summarized on the far right of the 
dialog. 

Holdoff by Time or Events 

Holdoff is an additional condition of Edge and Pattern triggers. It can be 
expressed either as a period of time or an event count. Holdoff disables 
the trigger circuit for a given period of time or number of events after 
the last trigger occurred. Events are the number of occasions on which 
the trigger condition is met. The trigger resumes when the holdoff has 
elapsed and its other conditions are met.  

Select the holdoff by touching the Time or Events buttons on the Holdoff 
dialog. 
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Now, click the corresponding control and provide a value. 

Use holdoff to obtain a stable trigger for repetitive, composite 
waveforms. For example, if the number or duration of sub-signals is 
known you can disable them by choosing an appropriate holdoff value. 
Qualified triggers operate using conditions similar to holdoff. 

HOLD OFF BY TIME 

Sometimes you can achieve a stable display of complex, repetitive 
waveforms by placing a condition on the time between each successive 
trigger event. This time would otherwise be limited only by the input 
signal, the coupling, and the instrument's bandwidth. Select a positive or 
negative slope, and a minimum time between triggers. The trigger is 
generated when the condition is met after the selected holdoff time, 
counted from the last trigger. The delay is initialized and started on each 
trigger. 

 
Edge Trigger with Holdoff by Time. The bold edges on the trigger source 

indicate that a positive slope has been selected. The broken upward-pointing 
arrows indicate potential triggers, which would occur if other conditions are 

met. The bold arrows indicate where the triggers actually occur when the 
holdoff time has been exceeded. 

HOLD OFF BY EVENTS 

Select a positive or negative slope and a number of events. An event is 
the number of times the trigger condition is met after the last trigger. 
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A trigger is generated when the condition is met after this number, 
counted from the last trigger. The count is restarted on each trigger. For 
example, if the event number is two, the trigger will occur on the third 
event. 

 
Edge Trigger with Holdoff by Events (in this example, two events). The bold 
edges on the trigger source indicate that a positive slope has been selected. 

The broken, upward-pointing arrows indicate potential triggers, while the bold 
ones show where triggers actually occur after the holdoff expires. 

Auxiliary Input Trigger 

Some instrument models provide auxiliary input trigger capability. It's 
done as a pattern trigger, on the Ext dialog. 

 

Select X1, or ÷10. You can also select from DC50Ω, Gnd, and DC1MΩ 
Impedance values. 
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TriggerScan 

TriggerScan is a debugging tool (available for any trigger type) that helps 
you quickly find rare waveform glitches and anomalies. With TriggerScan, 
you can build a list of trigger setups to look for rare events and 
automatically sequence through each one. TriggerScan can use any type 
of trigger setup available including edge, width, and qualify as well as 
Smart Triggers (such as, glitch and runt triggers). TriggerScan automates 
two key processes in triggering rare events: 

1. Trains the system by looking at normal acquired waveforms. 
During the training, the oscilloscope analyzes the waveforms to 
determine what waveforms normally look like. Using this 
information, it generates a list of smart trigger setups to trigger on 
abnormal situations. 

2. Loads the smart trigger setups from the Trainer and cycles 
through these. As triggers occur, they are overlaid on the screen. 
All acquisition settings are preserved and you can use all the 
functions of the oscilloscope to find the root cause of these 
anomalies including, WaveScan, Histograms, and advanced 
analysis. 
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Training TriggerScan 

The TriggerScan Trainer inspects a currently acquired waveform and 
automatically builds a list of common trigger setups used to find rare 
events.  

PLEASE NOTE THE FOLLOWING:  

  You must acquire and display at least 3 cycles of a signal before 
running the Trainer. 

 You should run the Trainer if you want to change the trigger types 
or if you change the channel or signal. 

1. Touch Trigger → Trigger Setup... from the menu bar. 
2. On the Trigger dialog, click the TriggerScan tab. 
3. Touch the Trainer button and select a channel as the source for 

the training on the Trigger Scan Trainer pop-up. Also choose the 
types of triggers the Trainer should use to train the system and 
then touch the Start Training button. The training begins. When it 
is complete, a list of smart trigger setups is displayed in the Trigger 
List. 

 



WaveRunner 6 Zi Oscilloscopes 

87 WR6Zi-GSM-E 

Starting TriggerScan 

After you have run the Trainer, the Trigger List displays a list of smart 
trigger setups. You can add or remove trigger setups. You can also 
update the selected smart trigger setup. Once you have made any 
changes to the Trigger List, you are ready to start scanning. 

1. Touch Trigger → Trigger Setup... from the menu bar. 
2. On the Trigger dialog, click the TriggerScan tab and its 

corresponding dialog is shown. 

 

3. If you want to add a new trigger setup, touch the Trigger tab and 
set the new trigger as desired on the Trigger dialog. Then, back on 
the TriggerScan dialog, touch the Add New button to append the 
new trigger to the Trigger List. 

4. If you want to replace the selected trigger setup with the current 
trigger setup, highlight the setup in the Trigger List and touch the 
Update Selected button. 

5. If you want to shown a specific trigger setup on the Trigger List, 
highlight its corresponding row on the list, and then touch the 
Load Selected button. 

Note: If you want to delete all trigger setups in the Trigger List, 
touch the Delete All button. 

6. If you want to delete a trigger setup, highlight the setup in the 
Trigger List and touch the Delete Selected button. 

7. All trigger setups can be deleted regardless of selections on the 
Trigger List with one step by touching the Delete All button. 

5. Once you have made any changes to the Trigger List, touch the 
Trainer button and then restart the scan by touching the Start 
Training button on the Trigger Scan Trainer pop-up. The 
oscilloscope automatically sequences through all the trigger 
setups. 
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PLEASE NOTE THE FOLLOWING: 

 You can tune the dwell time that the oscilloscope waits 
before loading the next trigger setup using the Dwell Time 
data entry control. 

 If you have Persistence display mode enabled, all trigger 
events are recorded on the display. Refer to the 
Persistence Setup (on page 94) topic for instructions on 
enabling Persistence display mode. 

 If you want TriggerScan to stop when the next oscilloscope 
trigger, check the Stop On Trigger checkbox. You can use 
this to isolate specific trigger setups. 

Saving TriggerScan Setups 

You should save TriggerScan setups once you have made any 
modifications to the Trigger List. The current Trigger List is not be 
preserved after exiting the application unless you save it. 

1. On the TriggerScan dialog, touch inside the Setup File Name data 
entry control and providing a file name using your preferred input 
control method - for more information regarding the touch screen 
controls, refer to Dialog Area (on page 46). 

OR 
Touch the Browse button and select a location and file name. 

2. Touch the Save Setup... button. 

Note: You can load previously saved TriggerScan setups by touching the 
Browse button, locating the file, and then touching Load Setup....  

Viewing Waveforms 

Display 

Display Overview 

Oscilloscope display grids present the trace information in a voltage vs. 
time format. The oscilloscope analog-to-digital converter (ADC) 
information is displayed vertically on the grid with the ADC bits divided 
proportionally according to their amplitude on the grid. 
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Channel traces are typically 8-bits of vertical data, whereas Math traces 
are 16-bits of vertical data. LeCroy grids consist of eight vertical divisions. 

When displaying channel traces on the grid, use of less than full-grid 
amplitude results in some reduced vertical resolution and accuracy. For 
instance, if a channel trace is displayed as two divisions high on a grid, 
the number of ADC bits utilized is... 

2/8 * 2^8 or 64 bits 

This is quite less than the full 8-bit resolution. Such a reduction in vertical 
resolution may be acceptable if the primary measurement consideration 
is for rough timing measurements; however, if vertical accuracy or 
extreme timing accuracy is a requirement, it is better to increase the 
amplitude of the signal to utilize close to maximum grid height. 
Accomplishing this - while still providing the ability to view many signals 
at one time on the oscilloscope display - LeCroy provides multi-grid 
capability. This creates multiple oscilloscope grids, each with 8-bit 
vertical resolution, and allows many full-resolution grids (but vertically 
smaller in grid height) for concurrent display without affecting the 
vertical resolution. 

Different grid displays are available based on instrument and installed 
software packages. For example, some displays show side-by-side, 
instead of vertically stacked grids. The additional grid displays offer more 
convenient views of multiple waveforms. Refer to your instrument 
datasheet at www.lecroy.com for detailed information as to which grid 
displays are provided with your oscilloscope. 

Display Setup 

Access and adjust the different display configurations on our oscilloscope 
using the following steps: 

Note: Not all grid styles are available on all instruments. Grid styles 
vary based on both oscilloscope model and whether or not you have 
the SDAII software option loaded on your oscilloscope. Learn more 
about software options and Contact LeCroy for Support (on page 188). 

1. Touch Display → Display Setup... on the menu bar. 

http://www.lecroy.com/
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2. Touch one of the Display combination buttons. 

 

PLEASE NOTE THE FOLLOWING:  

 Small images label each Display combination button and indicate 
its corresponding grid configuration. 

 Autogrid automatically adds or deletes grids as you select more or 
fewer waveforms to display. 

3. Touch inside the Grid Intensity data entry control(as follows). 

 

Provide a value from 0 to 100. 
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4. Touch the Grid on top checkbox if you want to superimpose the 
grid over the waveform.  

Note: Depending on the grid intensity, some of your waveforms may be 
hidden from view when the grid is placed on top. To undo, simply 
uncheck Grid on top. 

3. Touch the Axis labels checkbox to permanently display the values 
of the top and bottom grid lines (calculated from volts/div) and 
the extreme left and right grid lines (calculated from the 
timebase). 

4. Choose a line style for your trace: solid Line or Points as follows: 

 

5. Touch inside the trace Intensity data entry control if you want to 
change the value. 

 

Enter a value from 0 to 100. 

Note: Access the Monitor tab for external monitor display settings. 
Refer to the External Display topic for more details. 

SEQUENCE MODE DISPLAY 

Set up a Sequence Mode display by first selecting a Sequence trigger 
mode in the Timebase → Horizontal Setup  dialog. You must also have 
entered a Num Segments value. For more information on setting up 
Sequence Mode, see the Sequence Sampling Mode (on page 56) topic. 

1. Touch Display → Display Setup... on the menu bar. 
2. Touch inside the Display Mode control and select a display mode 

from the pop-up menu. 



Getting Started Manual 

WR6Zi-GSM-E 92 

Touch inside the Num seg displayed control and enter a value, 
using the pop-up keypad. 

Touch inside the Starting at control and enter a value.  

Moving Traces from Grid to Grid 

You can move traces from grid to grid with the touch of a button. 

Moving a Channel or Math Trace 

1. Touch the trace descriptor label for the waveform you want to 
move. 

 

2. Touch the Next Grid button. 

 

Note: If you have more than one waveform displayed on only one grid, 
a second grid automatically opens when you select Next Grid. 

Displays Containing Masks 

Since masks are pixel-based display renderings, you can think of them as 
part of the Display feature set on your instrument. Masks and mask 
testing are applied to waveforms as part of Pass/Fail functionality 
accessed from Analysis → Pass/Fail from the menu bar. 

Note: For more detailed information about Masks and other Pass/Fail 
functionality, such as removing a mask from your display, refer to Mask 
Testing (on page 134). 
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Dual Display Grid Selection 

Make a dual grid display selection for showing on an external display 
(once properly connected to the I/O panel) by selecting Display → 
Display Setup.... Numbered labels on this image correspond with the 
following steps. 

 

Note: First-time setup may show a different Display tab. Fix this by 
touching File → Exit on the menu bar and re-launching the oscilloscope 
software using the Start DSO shortcut on the desktop. 

1. Touch the Dual button on the Display Mode section of the Display 
dialog. 

2. Touch inside the Grid control on the Grid Mode section of the 
dialog. The Select Grid pop-up is shown. 

3. Touch the Dual Display category and choose from Single/Single, 
Dual/Dual, and Quad/Quad options. 

Your grid selection is now shown on both displays. 
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Persistence 

Persistence Overview 

The Persistence feature helps you display your waveform and reveal its 
idiosyncrasies or anomalies for a repetitive signal. Use Persistence to 
accumulate on-screen points from many acquisitions to see your signal 
change over time. The instrument persistence modes show the most 
frequent signal path in three-dimensional intensities of the same color, 
or graded in a spectrum of colors. 

You can show persistence for up to eight inputs for any channel, math 
function, or memory location (M1 to M4). 

Persistence Setup 

Touch Display → Persistence Setup... on the menu bar. 

Now, touch the Persistence On checkbox and refer to the following 
scenarios based on your needs. 

Persistence Setup for All Input Channels at Once 

1. Touch the All Locked button. 

 

2.  Touch one of the Mode buttons. 

 

3. Touch the Show last trace checkbox if you want the last trace 
displayed. 

4. Touch inside the Saturation data entry control and provide a 
whole number integer. 

For more information on saturation, see the Saturation Level 
topic. 

5. Touch inside the Persistence time data entry control and make a 
selection from the pop-up menu. 



WaveRunner 6 Zi Oscilloscopes 

95 WR6Zi-GSM-E 

Persistence Setup for Each Input Channel Individually 

1. Touch the Per Trace button. 

 

2. Touch one of the persistence mode buttons next to an input 
channel. 

 

To turn off persistence for an individual channel, touch the left-
most persistence mode button next to the channel. 
OR 

For each input channel, touch its tab to set up persistence for that 
channel. 

3.  Touch one of the mode buttons. 

 

4. Touch the Show last trace checkbox if you want the last trace 
displayed. 

5. Touch inside the Saturation data entry control and enter a whole 
number integer,. 

6. Touch inside the Persistence time data entry control and make a 
selection from the pop-up menu. 

7. If you want to return all input channel setups to their default 
settings, touch the Reset All button. 
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WaveStream Display Mode 

 

This fast viewing mode provides brightness-graded intensity with a decay 
time similar to the action of phosphor on an analog screen. 

WaveStream mode operates at up to 80 GS/s with an update rate of up 
to several thousand waveforms/second for better capture of higher 
frequency abnormal events. 

Adjusting Trace Intensity 

The INTENSITY knob adjusts the brightness of your trace. 

The intensity value is shown in the bottom-right corner of the screen. 

 

PLEASE NOTE THE FOLLOWING:  

Pushing the Intensity knob changes the Persistence status in the 
following ways.  

 OFF - When the button hasn't been pushed, it may be turned to 
control the trace Intensity control value. 

 Analog Persistence - When the button is pushed once, the 
waveform resembles a trace on a phosphor oscilloscope. Turning 
the knob affects persistence with a blended form of Intensity and 
Saturation. As the knob is turned clockwise, the Intensity value 
increases while the Saturation value decreases. The opposite 
occurs when the button is turned counter clockwise. 

 

 Color Persistence - The button behaves the same way as Analog. 
However, the grid display shows a color waveform where red 
indicates most frequent occurrences while blue denotes the less 
frequent. 

Instead of using the knob, you can provide values for Intensity (same 
control on Display and Persistence dialogs) or Saturation controls. 
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Zooming Waveforms 

Zooming Waveforms Overview 

 You can magnify a selected region of a waveform using the Zoom 
function. You can display up to four Zoom (Z1 - Z4) and eight Math Zoom 
traces (F1 - F8).You can zoom: 

  a single channel (known as To Zoom a Single Channel (on page 
98)) 

 a math or memory trace (known as Zooming Memory or Math 
Function Traces) 

 multiple waveforms at once (known as  To Zoom Multiple 
Waveforms Quickly (on page 100)) 

 segments in a sequence (found in  Sampling Modes → Sequence 
Sampling Mode (on page 56) 

You can also use the Multi-Zoom Math function to create time-locked 
zoom traces for selected waveforms using Multi-Zoom. 

At any time, you can zoom a portion of a channel waveform or 
Memory/Math function trace by touching and dragging a rectangle 
around any part of the input waveform, see the To Zoom by Touch-and-
Drag (on page 100) topic. The zoom trace will size itself to fit the full 
width of the grid. The degree of magnification, therefore, will depend on 
the size of the rectangle that you draw. 

You can also use the front panel QUICKZOOM button to create multiple 
zooms, one for each displayed input channel. For more information, see 
the To Zoom Multiple Waveforms Quickly (on page 100) topic. 
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Previewing Zoomed Waveforms 

When you zoom a waveform, a preview of the zoomed area is shown on 
the Preview section of the Zx dialog. 

 

Zooming a Single Channel 

The Zoom button appears as a standard button at the bottom of the 
channel Cx Vertical Adjust setup dialog for you to create a zoom trace of 
your input waveform. 

 

1. On the menu bar, touch Vertical → Channel X Setup....  
OR 
Touch the channel trace descriptor label for a displayed channel. 

 

2. Touch the Zoom at the bottom of the Cx Vertical Adjust dialog. A 
zoom trace (one of Z1 to Z4) is created for the selected channel. 

 

3. Vary the degree of zoom by touching the newly created Zx trace 
label. The setup dialog for the zoom (Z1 to Z4) opens. It shows the 
current horizontal and vertical zoom factors. 
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4. If you want to increase or decrease your horizontal or vertical 
zoom in small increments, touch the Var. checkbox to enable 
variable zooming. Now with each touch of the zoom control 
buttons, the degree of magnification changes by a small 
increment. 

 
OR 

If you want to zoom in or out in large standard increments with 
each touch of the zoom control buttons, leave the Var. checkbox 
unchecked. 

OR 
If you want to set exact horizontal or vertical zoom factors, touch 
inside the Horizontal Scale/div data entry control and provide a 
time-per-div value using your preferred input control method - for 
more information regarding the touch screen controls, refer to 
Dialog Area (on page 46). Then touch inside the Vertical Scale/div 
control and enter a voltage value. 

PLEASE NOTE THE FOLLOWING: 

To reset the zoom to x1 magnification, touch Reset Zoom in the dialog.  

You can also use the Zoom and Math front panel knobs to adjust the 
horizontal and vertical zoom. 

 Horizontal Position - Press to reset the horizontal zoom position 
to zero. Turn to change the horizontal position of the selected 
math or zoom trace. 

 Horizontal Ratio - Press to toggle between fixed and variable 
horizontal zoom ratio adjustment. Turn to change the horizontal 
zoom ratio of the selected math trace. 

 Quick Zoom - Press to automatically display magnified views of up 
to four signal inputs on multiple grids. With four input signals, the 
signals are displayed along with four zoom traces, each on its own 
grid. Pressing this button also turns off all other traces. 
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 Vertical Position - Press to reset the vertical zoom position to 
zero. Turn to change the vertical position of the selected math or 
zoom trace. 

 Vertical Ratio - Press to toggle between fixed and variable vertical 
zoom ratio adjustment. Turn to change the vertical zoom ratio of 
the selected math trace. 

Touch-and-Drag Zooming 

1. Touch and drag a rectangle around any part of an input channel 
waveform, math trace, or memory trace. The Zoom (Z1 to Z4) 
dialog opens. 

Note: If you have enclosed a combination of channel and math or 
memory traces in the rectangle, a pop-up Rectangle Zoom Wizard is 
shown. Touch a Zoom button (Z1 to Z4). 

2. Turn off the zoom traces by touching the Undo button at the top-
right corner of the screen. 

 

OR 
Uncheck the Trace On checkbox in the dialog for each zoom trace. 

 

Quickly Zooming Waveforms and Multiple 
Waveforms 

Quickly create a Zoom trace by either pressing the front panel Zoom 
button or touching the Zoom button on the respective channel dialog. 
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Turning Off Zoom 
Turn off a Zoom by either pressing the front panel Zoom button again. 

OR 

On the corresponding Zoom dialog, touch the Trace On checkbox to 
remove the check mark and disable the zoom trace. 
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Measuring with Cursors 

Measuring with Cursors Overview 

Cursors are important tools that aid you in measuring signal values. 
Cursors are markers - lines, cross-hairs, or arrows - that you can move 
around the grid or the waveform itself. Use cursors to make fast, 
accurate measurements and eliminate guesswork. There are two basic 
types: 

 Horiz(ontal) (generally Time or Frequency) cursors are markers 
that you move horizontally along the waveform. Place them at a 
desired location along the time axis to read the signal’s amplitude 
at the selected time. 

 Vert(ical) (Voltage) cursors are lines that you move vertically on 
the grid to measure the amplitude of a signal. 

Cursor Measurement Icons 

Each cursor locates a point on the waveform. The cursor values can be 
read in the descriptor label for the trace. Use the Position data entry 
controls at the right side of the dialog to place the cursors precisely. The 
Readout icons depict what is being measured for each measurement 
mode. 

Absolute 

 

Displays the absolute Y position. 

Delta 

 

Displays the difference in Y values. The value can be read in the 
descriptor label for the trace. 
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Abs+Delta 

 

Displays absolute and delta cursors together. 

Slope 

 

Displays the slope between cursors. 

If there are non–time-domain waveforms displayed, there will also be a 
menu offering choices of x-axis units: s or Hz, for example. 

Cursors Setup 

Quick Display 

At any time, you can change the display of cursor types (or turn them off) 
without invoking the Cursors Setup... dialog as follows: 

1. On the menu bar, touch Cursors, then Off, Abs Horizontal, Rel 
Horizontal, Abs Vertical, or Rel Vertical. 
OR 
Press the CURSOR TYPE button on the front panel repeatedly to 
scroll through each cursor type. Turn the CURSORS knobs to adjust 
the position of the cursor. 

Note: The bottom cursor knob adjusts relative cursors. It does not work 
with absolute cursor types. 

2. The cursors displayed assume the positions previously set up. If 
you want to change their position or measurement mode, touch 
Cursors → Cursors Setup... on the menu bar. 

Absolute Cursors Setup 

1. Touch Cursors → Cursors Setup... on the menu bar. The Standard 
Cursors dialog opens. 
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2. In the dialog area, touch the Cursors On check box to display 
them. 

3. Touch the Horizontal Abs or Vertical Absmode button. 
4. Touch inside the Position 1 data entry control and type in a value 

for the cursor. 

OR 
Use the CURSORS knobs on the front panel to place the cursor. 

Setting Up Relative Cursors 

1. Touch Cursors → Cursors Setup... on the menu bar. The Standard 
Cursors dialog opens. 

2. In the dialog area, touch the Cursors On check box to display 
them. 

3. Touch the Horizontal Rel or VerticalRel mode button. 
4. Touch a readout parameter button: Absolute, Delta, Abs+Delta, 

or Slope. 
5. Touch inside the Position 1 and Position 2 data entry controls and 

type in a value for each cursor. 

 
OR 
Use the CURSORS knobs on the front panel to place the cursors. 

6. If you want both cursors to move in unison as you adjust the 
position, touch the Track check box to enable tracking. 

Cursors on Math Functions 

You can place cursors on a math function whose X-axis has a dimension 
other than time (FFT, for example). On the Cursors Setup... dialog, an X-
Axis menu is available where you can choose the units. For example, if 
you are placing cursors on a histogram, select V (histo). 
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Measurement Parameters 

Measurement Parameters Overview 

Parameters are measurement tools that determine a wide range of 
waveform properties. Use them to automatically calculate many 
attributes of your waveform, like rise-time, rms voltage, and peak-to-
peak voltage, for example. 

There are parameter modes for the amplitude and time domains, custom 
parameter groups, and parameters for pass and fail testing. You can 
make common measurements on one or more waveforms. 

Turning On Parameters 

1. Touch Measure → Measure Setup... on the menu bar. 
2. Touch the On checkbox for each parameter you want to enable.  
3. Touch the Show Table checkbox to display the parameters below 

the grid. 

Quick Access to Parameter Setup Dialogs 

You can quickly gain access to a parameter setup dialog by touching the 
parameter list box below the grid. 

 

For example, touch within P1 below the grid (previous) to display the P1 
setup dialog. 
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Touch the row titles (as follows) to display the top Measure dialog. 

 

Parameter Setup 

1. Touch the parameter tab (Px) of an unused location or one that 
you want to change. 

2. Under Type, select a measurement type: 

Measure On Waveforms 

 

Applies measurements directly on the waveform as indicated on 
the Source1 control. 

Math On Parameters 

 

Performs math (addition, subtraction, multiplication, division) on 
parameters indicated on the Source1 and Source2 controls.  

Advanced Web Edit 

 

Selecting this type uses LeCroy's Processing Web for measurement 
setup. This feature, available with the XWEB option, allows you to 
chain practically unlimited math functions together for operation 
on your waveform measurements. 

3. Touch inside the Source1 field and select a channel, math trace, 
memory trace, or other waveform to be measured. 
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4. If you selected Measure On Waveforms, touch inside the 
Measure field and select a parameter from the pop-up menu. 

 

OR 
If you selected Math On Parameters, touch inside the Math 
Operator data entry field and select a math function from the 
pop-up menu. 
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5. In the mini-dialog to the right of the main setup dialog, touch the 
Gate tab to narrow the span of measurement - as covered in the 
Measure Gate topic (available in the online help files). 

6. Touch the Accept tab to define parameter values to be used in the 
measurement - as covered in the Qualified Parameters topic 
(available in the online help files). 

Measure Modes 

The selections for Measure Mode allow you to quickly apply parameters 
for standard vertical and standard horizontal setups, and custom setups. 

Standard Vertical Parameters 

These are the default Standard Vertical Parameters: 

Vertical 

mean sdev max. min. ampl pkpk top base 

Standard Horizontal Parameters 

These are the default Standard Horizontal Parameters: 

Horizontal 

freq period width rise fall delay duty num points 

Selecting Measure Modes 
1. Touch Measure → Measure Setup... on the menu bar. 
2. Under Measure Mode, select the Std Vertical or Std Horizontal 

buttons. 

Note: You can customize parameters by touching My Measure. Learn 
more in the Customize a Parameter topic (available in the online help 
files). 

3. Touch inside the Source data entry control and choose a source 
for which the measurements should apply. 

Help Markers 

Help Markers clarify parameter measurements by displaying movable 
cursors and a visual representation of what is being measured. 
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For the at level parameters, Help Markers make it easier to see where 
your waveform intersects the chosen level. This feature also displays the 
hysteresis band that you have set about that level. 

You also have the option, by means of an Always On checkbox, to leave 
the Help Markers displayed after you have closed the Help Markers 
setup dialog. 

You have a choice of Simple or Detailed views of the markers: 

 The Simple selection produces cursors and Measure Gate gate 
posts. The gate posts are independently placeable for each 
parameter. 

 The Detailed selection produces cursors, Measure Gate gate 
posts, a label identifying the parameter being measured, and a 
level indicator and hysteresis band for at level parameters (not 
part of Standard Horizontal or Standard Vertical parameters). 

 
Standard Horizontal Parameter Help Markers 
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Standard Vertical Parameter Help Markers 

Help Markers Setup 

1. Touch Measure → Measure Setup... on the menu bar. 
2. Select a Measure Mode: Std Vertical, Std Horizontal, or My 

Measure. 
3. Touch the Show All button (as follows) to display Help Markers for 

every parameter being measured on the displayed waveform (C2 
in the previous examples). 

 

4. Touch a Px for any listed parameter; it doesn't matter which. 

 

Now, on its corresponding dialog, touch inside the Help Markers 
control and select Simple or Detailed. The Simple selection 
produces cursors and Measure Gate gate posts. The gate posts are 
independently placeable for each parameter. 
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The Detailed selection produces cursors, Measure Gate gate 
posts, a label identifying the parameter being measured, and a 
level indicator and hysteresis band for "at level" parameters. 

Note: The choice of Simple or Detailed is applied to all parameters at 
the same time. That is, if you choose Simple markers for one 
parameter, all parameters are then displayed in this mode. 

5. Touch the Always On checkbox if you want to continuously display 
Help Markers for this parameter. 

TURNING OFF HELP MARKERS 

1. Touch the Clear All button to turn off Help Markers for all 
parameters. 

 

2. Turn off Help Markers for individual parameters by touching the 
Px tab for the parameter in question. Then uncheck the AlwaysOn 
checkbox. When you close this dialog, the Help Markers for this 
parameter are no longer shown. 

Measurement Parameter Analysis 

Measurement Parameter Analysis Overview 

LeCroy provides a variety of unique capabilities for advanced 
measurement parameter analysis. Most LeCroy oscilloscopes calculate 
measurements for all instances in the acquisition. This provides the 
ability to rapidly and thoroughly analyze a long memory acquisition and 
calculate thousands or millions of parameter values, or find anomalous 
measurements. A variety of views are then provided allowing quick and 
easy measurement value understanding, as follows: 

 Histograms provide a view of the measurement parameter 
distribution. See Create and View a Histogram (on page 113). 

 Tracks provide a time-correlated view of a measurement 
parameter compared to other acquired channels or calculated 
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math traces. A common usage for track is to observe the 
modulation of a signal, such as amplitude, frequency, or pulse 
width modulation. See Creating a Track View (on page 121). 

 Trends provide a view of the measurement parameter over an 
extended period of time and over multiple acquisitions. See 
Creating and Viewing a Trend (on page 120). 

 Pass/Fail Testing (on page 122) allows definition of the normal or 
abnormal measurement parameter value with a definable 
pass/fail action alerting the operator when a condition is met. 

 WaveScan allows searching through a single acquisition for a 
measurement parameter that meets a variety of conditions, or 
scanning through multiple acquisitions with allowable trigger 
actions when conditions are met. In addition, a variety of views 
can be used to understand the specific behaviors of searched or 
scanned measurement parameters. See Introduction to 
WaveScan (on page 139). 

These capabilities are only possible with the measurement of every 
occurrence of a measurement parameter in a long acquisition. 

Both Track and Trend are tools that can be used to plot measurement 
data and observe variations with respect to time. Differences between 
Track and Trend are summarized in the following table: 

Characteristic Track Trend 

Representation Parameter value 
vs. time 

Parameter value vs. event 

Behavior Non-cumulative 
(resets after 
every 
acquisition). 
Unlimited 
number of events 

Cumulative over several 
acquisitions up to 1 
million events 
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Characteristic Track Trend 

Time Correlation to 
Other Data 

Yes No 

Monitors an 
Evolution in the 
Frequency Domain 

Yes No. Trend points are not 
evenly spaced in time and 
therefore cannot be used 
for an FFT. 

Monitors the 
Evolution of a 
Measurement 
Parameter over 
Several 
Acquisitions 

No. Track resets 
after every 
acquisition. 

Yes 

Ensures No Lost 
Measurement Data 

Yes. Maximum 
time period that 
can be captured 
is limited by 
acquisition 
memory and 
sampling rate. 

No. Since data can be 
accumulated over many 
acquisitions, and since the 
oscilloscope takes time to 
calculate measurement 
values and to display data 
before the trigger is re-
armed, data can be 
missed. 

In general, Track is the tool to use if you want to capture a continuous 
stream of data spaced closely together. To understand the change in a 
parameter with time, Trend can be used if your data is spaced widely 
apart and longer than the dead-time of the oscilloscope between 
acquisitions. Think of Trend as a strip chart recorder for your 
oscilloscope. 

Creating and Viewing a Histogram 

Histograms are graphical representations of data which divides it into 
intervals or bins. These intervals/bins are plotted on a bar chart such that 
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the bar height relates to the number of data points inside each 
interval/bin. Various histograms can be setup using Measure or Math 
dialogs. Thumbnail versions of Histograms are called Histicons. Also, 
Persistence can be applied to Histograms. 

PLEASE NOTE THE FOLLOWING:  

1. The number of sweeps comprising the histogram is shown on the 
trace descriptor label: 

 

2. The range of a histogram is limited to the portion of the trace that 
is visible on screen. That is, if you zoom in on a trace, the 
histogram does not contain data for that part of the original (no 
longer visible) trace. 

Single Parameter Histogram Setup 

Setup a single parameter histogram can be done from Measure or Math 
dialogs. The following sections demonstrate both methods. 

SINGLE PARAMETER HISTOGRAM SETUP USING MEASURE 

Touch Measure → Measure Setup... on the menu bar to access the 
Measure dialog. The My Measure button should be selected by default 
on the Measure dialog. 

There are two ways to select parameters when setting up your 
measurement. They only differ in the order of the steps. 



WaveRunner 6 Zi Oscilloscopes 

115 WR6Zi-GSM-E 

 Using the Px Buttons on the Measure Dialog - After directly 
touching a Px button on the Measure dialog, the Select 
Measurement pop-up is shown. 

 
The Select Measurement pop-up. 

 Using a Corresponding Px Tab/Dialog - After directly accessing a 
corresponding Px dialog, touch the Measure control and the 
Select Measurement pop-up is shown. 

Regardless of how you performed the previously described initial steps, 
at this point access your corresponding Px dialog to change other setup 
items as follows: 

1. Touch inside the Source1 control and select an input waveform 
from the Select Source window. 

2. Touch inside the Measure field and select a parameter from the 
Select Measurement window. 
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3. Touch the Histogram button at the bottom of the dialog. After 
touching this button, the Math selection for Histogram pop-up is 
shown. Select the desired Math Trace in which to store the 
results. Touch the Close button when you are finished. 

 

Touch the trace descriptor label for the math trace just created for the 
results, and then touch the Histogram tab to access its right-hand dialog. 

 

Numbered callouts on the previous image correspond with the following 
explanations. 

1. On the Buffer side of the Histogram right-hand dialog, touch 
#Values and provide a value. 

2. On the Scaling side of the Histogram right-hand dialog, touch 
#Bins and provide a value. 

3. Center the histogram by touching the Find Center and Width 
button. 
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4. Instead of using the Find Center and Width button, you can 
provide specific Center and Width values using their respective 
controls and providing values using the pop-up numeric keypad. 

SINGLE PARAMETER HISTOGRAM SETUP USING MATH 

Access the main Math dialog by selecting Math → Math Setup... on the 
menu bar. 

There are two ways to select your math operator during setup. They only 
differ in the order of the steps. 

 Using the Fx Buttons on the Math Dialog - After directly 
touching an Fx button on the Math dialog, the Select Math 
Operator pop-up is shown. 

 
Math functions are categorized into Basic and Special. 

 Using a Corresponding Fx Tab/Dialog - After directly accessing a 
corresponding Fx dialog, touch the Operator control and the 
Select Math Operator pop-up is shown. 
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Regardless of how you performed the previously described initial steps, 
at this point access your corresponding Fx dialog if you want to change 
other setup items as follows: 

 

 You can modify the source of your waveform used on a Math 
trace using the source (Source 1) control. 

 On the far left of the Fx dialog, the single and dual buttons are 
available for one math function or math-on-math, respectively. 

 The web edit button is used to access the Processing Web and 
sequence highly-detailed math functionality. 

 Touch the Graph button, and then touch inside the Graph with 
control to select a graph mode (in this case Histogram). 

At this point, access the Histogram right-hand dialog by touching the 
Histogram tab on the far-right of the screen. Follow the final 1 - 4 steps in 
the previous Single Parameter Histogram Setup Using Measure 
instructions. 

Viewing Thumbnail Histograms (Histicons) 

Histicons are miniature histograms of parameter measurements that 
appear below the grid. These thumbnail histograms let you see at a 
glance the statistical distribution of each parameter. 
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1. On the menu bar, touch Measure, then one of the Measure 
Mode buttons: Std Vertical, Std Horizontal, or My Measure. 

2. Touch the Histicons checkbox to display thumbnail histograms 
below the selected parameters. 

Note: For measurements set up in My Measure, you can quickly display 
an enlarged histogram of a thumbnail histogram by touching the Histicon 
you want to enlarge. The enlarged histogram appears superimposed on 
the trace it describes. This does not apply to Std Vertical or Std 
Horizontal measurements. 

Persistence Histogram 

You can create a histogram of a persistence display also by cutting a 
horizontal or vertical slice through the waveform. You also decide the 
width of the slice and its horizontal or vertical placement on the 
waveform. 

Note: This math operation is different than the Histogram math 
operation and is not affected by Center and Width settings made on any 
existing Histograms. 

PERSISTENCE HISTOGRAM SETUP 

1. Touch Math → Math Setup... on the menu bar. 

2. Either directly touch an Fx button on the Math dialog and select 
your Math Operator, or touch an Fx tab to show its 
corresponding dialog and touch the Operator1 dialog to select 
your Math Operator. Select Phistogram from the Select Math 
Operator pop-up. 

 

3. With your math operator selected and the Fx dialog shown, 
touch inside the Source1 field and select a source from the pop-
up. 
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4. Touch the Phistogram tab to access its right-hand dialog. Now, 
touch the Slice Direction control and select Horizontal or 
Vertical slice from the pop-up. 

5. Touch inside the Slice Center field and enter a value using the 
pop-up keypad. 

6. Touch inside the Slice Width field and enter a value, using the 
pop-up keypad. 

Persistence Trace Range 

Using this math operatior, you can enter the percent of the persistence 
trace population to use in creating a new waveform. 

Note: See previous sections for details around setting up a math trace 
and selecting your math operator if needed. 

Persistence Sigma 

Using this math operation, you can enter a scale, measured in standard 
deviations, by which to create a new waveform. 

Creating and Viewing a Trend 

1. In the menu bar, touch Measure → Measure Setup.... 
2. Touch one of parameter tabs Px showing its corresponding dialog. 
3. Now, on the dialog, touch inside the Source1 data entry field and 

select an input waveform from the pop-up menu. 
4. Touch inside the Measure data entry field and select a parameter 

from the pop-up menu. 
5. Touch the Trend button at the bottom of the dialog. 

 

Now, from the Math selection for Trend menu, select a math 
function location Fx in which to store the Trend display. 
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The Trend is then shown along with its respective trace descriptor 
label for the selected math function. 

 

6. Touch the newly displayed Trend math function trace label to 
change settings on the Trend dialog (located on the Trend tab at 
the lower-right side of the screen). 

 

Note: Turning off a trace for which trend data is being collected resets 
the trend. If it is necessary to continue data collection for the trend, 
first create a zoom trace of the channel trace (before turning off the 
channel trace). 

Creating a Track View 

1. In the menu bar, touch Measure → Measure Setup.... 
2. Touch a parameter tab Px and its corresponding dialog is shown. 
3. Now, on the dialog, touch inside the Source1 data entry field and 

select an input waveform from the pop-up menu. 
4. Touch inside the Measure data entry field and select a parameter 

from the pop-up menu. 
5. Touch the Track button at the bottom of the dialog. 
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Now, from the Math selection for Track menu, select a math 
function location (Fx) on which to store the Track display. The 
Track is then shown along with its respective trace descriptor label 
for the selected math function. 

 

6. Touch the newly displayed Track math function trace label if you 
want to change any settings in the Track dialog: 

 

Pass-Fail Parameter Testing 

Pass/Fail Parameter Testing Overview 

Access the main Pass/Fail dialog by selecting Analysis → Pass/Fail 
Setup... from the menu bar. The main Pass/Fail dialog is shown. 

 

Access the respective Qx dialogs either by touching a Qx button on this 
main Pass/Fail dialog, or touching a Qx tab as described in Displays 
Containing Masks (on page 92). 
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When you have each of the Qx dialogs configured and enabled as 
desired, you can then begin your testing and turn them all on or off using 
the Testing checkbox on the main Pass/Fail dialog. You can also specify 
Actions for all or some of your conditions using the Actions dialog.  

Testing and Enabling Pass/Fail Conditions 

Beside each Qx button on the main Pass/Fail dialog is a corresponding Qx 
checkbox. 

 

Use either these checkboxes or the ones on each respective Qx dialog to 
enable the specific condition for use. 
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When you have each of the Qx dialogs configured and enabled as 
desired, you can then begin your testing and turn them all on or off using 
the Testing checkbox on the main Pass/Fail dialog. 

 

Your test data is shown on the Table display area shown in the previous 
screen-shot. 

Pass/Fail Setup on Qx Dialogs 

The Qx dialog contains several controls for specifying your Pass/Fail 
setup. 

MAIN QX DIALOG CONTROLS 

Use the Source1 control to specify the waveform you'll use for your 
Condition. 

Set your Pass/Fail condition by touching the Condition control on the 
corresponding Qx dialog. The Pass/Fail Condition pop-up is shown. 

 



WaveRunner 6 Zi Oscilloscopes 

125 WR6Zi-GSM-E 

Select the desired condition. 

Note: Right hand dialogs back on the corresponding Qx dialog vary 
based on the Pass/Fail condition selected. 

The following sections cover the right hand dialogs for Bool identity and 
Param and Dual Param Compare. The Mask test condition is covered in 
Mask Testing (on page 134). 

CONDITION-BASED RIGHT-HAND DIALOGS 

The following provide some explanation about the different Conditions 
and their respective right-hand dialogs. 

Boolean Identity 

This condition simply passes the input values through as the desired 
result. 

Param and Dual Param Compare 

Using the Param Compare conditions, each Pass/Fail input (Qx) can 
compare a different parameter result to a user-defined limit (or 
statistical range) under a different condition. 

Comparing a Single Parameter 

1. With the ParamCompare condition selected on a Qx dialog, touch 
inside the Compare Values field and select All or Any from the 
pop-up menu. 

 

By selecting All, the test are true only if every waveform falls 
within the set limit. Selecting Any makes the test true if just one 
waveform falls within the limit. 
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2. Touch inside the Condition field on the ParamCompare part of the 
dialog and select a math operator from the pop-up menu. 

 

3. Touch inside the Limit field and enter a value using the pop-up 
numeric keypad. The value entered acquires the dimensions 
corresponding to the parameters being tested. For example, if you 
are testing a time parameter, the unit is seconds. 

 

If you choose either WithinDeltaPct or WithinDeltaAbs from the 
Condition menu (respectively, previous), you also have the choice 
of setting the limit by means of the statistical buttons (relating to 
standard statistical limits) at the bottom of the ParamCompare 
dialog: 

 

Comparing Dual Parameters 

In Dual Parameter Compare mode, your oscilloscope can take parameter 
results measured on two different waveforms and compare them to each 
other. If desired, set your test to be true if Any or All waveforms fit the 
criteria set by the comparison condition. 
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Setups are conveniently shown in the Summary box of the Qx dialog as 
follows (shown on the Dual Param Compare right-hand dialog): 

 

 

1. Touch Analysis → Pass/Fail Setup... from the menu bar. 
2. Touch one of the Qx tabs and a setup dialog for the position is 

shown. 
3. Touch inside the Condition field in the main dialog and select 

DualParamCompare. 

 

4. Touch inside the Source1 and Source2 fields and select a source 
from the pop-up menu. 

5. Touch inside the ParamCompare mini-dialog field and select a 
source from the pop-up menu. 

6. Touch inside the Compare Values field and select All or Any from 
the pop-up menu. 

 

By selecting All, the test are true only if every waveform falls 
within the set limit. Selecting Any makes the test true if just one 
waveform falls within the limit. 
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7. Touch inside the Condition field on the ParamCompare part of the 
dialog and select a math operator from the pop-up menu. 

 

8. Touch inside the Limit field and enter a value, using the pop-up 
numeric keypad. This value takes the dimension of the parameter 
that you are testing. For example, if you are testing a time 
parameter, the unit is seconds. 

9. If you choose either WithinDeltaPct or WithinDeltaAbs from the 
Condition menu respectively, touch inside the Delta field and 
enter a value. 

 

The Actions Dialog 

Various configurations can be made to all or some of your Pass/Fail 
conditions using the Actions dialog. 

 

By touching the Stop Testcheckbox in the Actions dialog, you can set up 
the test to end after a predetermined number of sweeps that you decide. 
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You can also decide the actions to occur upon your waveforms' passing 
or failing, by selecting one or all of the following: 

 stop 

 audible alarm 

 print image of display 

 emit pulse (if available) 

 save waveform 

The Pulse checkbox (shown right) causes a pulse to 
be output through the Aux Out connector at the 
front of the oscilloscope. 

This pulse can be used to trigger another oscilloscope. You can set the 
amplitude and width of the pulse as described in Auxiliary Output 
Signals. 

Depending on your oscilloscope model, you can configure up to 8 
pass/fail conditions. The Boolean conditions to determine if your 
waveform passes are as follows: 

Pass/Fail Boolean Conditions 

All True All False 

Any True Any False 

All Q1 to Q4 Or All Q5 to Q8 Any Q1 to Q4 And Any Q5 to Q8 

PASS/FAIL TESTING SETUP 

Initial Setup 

1. Touch Analysis → Pass/Fail Setup... on the menu bar. 
2. Touch the Actions tab. 
3. Touch the Enable Actions checkbox. This causes selected actions 

to occur on your waveform's passing or failing a test. 
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4. Touch the Summary View checkbox to enable a line of text (as 
follows) showing a concise status of the last waveform and 
keeping a running count of how many sweeps have passed. 

 

5. Touch inside the Pass If control, and select a Boolean condition 
from the choices shown. 

6. If you want to set up the test to end after a finite number of 
sweeps, touch the Stop Test checkbox. Then touch inside the 
After data entry control and provide a value using your preferred 
input control method - for more information regarding the touch 
screen controls, refer to Dialog Area (on page 46). 

7. Use either the Pass or Fail button on the If section of the dialog to 
set actions taking place when your waveform passes or fails the 
test. 

 

8. The Then section of the dialog provides stop test, sound alarm, 
print result, emit pulse, or save (the waveform) actions. If you 
want to have the results printed (and your oscilloscope is not 
equipped with a printer) make sure your instrument is connected 
to a local or network printer. Learn more in the Printing and 
Hardcopy FunctionsPrinting and Hardcopy Functions topic  
(available in the online help files). 

9. If you want to save your waveform automatically, touch the Save 
Setup... checkbox. This takes you out of the current dialog and 
opens the Save Waveform dialog. Learn more in the Save Recall 
→ Saving and Recalling WaveformsSaving and Recalling 
Waveforms topic  (available in the online help files). 

10. Test Pass/Fail conditions by touching the Force Actions Once 
button. Press the Clear All button to quickly uncheck all 
checkboxes and make new selections. 
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Math 

Math Traces and Functions Overview 

LeCroy offers a deep toolset of math functions always growing and 
changing to provide superior functionality. 

Note: To find out which math tools are available in each optional 
package or for any detailed explanations about specific functionality, it's 
always a good idea to check the more comprehensive online help 
onboard your instrument, datasheet materials regularly maintained on 
the LeCroy website at www.lecroy.com, and to Contact LeCroy for 
Support (on page 188) and confer with your local LeCroy sales 
representative. 

The extreme power of LeCroy’s math functions is most evident when 
used: 

 to perform mathematical functions on waveforms displayed on 
any channel Cx. 

 to perform mathematical functions on waveforms recalled from 
memory Mx. 

 as a source input waveform Fx in order to perform computations 
in sequence.  

 as parameters Px. 

Instruments offering more than one math trace provide even more 
enhanced capabilities. For example: 

 setting up Trace F1 as the difference between Channels 1 and 2 
 having trace F2 provide the average of F1 
 having trace F3 provide the integral of F2 
 go even further and display the integral of the averaged 

difference between Channels 1 and 2. 

You can even chain traces and/or functions to another trace or 
function. For instance: 

 making Trace F1 an average of Channel 1. 
 making Trace F2 an FFT of F1. 
 making Trace F3 a zoom of F2. 

http://www.lecroy.com/
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Math Setup 

Access the main Math dialog by selecting Math → Math Setup... on the 
menu bar. 

There are two ways to select your math operator during setup. They only 
differ in the order of the steps. 

 Using the Fx Buttons on the Math Dialog - After directly 
touching an Fx button on the Math dialog, the Select Math 
Operator pop-up is shown. 

 
Math functions are categorized into Basic and Special. 

 Using a Corresponding Fx Tab/Dialog - After directly accessing a 
corresponding Fx dialog, touch the Operator control and the 
Select Math Operator pop-up is shown. 
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Regardless of how you performed the previously described initial steps, 
at this point access your corresponding Fx dialog if you want to change 
other setup items as follows: 

 

 You can modify the source of your waveform used on a Math 
trace using the source (Source 1) control. 

 Touch the Single function button if you want to perform just one 
math function on the trace, or touch the Dual function button to 
perform math on math (shown respectively, as follows). 

 
 Touch the Graph button, and then touch inside the Graph with 

control to select a graph mode. 
 Use the web edit button to access the Processing Web and form 

sequence highly detailed math functionality. 
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Mask Testing 
Users may load or create a pixel-based mask on the display grid using a 
variety of methods. Test conditions can be set, and a pass/fail result 
returned based on whether the condition was found to be true or false. 
The source of the mask is always a trace (Channel, Zoom, Math 
waveform, etc.). 

Creating a Mask 

1. After selecting Analysis → Pass/Fail, the Pass/Fail dialog is shown. 

 

 If you touch the Q1 button, a pop-up is shown where you can 
select the Mask test Pass Fail Condition. 
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Now, the Q1 dialog is shown and shows the Mask test condition 
selected. 

 

 If you touch the Q1 tab, the Q1 dialog is shown. Touching the 
Condition control shows the same pop-up where you can select 
the Mask test Pass Fail Condition. 

2. With the Mask test Pass Fail Condition selected, the Test, Load 
Mask, Make Mask, and Gate right-hand dialogs are shown and are 
where you manage, make, and apply gates to your mask. 

 

For more detailed information about these right-hand dialogs, 
refer to Pass/Fail Testing (on page 122). 
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Quick Access to Pass/Fail Setup Dialogs 

You can quickly gain access to the main Pass/Fail dialog, a (Qx) setup 
dialog, or the Actions dialog, by touching one of the following respective 
sections below the grid display. 

 

Removing a Mask from the Display 

Quickly remove a mask by accessing the Qx dialog. On the Load Mask 
right-hand dialog, click the Delete button. 

 

Mask testing can be done using an existing mask, or by using a mask 
created from your actual waveform, with vertical and horizontal 
tolerances that you define. Existing masks can be loaded from a floppy 
disk or from a network. 

You can set your mask test to be True for waveforms All In, All Out, Any 
In, or Any Out. For example, if you select All In, the test becomes False if 
even a single waveform falls outside the mask. 
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Masks that you create from your waveform can be confined to just a 
portion of the trace by use of a measure gate. Refer to the Measure Gate 
online help topic for more information on how this feature works. 

Right-Hand Dialogs 

 On the Test right-hand dialog, make a selection in the Test is True 
when group of buttons (as follows). 

 

Note: The previous selection is for All In and means the test is 
False when a single waveform falls outside the mask. 

From the Show Markers section of the dialog, choose whether or 
not to have mask violations displayed by touching either the Off or 
On button, respectively. 

 When loading a pre-existing mask, use the Load Mask right-hand 
dialog. Using the File button, you can then enter the file name or 
browse to its location. 

 When creating a new mask, use the Make Mask right-hand dialog. 

Touch the Browse button to create a file name and location for 
the mask if you want to save it. 

Touch inside the Ver Delta and Hor Delta fields and enter 
boundary values, using the pop-up numeric keypad. You can also 
use the Make from Trace button to instantly create a mask from a 
new waveform. 

 When creating a new mask, use the Make Mask right-hand dialog. 
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 On the Gate right-hand dialog, you can enter values in the Start 
and Stop fields to constrain the mask to a portion of the 
waveform. Or, you can simply touch and drag the Gate posts, 
which initially are placed at the extreme left and right ends of the 
grid. 
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WaveScan Overview 
WaveScan enables you to search for unusual events in a single capture, 
or to scan for an event in many acquisitions over a long period of time. 
You can select from more than 20 search modes (frequency, rise time, 
runt, duty cycle, etc.), apply a search condition (slope, level, threshold, 
hysteresis), and begin scanning in a post-acquisition environment. Since 
the scanning modes are not simply copies of the hardware triggers, but 
software triggers, the capability is much greater. 

For instance, there is no frequency trigger in any oscilloscope, yet 
WaveScan allows for quick frequency scans. You can accumulate a data 
set of unusual events separated by hours or days, enabling faster 
debugging. The events are time stamped, table indexed, and event rows 
can be selected for individual viewing. 

You can also set actions to occur automatically when unusual events are 
found: stop the acquisition, emit an audible beep, output a pulse as 
shown in Auxiliary Output Signals (on page 169), print the screen as 
shown in Printing and Hardcopy Functions (on page 161), save 
waveforms as shown in Saving and Recalling Waveforms (on page 152), 
or create a LabNotebook™ entry as shown in My Lab Notebook 
Overivew (on page 144). 
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Signal Views 

WaveScan provides distinct views of your signal: 

 Source (Channel View)view highlights all occurrences of edges 
that meet your criteria. 

 Scan Overlay places all captured edges one on top of the other in 
a separate grid. You can apply monochromatic persistence in this 
view. 

 Scan Histogram provides a statistical view of edges that meet your 
search criteria. 

 Zoom allows you to expand a waveform feature vertically and 
horizontally; to apply further processing (using Measure); to Store 
it, or to apply a descriptive Label to the feature (as shown on the 
Actions portion of the trace dialog). 

 

Note: The number of grids displayed varies from one to three grids 
depending on which views are enabled. WaveScan handles this 
function automatically, and there is no option to move traces from one 
grid to another, as would be the case under normal (non-WaveScan) 
operation. 

Search Modes 

Search modes are used to locate anomalies during acquisition. 

 Edge Mode - for detecting the occurrence of edges; selectable 
slope and level 

 Non-monotonic Mode - for detecting threshold re-crosses; 
selectable slope, hysteresis, and level 

 Runt - for detecting pulses that fail to cross a threshold; selectable 
polarity and thresholds 

 Measurement Mode - for filtering and performing parameter 
measurements 

 Serial Pattern – Searches from 2 to 64 bits; ideal for bursted 
patterns where a PLL cannot lock. 
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 Bus Pattern – Searches from 2 to 64 bits; enhances MSO search 
capabilities.  

Parameter Measurements 

Besides parameter measurements made during acquisition, post-
acquisition measurements can also be made. The number of parameters 
available depends on the options loaded on your instrument. 
Measurements are made only on the events defined by your filter 
(search criteria). A Filter Wizard is provided to quickly establish statistical 
criteria such as ±1, 3, or 5 sigma. 

Sampling Mode 

Whenever WaveScan is enabled, the instrument reverts to Real-time 
sampling mode. 
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Customization Overview 
The instrument provides powerful capability to add your own 
parameters, functions, display algorithms, or other routines to the 
oscilloscope user interface without having to leave the instrument 
application environment. You can customize the instrument to your 
needs by using the power of programs such as Excel™, Mathcad™, and 
MATLAB™, or by scripting in VBS. Whichever method you use, the results 
appear on the instrument's display together with the signals that you 
started with. This ability offers tremendous advantages in solving unique 
problems for a large range of applications, with comparatively little effort 
from you. 

Instrument customization provides these important capabilities: 

 You can export data to programs, without leaving the instrument 
environment.  

 You can get results back from those programs, and display them 
on the instrument, without leaving the instrument application 
environment.  

 Once the result is returned, you can perform additional 
oscilloscope operations, such as measuring with cursors, applying 
parameters, or performing additional functions on the waveform, 
in exactly the same way as for a normal waveform.  

 You can program the oscilloscope yourself. 

The instrument does not just provide connectivity with data downloads 
to other programs. It provides true customizable interaction with these 
other programs, and allows you to truly customize the oscilloscope to do 
the exact job you want it to do. The advantages to this are many: 

 You can use the standard processing power of the instrument to 
do most of your calculations. 

 You only need to write the function, parameter, display algorithm, 
etc. that specifically applies to your need and that the instrument 
doesn't contain.  

 You can view the final result on the instrument display, and use all 
of the instrument's tools to understand the result.  
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 You can do additional processing on the result by applying either 
standard instrument parameters, functions, etc. to the returned 
result, or even more powerfully, adding chained customized 
functions. For example, you can do an Excel calculation on a result 
with a MATLAB function applied to it.  
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Documenting Your Work Using 

LabNotebook 

LabNotebook Overivew 

LeCroy's LabNotebook feature extends the documentation capabilities of 
your oscilloscope. It allows you to create an annotated notebook entry 
containing all displayed waveforms, the setup of the DSO, and user-
supplied annotations. The notebook entry can then be converted to 
hardcopy format - .pdf, .rtf, or .html - and printed or e-mailed. You can 
also use the default report layout or configure your own, and even 
substitute your own company logo in the header. 

Notebook entries are stored in an internal database and are available for 
recall at any time. Besides storing the waveform data, LabNotebook also 
stores your panel setups and parameter measurements. You can also 
back up the database to external media. 

The Flashback feature allows you to recall the state of the DSO at a later 
date, including the saved waveforms and the DSO setup, so you can 
make additional measurements. A keyword filter makes it easy to find 
and recall a specific notebook entry. 

You can choose which notebook to use for your entries, and label the 
notebook by project or user. This is especially useful if the oscilloscope is 
shared among several users and/or used for different projects as data 
can be kept separate how you see fit. Similarly, hardcopy reports can be 
stored in different folders. 

Note: If your external monitor is connected, the LabNotebook 
automatically opens on the external monitor. 
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LabNotebook 

When LabNotebook is accessed by File → LabNotebook on the menu 
bar, the main LabNotebook dialog is shown by default. 

 

This dialog is where you can store and create LabNotebook entries. You 
also can View, Create, E-Mail, and select an output format for your 
reports. 

Numbered sections on this dialog correspond with the following 
explanations. 

Note: Before creating a new Notebook Entry, you should first configure 
your preferences in Preferences. 

1. You can create a notebook entry by either: 

 Touching File → Create Notebook Entry on the menu bar. 

 Touching the Create button on the main LabNotebook dialog. 

Regardless, the  Enter Notebook Info pop-up is shown where you 
can provide a title and comments for the entry. By default, the 
entry is titled with the current date and time. 
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Touch inside the Title control and provide a value using your 
preferred input control method - for more information regarding 
the touch screen controls, refer to Dialog Area (on page 46). If 
desired, touch inside the Description field, provide information 
and touch Save. 

PLEASE NOTE THE FOLLOWING:  

 When an entry is first created and Report Title and 
Description information is provided, your new entry is 
shown along with The Drawing Toolbar at the top of the 
screen. 

 When finished and the Done button is touched from the 
Drawing Toolbar, your new entry is shown on the My 
Notebook Entries list. 

2. My Notebook Entries list shows the entries you've already stored 
on your instrument. With a stored entry selected on the My 
Notebook Entries section of the dialog, you can do the following: 

3. Touch the Flashback (Recall) button to return your instrument to 
the state it was in when the Notebook Entry was saved. Exit 
Flashback by touching the Undo Flashback button in the top-right 
corner of the screen, or touch the Auto Trigger front panel 
control. 

PLEASE NOTE THE FOLLOWING: The flashback feature currently 
recalls the DSO Setup, and all displayed waveforms. Some of result 
data is not recalled, including:  

 Persistence data - While it is saved in hardcopy and is 
printed on the report, it is not recalled during Flashback. 

 Histogram data - Histograms internally have a 32-bit 
resolution, but when stored into a trace file and recalled 
during flashback they are clipped to 16-bits.  

 Floating point waveforms - Certain math operations result 
in the creation of floating point waveforms with much 
higher resolution than can be stored in a 16-bit waveform 
file. This extra resolution is not preserved when traces are 
recalled using flashback. 
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 Cumulative Measurements - Any measurements on when 
the Lab Notebook entry is created are not saved 
individually in the database (other than being embedded in 
the hardcopy image). This means that when flashback is 
used, the measurements are recomputed using the recalled 
waveform data. Normally, doesn't pose a problem; 
however, if cumulative measurements were on when the 
entry was stored and the cumulative measurements 
accumulated data from multiple acquired waveforms, they 
lose their history and show instead only the results from 
the stored waveforms. 

4. You can use the Up and Down arrows to move through your My 
Notebook Entries list one row at a time. If you have a large 
amount of entries, touch the Filter button and the Filter Entries 
pop-up is shown. 

 

Provide a Date and/or Keyword and touch the Find Now button to 
apply your filter to the My Notebook Entries list. 
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5. Use the View, Create Report, and E-Mail buttons as desired. The 
More Actions button shows the Specific Entry dialog for the entry 
selected on the My Notebook Entries list. Using this dialog is 
explained in Managing Notebook Entry Data in the online help. 

 

6. You can select the Format of your LabNotebook entry from HTML, 
RTF, and PDF choices. The Delete button removes the specific row 
selected on the My Notebook Entries list while the Delete All 
button removes every entry on the list. 

7. Marking the Multi Selection checkbox shows the Select All, Clear 
All, Select, Clear, and Print buttons. 

 

The Select All, Clear All, Select, and Clear buttons are used to 
select/deselect multiple entries on the My Notebook Entries list. 
The Print button can only be used for Multi Selection printing of 
My Notebook Entries from the main LabNotebook dialog. 

Note: If selected in Preferences, your entry can show your 
waveforms in print colors. This means it's printed on a white 
background in order to save printer ink. Otherwise, waveforms 
are shown on a black background. 

8. Use the Delete button to delete the selected entry (or entries if 
the Multi Selection checkbox is marked). The Delete All button 
can be used to remove all notebook entries shown on the My 
Notebook Entries list with the touch of a single button. 
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Save/Recall 

Save/Recall Overview 

The Save/Recall section allows for storage and retrieval of Waveforms, 
Table Data, and Instrument Setups. It even provides Disk Utilities for 
arranging the file/folder structure on your instrument's hard drive. 

Directly access each Save/Recall dialog (Waveform, Table, Setups, and 
Disk Utilities on the File menu on the menu bar. 

 

A main Save/Recall dialog is shown providing buttons to access the 
aforementioned dialogs for specific Save/Recall functions. 

 

Note: While the Disk Utilities (on page 172) is the final dialog of these 
Save/Recall functions, it's actually considered part of the Utilities menu 
and is therefore covered in that section of the documentation. 
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Saving and Recalling Setups 

The Save/Recall Setup dialogs allow for quick saving and recalling of up 
to six oscilloscope panel settings internally on your instrument. If 
desired, you can also save and recall your oscilloscope panel settings as 
an .lss file to a specific hard disk location, a network location, or USB 
drive.  

Saving Oscilloscope Setup(s) 

Access the Save Setup... dialog by either selecting File → Save Setup... 
from the menu bar or clicking the Save Instrument Setup button on the 
main Save/Recall dialog. Now use one of the following two methods to 
save setup(s). 

SAVING SETUP(S) INTERNALLY ON YOUR INSTRUMENT 

Save your settings internally on your instrument by touching inside one 
of the six SetupX data entry controls on the Save to Internal Setup... part 
of the screen and providing a name. Now, touch its corresponding Save 
button directly to the left. 

Your setup file is then saved to the D:\Internal Setups location on your 
instrument and the current date/time is shown above the SetupX data 
entry control.  

OR 

SAVING SETUP(S) DIRECTLY TO A FILE 

Save your setup(s) directly to a file by touching the File button on the 
Save To section on the dialog. Now, touch inside the Save files in 
directory control and provide a path to the destination folder. Or touch 
Browse to navigate to the destination folder. Finally, touch the Save 
Now button. 

Recalling Oscilloscope Setup(s) 

Access the Recall Setup... dialog by either selecting File → Recall Setup... 
from the menu bar or clicking the Recall Instrument Setup button on the 
main Save/Recall dialog. Now use one of the following two methods to 
save setup(s). 
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RECALLING SETUP(S) INTERNALLY ON YOUR INSTRUMENT  

Recall your settings located internally on your instrument by touching 
inside one of the six Recall buttons on the Recall From Internal Setup... 
part of the screen. 

Each Recall button is labeled with a corresponding setup storage slot. If a 
setup is stored, SetupX is shown along with the date/time of the save, 
otherwise, the slot is labeled Empty.  

OR 

RECALLING SETUP(S) DIRECTLY FROM A FILE 

Recall your setup(s) directly from a file by using controls on the Recall 
From File section on the right side of the dialog. Touch inside the Recall 
panel from file data entry control and provide a path to the destination 
folder. Or touch Browse to navigate to the destination folder. Finally, 
touch the Recall Now button. 

Recalling Default Settings 

Some of the default settings for your oscilloscope include the following 
configurations:  

 Channels 1 and 2 are turned on at 50 mV/div, 0V offset, linear 
interpolation 

 All other measurements are cleared for Math, Reference 
Waveforms, and Channels 

 Trigger is set to Channel 1 with an Auto positive edge, DC coupled, 
and with a 0V level 

 The Timebase set to 50 ns/div, 10ks, 20 GS/s, and with zero delay 

 Smart memory is set to Set max memory with 100ks selected 

 The Cursors are turned off 

 The Grids are set to AutoGrid 

If you want to reset the settings to the default configuration, press the 
DEFAULT SETUP... front panel button 

OR 

Your instrument's default settings can be recalled at any time using the 
Recall Default button. 
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Saving and Recalling Waveforms 

Saving Waveforms 

The Save Waveform dialog is used to save displayed waveforms to either 
a memory trace or to text or binary file formats. 

Access the Save Waveform dialog by either selecting File → Save 
Waveform from the menu bar or clicking the Save Waveform button on 
the main Save/Recall dialog. 

Use the numbered sections of this Save Waveform dialog, which 
correspond with the following explanations, to properly save your 
waveform(s). 

1. Select either Memory or File by touching either respective button 
on the Save To portion of the dialog. 

Note: When Memory is selected, only Source and Destination 
controls are shown on the Save Waveform dialog. When File is 
selected, many more controls are available. Regardless, the 
controls are used as explained in the following steps. 

2. Touch inside the Source control and select a source from the 
Select Source pop-up. The source can be any trace; for example, a 
channel (C1–C4), math function (F1–F4), or a waveform stored in 
non-volatile RAM (M1–M4). 

3. Destination - Click to show the available memory traces when 
saving to memory. 

4. Touch inside the Trace Title data entry control to change the 
default name of your waveforms (if desired). 

Note: You can change the name but not the sequence number.  

 CAUTION 
If you use a name ending with a number instead of a letter, the 
instrument may truncate the number. This is because, by design, 
the first waveform is automatically numbered 0, the second 1, etc. 
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For example, if you want to use waveform name XYZ32 but it is 
not preceded by waveforms XYZ0 through XYZ31, the waveform is 
renumbered with the next in sequence. 
If you need to use a number in your waveform's name, append an 
alpha character at the end of the number: XYZ32a, for example. 

5. If you are saving to a file, touch the Data Format control and 
select a format type. 

 

 Binary - saves the file to LeCroy's binary file format. This 
format is documented in various Remote Control Manuals 
for LeCroy Oscilloscopes. Selecting Binary results in the 
smallest possible file size, and is recommended when 
recalling waveforms to LeCroy instruments.  

Note: Binary files can be converted to ASCII using LeCroy 
utilities such as ScopeExplorer or WaveStudio. 

 ASCII -Text output file (.txt extension). 

 MATLAB - Text output file compatible with MATLAB (.dat 
extension). 

 Excel - Text output file compatible with Excel (.csv 
extension). 

 MathCad - Text output file compatible with Excel (.prn 
extension). 
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Depending on your selection, you may need to touch the 
SubFormat control and select a subformat. 

 Word - Available when selecting the Binary format, 
specifies the samples in the output file are represented 
with 16 bits. Always use this option unless Byte mode is 
pre. 

 Byte - Available when selecting Binary format, specifies the 
samples in the output file are represented with 8 bits. 

Note: Using this option can result in a loss of output file 
resolution. 

 Amplitude only - Specifies the output file include amplitude 
data for each sample, but not sample time information. 

 Time and Amplitude - Specifies the output file include both 
time and amplitude data for each sample. 

 With Header - Specifies to include a header with scaling 
information. 

If you select ASCII, touch the Delimiter control and select a 
delimiter character from the pop-up menu. Choose from comma, 
space, semicolon, or tab delimiters. 

PLEASE NOTE THE FOLLOWING:  

 Select Audio to save your waveforms into the .wav format. 

 The WaveML format, which enables XML output, is used for 
persistence traces. 

6. You can use the Auto Save feature to automatically save a 
waveform to disk after each new trigger. You can enable Auto 
Save from the Save Waveform dialog by touching one of the Auto 
Save buttons. 

Select Wrap (old files overwritten) or Fill (no files overwritten). 

 CAUTION 
Selecting Fill can quickly use up all the hard disk space on your 
instrument. 
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7. Touch the Browse button next to the Save file in directory control 
and navigate to the location where you want the file saved. The 
file name is assigned automatically and is shown under the 
control. 

8. Finally, touch the Save Now! button. 

Recalling Waveforms 

Note: Only .trc files were saved in binary format can be recalled into 
the oscilloscope.  

Access the Recall Waveform dialog by either selecting File → Recall 
Waveform from the menu bar or clicking the Recall Waveform button on 
the main Save/Recall dialog. 

Use the numbered sections of this Recall Waveform dialog, which 
correspond with the following explanations, to properly recall your 
waveform(s). 

1. Select either Memory or File by touching either respective button 
on the Recall From portion of the dialog. 

Note: When Memory is selected, only Source, Destination, and 
Show on recall controls are shown on the Recall Waveform 
dialog. When File is selected, many more controls are available. 
Regardless, the controls are used as explained in the following 
steps. 

2. If recalling from Memory, touch inside the Source control and 
select a source stored in non-volatile RAM (M1–M4) from the 
Select Source pop-up. 

3. Touch inside the Destination control and select a location for 
storage (memory or file) from M1 to M4. 

4. Show on Recall - Mark this checkbox to have the memory trace 
shown on the grid display after recalling the waveform. 

5. When saving a File, touch inside the Show only files control and 
select an area to limit the search (channels, math functions, or 
memory).  
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6. Touch inside the Recall files from directory data entry control and 
provide the path. You can also touch the Browse button and 
navigate to the file. Touch inside the Next file will be recalled 
from data entry control and provide the path or, touch the 
Browse button to navigate to the file. 

7. Up /Down arrows - Use these buttons to cycles through files in 
the selected folder from the Show only files control. 

8. When finished, touch the Recall Now! button. 
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Utilities 

Utilities Setup 

Utilities Overview 

Access Utilities by touching Utilities → Utilities Setup... on the menu bar. 
A variety of settings can be made on your oscilloscope using the Utilities. 

Utilities settings are divided into three main sections: Utilities, Disk 
Utilities, and Preferences. 

Utilities 

Selecting Utilities → Utilities Setup... shows the main Utilities dialog by 
default. The following controls are available from this dialog: 

 

 The HardCopy Setup, Date/Time Setup, and System Status 
buttons all open their corresponding dialogs. 

Note: To the right of the HardCopy Setup button, display text 
indicates your currently selected printer for convenience. 

 When touched, the Show Windows Desktop button instantly 
minimizes the oscilloscope (and any other) applications. 
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Maximize the application by touching the shortcut icon located on 
the lower-right of the screen. 

 

 A sequence of calibration screens are shown when the Touch-
Screen Calibration button is touched. These screens instruct you 
to touch a series of displayed crosses in order to improve precision 
and accuracy when using your touch screen. 

PLEASE NOTE THE FOLLOWING: 

 Use a stylus for this procedure. Using your finger for the 
calibration prompts provides insufficient accuracy for the 
procedure. 

 The calibration procedure times out after ten seconds pass 
and no cross is touched. 

 Avoid parallax errors by placing your line of sight directly in 
front of each cross before touching it. 

 The Service button is a section of the application reserved for 
qualified LeCroy personnel. When touched, an access code pop-up 
is shown enabling LeCroy technicians access to various service 
dialogs inside the oscilloscope software. 

Contact LeCroy for more information using Contact LeCroy for 
Support (on page 188). 
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Status 

Control values are shown for information about your instrument. Among 
them include your Hardware and Software options. 

View the oscilloscope's system status (including software and hardware 
configurations) on this Status dialog. The dialog displays read-only 
system information including model number, serial number, firmware 
version, and installed software and hardware options. 

ADDING SOFTWARE OPTIONS 

New software options can be added after purchasing a code and then 
enabling the option on the oscilloscope. Call LeCroy Customer Support to 
place an order and receive the code. 

Note: For more information about LeCroy Software Options, Contact 
LeCroy for Support (on page 188). 

 After adding new software options, the entire oscilloscope 
application needs to be restarted. Do this by touching the desktop 
shortcut. 

 

 Restart the Windows® operating system on your instrument (if 
necessary) by rebooting the oscilloscope. Do this by pressing the 
power switch, and then turning the power back on after a ten-
second wait. 

Upon initial power-up, the oscilloscope automatically loads the 
instrument application software along with any additional software 
options. 

Remote Communication 

Use the Remote dialog to setup remote communication. You can select a 
network communication protocol, establish network connections, and 
configure the Remote Control Assistant log from the Remote dialog. 
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The choice of communication protocols is limited to TCPIP, GPIB, and 
USB488 (on specific models). 

PLEASE NOTE THE FOLLOWING:  

  GPIB is an option that either requires a GPIB card to be installed 
in an open card slot on your oscilloscope or the use of an external 
USB to GPIB LeCroy accessory. For more information about LeCroy 
Accessories, Contact LeCroy for Support (on page 188). 

 The instrument uses Dynamic Host Configuration Protocol (DHCP) 
as its addressing protocol. Therefore, it is not necessary to set up 
an IP address if your network supports DHCP. If it does not, you 
can assign a static address in the standard Windows network 
setup menu. 

The Remote Control Assistant monitors communication between your PC 
and oscilloscope when you are operating the instrument remotely. You 
can log all events or errors only. This log can be invaluable when you are 
creating and debugging remote control applications. 

REMOTE COMMUNICATION SETUP 

If you are connecting the oscilloscope to a network, first contact your 
Information Systems administrator. If you are connecting the 
oscilloscope directly to your PC, connect a GPIB or Ethernet cable 
between them. 

1. On the Remote dialog, make a Port selection: TCPIP (transmission 
control protocol/Internet protocol) or GPIB (general purpose 
interface bus). If you do not have a GPIB card installed, the GPIB 
selection will not be accessible. 

2. If you are using GPIB, set a GPIB address by touching inside the 
GPIB Address data entry control and provide an address. 
OR 

If you are using TCPIP, press the Net Connections button; the 
Windows Network Connections window opens. You can 
reconfigure the oscilloscope's connection if it is already connected 
to the network or make a new connection. 
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Note: Your instrument allows you to restrict remote control access to 
certain clients. To restrict access, under Security, touch the Yes button 
and enter the IP addresses or domain name server names you want to 
restrict separated by a comma. 

CONFIGURING THE REMOTE CONTROL ASSISTANT EVENT LOG 

1. Under Remote Control Assistant, touch inside the Log Mode data 
entry control. Select Off, Errors Only, or Full Dialog from the pop-
up menu. 

2. Export the contents of the event log to an ASCII text file by 
touching the Show Remote Control Log button. The Event Logs 
pop-up is shown. Touch inside the DestFilename data entry 
control and provide a file name using your preferred input control 
method - for more information regarding the touch screen 
controls, refer to Dialog Area (on page 46). 

Then, touch the Export to Text File button. 

Printing and Hardcopy Functions 

Your instrument provides the ability to output files to printers or plotters 
print to file, or e-mail your files. Any Microsoft Windows® supported 
printer is supported by your instrument. 

The following Printing and Hardcopy procedures are explained here. 

 Printer Setup 

 Adding Printers and Drivers 

 Default Printer Setup 

 Printing Screen Images 

 Printing 

 Clipboard 

 File 

 E-mail 
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PRINTER SETUP 

1. Touch File → Print Setup... on the menu bar. The Utilities 
Hardcopy dialog opens. 
OR 
Press the PRINT front panel button. Then, touch the Print Setup... 
button on the Print flyout menu. 

OR 

Touch Utilities → Utilities Setup... and click the Hardcopy tab. 

2. On the Hardcopy dialog, touch the Printer icon. 

 

3. Under Colors, touch the Use Print Colors checkbox if you want the 
traces printed on a white background. 

Note: A white background saves printer toner. (You can change 
the printer colors in the Utilities → Preference Setup → Color 
dialog.) 

4. Touch inside the Select Printer control and choose a printer from 
the pop-up menu.  

5. Touch the Properties button to see your printer setup. 
4. Touch the icon for the layout Orientation you want: portrait or 

landscape. 
5. Touch the Hardcopy Area control to choose which part of the 

screen you want to print from the pop-up menu. 
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Choose Grid Area Only if you do not need to print the dialog area 
and you only want to show the waveforms and grids. Choose DSO 
window if you want to print the dialogs with the waveforms and 
grids. Choose Full Screen if you want to print the entire screen. 

ADDING PRINTERS AND DRIVERS 

Note: If you want to add a printer driver, the driver must first be loaded 
on the oscilloscope. 

1. Touch File → Print Setup... on the menu bar. 
OR 
Press the PRINT front panel button. Then, touch the Print Setup... 
button on the Print flyout menu. 

OR 

Touch Utilities → Utilities Setup... and click the Hardcopy tab. 

2. On the Utilities Hardcopy dialog, touch the Printer icon. 

 

3. Touch the Add Printer button. A Microsoft Windows® Printer 
window opens where you can add a printer. 

PRINTING A SCREEN IMAGE  

You can print in one of three ways: 

 Press the PRINT front panel button. Then, touch the Print Now 
button on the Print flyout menu. 

 

 Touch File → Print on the menu bar. 

 Touch Utilities → Utilities Setup... and click the Hardcopy tab. 
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On the Hardcopy dialog, touch the Print Now button. 

 

Note: The instrument uses the Print settings on the Hardcopy dialog to 
print the screen image. 

So, you can either print from File → Print or from Utilities → Utilities 
Setup... (Hardcopy tab). However, the Hardcopy dialog provides some 
additional functionality like printing to the clipboard, or to a file. You can 
also choose to print the waveform and grids only, the waveform and 
grids with the dialog, or the entire screen. You can also e-mail your 
screen images. 

PRINTING 

Similar to Printing a Screen Image and alternatively to File → Print (and 
using the additional setting from the Hardcopy dialog) choose from 
either of the following methods to quickly print from your instrument: 

 Press the PRINT front panel button. Then, touch the Print Now 
button from the Print flyout menu. 

 Touch Utilities → Utilities Setup... and click the Hardcopy tab. On 
the Hardcopy dialog, touch the Print Now button. 

 

CLIPBOARD 

The Clipboard selection on the Hardcopy tab saves the screen image on 
the clipboard so you can paste a file into another application (like 
Microsoft Word, for example). Choose from either of the following 
methods to save a screen image to your clipboard: 

 Press the PRINT front panel button. Then, touch the Save Screen 
To Clipboard button from the Print flyout menu. 
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Note: Once you have configured your Clipboard settings from the 
Hardcopy dialog (using the next procedure), you can touch the PRINT 

front panel button and touch Save Screen To Clipboard on the Print 
flyout menu. The instrument automatically uses the additional 
clipboard settings to save the screen image to the clipboard. 

 Touch Utilities → Utilities Setup... and click the Hardcopy tab. On 
the Hardcopy dialog, touch the Clipboard button. 

 

1. Touch the Colors control and choose Standard to print the 
screen as it appears, Print to print the waveforms on a 
white background, or Black & White to print the 
waveforms in black & white. 

Note: Choosing Print colors saves printer toner or ink. 

2. Touch the Hardcopy Area control to choose which part of 
the screen you want to print. Choose Grid Area Only if you 
do not need to print the dialog area and you only want to 
show the waveforms and grids. Choose DSO window if you 
want to print the dialogs with the waveforms and grids. 
Choose Full Screen if you want to print the entire screen. 

3. Touch the Print Now button. 

 

FILE 

The File selection on the Hardcopy tab saves the screen image as a file to 
storage media such as a USB drive or hard drive. Choose from either of 
the following methods to save a screen image to a file: 

 Press the PRINT front panel button. Then, touch the Save Screen To 
File button from the Print flyout menu. 
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PLEASE NOTE THE FOLLOWING:  

 The instrument's hard disk is partitioned into drive C: and drive D:. 
Drive C: contains the Windows operating system and the 
instrument application software. Drive D: is intended for data files. 

 Once you have configured your Clipboard settings from the 
Hardcopy dialog (using the next procedure), you can touch the 
PRINT front panel button and touch Save Screen To File on the 
Print flyout menu. The instrument automatically uses the 
additional file settings to save the screen image to the file. 

 Touch Utilities → Utilities Setup... and click the Hardcopy tab. On 
the Hardcopy dialog, touch the File button. 

 

1. Touch inside the File Format data entry control and select a 
graphic file format from the pop-up menu. 

2. Touch the Colors control and choose Standard to print the 
screen as it appears, Print to print the waveforms on a 
white background, or Black & White to print the 
waveforms in black & white. 

Note: Choosing Print colors saves printer toner or ink 
(when you eventually do print from the file). 

3. Touch inside the File Name data entry control and provide 
a name for the display image using your preferred input 
control method - for more information regarding the touch 
screen controls, refer to Dialog Area (on page 46). 

4. Touch inside the Directory data entry control and provide 
the folder path for the resulting printout. Or touch the 
Browse button and navigate to the folder. 

5. Touch the Hardcopy Area control to choose which part of 
the screen you want to print. Choose Grid Area Only if you 
do not need to print the dialog area and you only want to 
show the waveforms and grids. 
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Choose DSO window if you want to print the dialogs with 
the waveforms and grids. Choose Full Screen if you want to 
print the entire screen. 

6. Touch the Print Now button. 

 

E-MAIL 

The E-mail selection on the Hardcopy tab gives you the option to e-mail 
your screen images, using either the MAPI or SMTP protocols. Before you 
output to e-mail from the Utilities dialog, you first have to set up the e-
mail server and recipient address in Preference Setup.... Choose from 
either of the following methods to e-mail your screen image: 

 Press the PRINT front panel button. Then, touch the Send Screen 
To E-mail button from the Print flyout menu. 

Note: Once you have configured your E-mail settings from the 
Hardcopy dialog (using the next procedure), you can touch the PRINT 

front panel button and touch Send Screen To E-mail on the Print flyout 
menu. The instrument uses the additional e-mail settings 
automatically. 

 Touch Utilities → Utilities Setup... and click the Hardcopy tab. On 
the Hardcopy dialog, touch the E-Mail button. 

 

1. Touch inside the File Format data entry control and select a 
graphic file format from the pop-up menu. 
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2. Touch the Colors control and choose Standard to print the 
screen as it appears, Print to print the waveforms on a 
white background, or Black & White to print the 
waveforms in black & white. 

Note: Choosing Print colors saves printer toner or ink 
(when you eventually do print from the file). 

3. Touch the Prompt for message to send with mail checkbox 
if you want to include remarks with the image. 

4. Touch the Hardcopy Area control to choose which part of 
the screen you want to print. Choose Grid Area Only if you 
do not need to print the dialog area and you only want to 
show the waveforms and grids. Choose DSO window if you 
want to print the dialogs with the waveforms and grids. 
Choose Full Screen if you want to print the entire screen. 

 

5. Touch the Print Now button. 
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Aux Output 

The Aux Output dialog allows you to specify Auxiliary and Calibration 
Output details. 

 

1. If you want a specialized output, touch one of the following 
buttons under Use Auxiliary Output For: Square Wave, Trigger 
Enabled, Trigger Out, Pass/Fail, or Off. 

Note: If Pass/Fail is selected on this Use Auxiliary Output For 
section of the dialog, a Pulse Duration data entry control is 
made available. Provide a value within your instruments 
specified range using your preferred input control method - for 
more information regarding the touch screen controls, refer to 
Dialog Area (on page 46). 

2. On the Use Calibration Output For section of the dialog, choose 
Square, DC Level, or Off. If you want a 1 kHz, 1 V Square Wave, 
touch the Set to 1 kHz, 1 V Square Wave button. 

Additional controls are made available based on Square or DC 
Level selections as follows: 

 If you selected Square on the Use Calibration Output For section 
of the dialog, a Frequency data entry control is made available. 
You can set a value using your preferred input control method. 

 If you selected Square or DC Level on the Use Calibration Output 
For section of the dialog, an Amplitude into 1 MΩ data entry 
control is made available. Provide a desired value using your 
preferred input control method. 
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AUXILIARY OUTPUT SIGNALS 

Signals can be output through the connector labeled AUX OUT on your 
oscilloscope. Use the Auxiliary Output to send the following signals to 
other instruments: 

 Trigger Enabled - This function can be used as a gating function to 
trigger another instrument when the oscilloscope is ready. 

 

 Trigger Out - This function can be used to trigger an external 
oscilloscope. 

 

 Pass/Fail - Allows you to set a pulse duration (durations vary 
based on your specific model, refer to datasheet specifications at 
www.lecroy.com for details); generates a pulse when pass/fail 
testing is active and conditions are met. 

 
 Fast Edge - Some models provide this signal output used to 

deskew multiple channels. The Fast Edge connection varies based 
on model and is either SMA or BNC. 

 
 Off - This function turns off the Auxiliary Output signal. 

 

http://www.lecroy.com/
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CALIBRATION OUTPUT SIGNALS 

A calibration signal can be output from the Probe Calibration Hook on 
the front of the oscilloscope. The following Calibration Output Signals are 
available for use: 

 Square Wave - You can set a Frequency value (frequency ranges 
vary based on your specific model, refer to datasheet 
specifications at www.lecroy.com for details).  

 

 DC Level - This is a reference level. 

 

 Off - This function turns off the Calibration Output signal. 

 

Date and Time 

From the Date and Time tab on the Utilities dialog, you can manually set 
the time and date or get it from the Internet. If you elect to get the date 
and time from the Internet, you need to have the oscilloscope connected 
to the Internet through the LAN connector on your instrument's I/O 
panel. You can also set time zones and daylight savings time. 

1. You can set the Date and Time manually by providing a value in 
the Hour, Minute, Second, Day, Month, and Year using your 
preferred input control method - for more information regarding 
the touch screen controls, refer to Dialog Area (on page 46). After 
providing values, touch the Validate Changes button. 

2. You can set the Date and Time from the Internet by first verifying 
that your oscilloscope is connected to the Internet, and then 
touching the Set from Internet button. 

Note: The Simple Network Time Protocol (SNTP) is used. 

http://www.lecroy.com/
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3. You can also set the Date and Time using Windows® by touching 
the Windows Date/Time button.  
Windows shows a Date and Time Properties pop-up where the 
date and time can be configured. 

 

Options 

The Options dialog is used to add or remove software options. Contact 
LeCroy for more information using Contact LeCroy for Support (on page 
188), or visit our Website at www.lecroy.com/options. 

This dialog also shows your ScopeID and Serial #.  

Disk Utilities 

Use the Disk Utilities dialog to arrange the file/folder structure on your 
instrument's hard drive. You can delete files, folders, or create new 
folders. 

Note: All Disk Utilities can also be accomplished using the standard 
Microsoft Windows® file management tools. 

http://www.lecroy.com/options
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Access the Disk Utilities dialog by selecting Utilities → Disk Utilities from 
the menu bar. 

 

1. Delete a single file by first touching the Delete button on the 
dialog (just to make sure it's selected). 

 Now, touch inside the Current folder data entry control and 
provide the path to the folder containing the file for 
deletion. 
OR  
Touch the Browse button and navigate to the folder. 

 Touch inside the File to be deleted data entry control and 
provide a file name using your preferred input control 
method - for more information regarding the touch screen 
controls, refer to Dialog Area (on page 46). 
OR  
Touch the Browse button and navigate to the file. 

Note: You can also use the up down arrows to move 
through the files contained in the Current folder selected. 

With the desired file for deletion located, touch the Delete File 
button. 

2. Delete all files in a folder by repeating the aforementioned Delete 
a single file process (up to the first bullet only using the Current 
Folder control).  

With the desired folder for deletion located, touch the Empty 
Folder button. 

3. Create a Folder by first touching the Create button on the 
dialog (just to make sure it's selected). 

 Touch inside the Current folder data entry control and 
provide the path for folder creation and be sure to include 
the folder name. 
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 Now, touch the Create Folder button. 

Note: Disk Space data for Size, Free, and File(s) is available on the far 
right of the dialog for convenience. 

Preferences 

Preference Setup Overview 

A variety of customizable preferences can be set on your instrument. 
Access Preferences by touching Utilities → Preference Setup... on the 
menu bar. The main Preferences dialog is shown. 

 

The following sections cover the Preferences, Acquisition, E-Mail, Color, 
and Miscellaneous dialogs. 

Preferences 

Selecting Utilities → Preference Setup... shows the main Preferences 
dialog by default. The following controls are available from this dialog: 

 
Numbered sections on this dialog correspond with the following 
explanations. 

1. You can choose to have audible confirmation each time you touch 
a screen or front panel control by marking the Enable checkbox on 
the Audible Feedback section of the dialog. With Audible 
Feedback enabled, the oscilloscope beeps each time you touch 
the screen or a front panel control. 
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2. You can choose to have your instrument automatically re-calibrate 
itself whenever there is a significant change in ambient 
temperature by marking the Enable checkbox on the Automatic 
Calibration section of the dialog. 

Note: If you do not enable this option, the oscilloscope re-
calibrates only at startup and whenever you make a change to 
certain operating conditions. 

3. If the option is available on your oscilloscope, you can set up the 
oscilloscope to optimize either Analysis (acquisition and 
calculation speed) or Display (update rate/speed) using the 
buttons provided on the Optimize For section of the dialog. 

Available choices are presented as a spectrum with highest values 
at Analysis and Display extremes. 

Select one of the buttons for the desired performance 
optimization. 

An example reasoning for Analysis optimization would be its 
persistence or averaging usefulness. In such a case, giving higher 
priority to waveform acquisition at the expense of display update 
rate makes practical sense. 

Acquisition 

Access the Acquisition preference settings in the following manner: 

 
The Acquisition dialog. The Trigger Counter Setting checkbox is not available 

on all models. 

Numbered sections on this dialog correspond with the following 
explanations. 

1. On the Offset Setting constant in area of the dialog, touch either 
the Div or Volts button. 
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As you change the gain, this control allows you to either keep the 
vertical offset level indicator stationary (when Div is selected) or 
to have it move with the actual voltage level (when Volts is 
selected). The advantage of selecting Div is that the waveform 
remains on the grid as you increase the gain; whereas, if Volts is 
selected, the waveform could move off the grid. 

Note: Regardless of whether you select Volts or Div, the Offset 
shown in the channel setup dialog always indicates volts. 
However, when Div is selected for the Offset Control, the offset 
in volts is scaled proportional to the change in gain, thereby 
keeping the division on the grid constant. 

2. On the Delay Setting constant in area of the dialog, touch either 
the Time or Div button. 

As you change the timebase, this control allows you to either keep 
the horizontal offset indicator stationary (when Div is selected) or 
to have it move with the trigger point (when Time is selected). 

 The advantage of selecting Div is that the trigger point remains on 
the grid as you increase the timebase; whereas, if Time is 
selected, the trigger point could move off the grid. 

Note: Regardless of whether you select Time or Div, the Delay 
shown in the timebase setup dialog always indicates time. 
However, when Div is selected for Delay In, the delay in time is 
scaled proportional to the change in timebase, thereby keeping 
the division on the grid constant. 

3. If this checkbox control is available on your oscilloscope, you can 
mark the Reset trigger counter before starting a new acquisition 
checkbox on the Trigger Counter Setting area of the dialog. 
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This preference clears the trigger counter each time the 
oscilloscope issues an arm acquisition command and applies when 
you have set a trigger Holdoff condition in the Trigger dialog in 
either time or events: 

 

The default condition of this control is off (unchecked). 

ACQUISITION STATUS  

For each general category of oscilloscope operation, you can view a 
summary of your setups. Access these status dialogs by making the 
following menu bar selections: 

 Vertical → Channels Status 

 Timebase → Acquisition Status 

 Trigger → Acquisition Status 

 Math → Math Status, Zoom Status, or Memory Status 

In addition to these dialogs, summaries are also provided for XY setups, 
memory (M1-M4) setups, and time stamps for sequence mode sampling. 

E-Mail 

Before you can send e-mail from the oscilloscope, configurations must be 
made on this dialog. 

 

Numbered sections on this dialog correspond with the following 
explanations. 

1. On the E-Mail Server section of the dialog, choose a server 
protocol from the following options: 
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 MAPI (Messaging Application Programming Interface) is the 
Microsoft interface specification that allows different 
messaging and workgroup applications (including e-mail, 
voice mail, and fax) to work through a single client, such as 
the Exchange client . MAPI uses the default Windows e-mail 
application. 

 SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol 
for sending messages from one computer to another 
through a network. This protocol is used on the Internet to 
route e-mail. In many cases no account is needed. 

2. Provide values on controls for SMTP Server, Originator Address 
(From:), and Default Recipient Address (To:) on the Configuration 
section of the dialog based the MAPI or SMTP choice during the 
previous step. 

 If you chose MAPI, touch inside the Originator Address 
(From:) data entry field and provide the instrument's e-mail 
address. Then touch inside the Default Recipient Address 
(To:) data entry field and provide the recipient's e-mail 
address. 

 If you chose SMTP, touch inside the SMTP Server data 
entry field and provide the name of your server. Touch 
inside the Originator Address (From:) data entry field and 
provide the instrument's e-mail address. Then touch inside 
the Default Recipient Address (To:) data entry field and 
provide the recipient's e-mail address. 

3. The Overview of E-Mail modes section of the dialog provides 
helpful descriptions for your Server selection (made during the 
first step in this topic). 

4. Use the Send Test Mail button to ensure proper E-Mail 
configuration by way of sending a confirmation message. 
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Color 

You can customize the Colors used for Channels, Math, and Memory 
traces both when shown on your instrument and when used in print 
output. 

Note: These color settings match a waveform on the grid display (both 
on-screen and printed) and show consistently on corresponding 
dialogs, tables, and trace descriptor labels. 

 

Numbered sections on this dialog correspond with the following 
explanations. 

1. Make color selections for Channels (Screen and Print) by touching 
one of the color swatches. The Color pop-up control is shown and 
may be used to specify your desired color. 

2. Just like Channels, make color selections for Math Traces (Screen 
and Print) by touching one of the color swatches. The Color pop-
up control is shown and may be used to specify your desired color. 

3. Again, just like Channels, make color selections for Memory 
Traces (Screen and Print) by touching one of the color swatches. 
The Color pop-up control is shown and may be used to specify 
your desired color. 

4. You can use the Factory default colors button to instantly recall 
the original color settings for your instrument. 

Note: Print colors are used only when the Colors control is set to 
Print on the Hardcopy dialog in Utilities → Utilities Setup... 
allowing colors to still appear when printed on white paper in 
order to save ink/toner. For convenience, the Preview print 
colors button is provided on this portion of the dialog. When the 
button is touched, a preview is generated on the grid display 
area. A subsequent touch of the button closes the preview. 
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Miscellaneous 

Other Preference setting controls are shown on the Miscellaneous dialog 
as follows: 

 

Numbered sections on this dialog correspond with the following 
explanations. 

1. You can add the LeCroy Logo to hardcopies of your grid display 
waveforms by marking the Print LeCroy Logo When Printing Grid 
Area Only checkbox on the Hardcopy section of the dialog. 

2. You can adjust the Dimming and Control Sensitivity of Zoom 
traces as follows: 

 Use the Dimming control to choose select On, Off, and Auto 
values. This controls the darkening/shading of waveform areas not 
part of the Zoom trace. 

 Use Control Sensitivity to choose Legacy or Optimized values 
3. If you have Serial Data Debug Solutions installed on your 

oscilloscope, you can control Annotations being put On Trace (on 
all traces) or On Noisy Trace (only on noisy traces). 

4. You can shut off the SuperKnob Help flyout menu by un-marking 
the SuperKnob Help checkbox on the Other section of the dialog. 

System Recovery Tool 

Restoring Software Using the Acronis 
Application 

Your oscilloscope is designed to operate reliably for many years. The 
application software operating the instrument runs on a Windows 
platform. The loading or incomplete removal of additional Windows 
applications can cause problems in the stability of the operating system. 
Severe cases may require a reloading of the base operating system and 
oscilloscope application. 
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LeCroy provides you with an Acronis recovery application and a backup 
image in an extra partition on the instrument’s hard drive. 

PLEASE NOTE THE FOLLOWING:  

 The recovery process produces a replica of the operating system 
and oscilloscope application software at the current revision levels 
when the oscilloscope was manufactured. Any further revisions of 
the application software, Windows operating system, and virus 
scan definition files are not automatically upgraded. Therefore, 
after completion of the disk image recovery, it is highly 
recommended to search vendor Web sites and upgrade the 
individual components to current revision levels. 

 After the recovery procedure is completed, you must activate 
Windows, either by Internet connection to Microsoft’s Web site or 
by telephone. Have your Windows Product Key number (shown on 
a sticker on your oscilloscope) handy during Widows reactivation. 

 The current oscilloscope application software can be downloaded 
directly from the LeCroy website at www.lecroy.com. Since the 
calibration data for the oscilloscope is stored in the D: drive, 
current calibration constants are not overwritten during the 
recovery process. 

Since third-party recovery software is used, our instructions certainly 
may not be the most definitive or current. We advise you to take 
advantage of resources available on the Acronis website - they maintain 
versions of their product manuals from the following locations: 

Acronis True Image Home 

http://www.acronis.com/homecomputing/download/docs/ 

Acronis True Image Echo Workstation 

http://www.acronis.com/backup-recovery/advanced-
workstation/index.html 

Note: The following procedures cover basic steps for running the True 
Image Echo Workstation. For more definitive documentation refer to 
their aforementioned documentation resources. 

http://www.lecroy.com/
http://www.acronis.com/homecomputing/download/docs/
http://www.acronis.com/backup-recovery/advanced-workstation/index.html
http://www.acronis.com/backup-recovery/advanced-workstation/index.html
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LeCroy provides you with a recovery application and a backup image in 
an extra partition on the instrument’s hard drive. The recovery process is 
easy to perform, using the Recovery Wizard. After the recovery 
procedure is done, you must activate Windows, either by Internet 
connection to Microsoft’s Web site or by telephone. Have your Windows 
Product Key number (located on the rear of the oscilloscope) handy 
during Widows reactivation.  

Running the Acronis True Image Echo Workstation 
Recovery Application 

1. Connect a network cable to the LAN port on the rear of the 
oscilloscope if you intend to activate windows through the 
Internet. 

2. Connect a keyboard and a mouse to the oscilloscope. 
3. Apply power to the oscilloscope. 
4. As soon as the Starting Acronis Loader... Press F11 for Acronis 

Startup Recovery Manager message appears on the screen, press 
the F11 key until the recovery software logo appears momentarily. 
The Acronis True Image Echo Workstation main window is 
displayed. 

Note: Do not press F11 before you see the Starting Acronis 
Loader message or you will enter the MB boot sequence 
selection. 

5. Select Recovery from the Main Menu. The Restore Data Wizard 
opens. 

6. Click Next on the Welcome page. 
7. On the Backup Archive Selection page, you choose the zone 

where the recovery partition is located. Choose Acronis Secure 
Zone (this is where the recovery data is located on your 
oscilloscope) and click Next. 

8. On the Backup Date Selection page, choose the date when the 
backup was created and to which state you want to revert your 
system and click Next. 

9. On the Restoration Type Selection page, select Restore disks or 
partitions and click Next. 
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10. On the Partition or Disk to Restore page, select SYSTEM (C:) as 
the source and click Next. 

11. On the Restored Partition Type page, select Active and click Next. 

Note: If a window appears asking if you want to buy Acronis 
products, click Do not show this message again and click OK. 

12. The Restored Partition Size page displays the Partition size for the 
restoration. Nothing needs to be changed, simply click Next. 

13. On the Next Selection page, you will be asked if you want to 
restore another partition or hard disk drive. Select No, I do not 
and click Next. 

14. The Restoration Options page displays additional options, such as 
what to do after the restoration is complete and error handling. 
Simply click Next to use the default selections. 

15. A summary window is displayed indicating that Acronis True 
Image is ready to proceed with the recovery of the C: partition. 
Click Proceed to start the recovery process. 

Note: This takes approximately 4 to 15 minutes depending on 
the version of Operating system that is being restored. The 
progress is displayed on the screen 

16. Once the restoration is complete, an Information window is 
displayed indicating that the Data was successfully restored. Click 
OK. 

17. Click Operations → Exit. The oscilloscope will restart and begin 
installing the required software. A message is displayed asking if 
you want to install Microsoft Office PowerPoint Viewer.  

18. Click Yes to install PowerPoint Viewer. The InsallShield Wizard for 
Adobe Flash Player opens. 

19. To install Adobe Flash Player, click Install and then Finish. The X-
Stream software installer screen appears. 

20. Click Next to continue. The License Agreement page is displayed. 
21. Click I Agree. The Choose Components page is displayed.  
22. Select all X-Stream components and click Install. 
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Note: A Windows Security window may be displayed indicating 
that Windows can't verify the publisher of this driver software. 
Choose Install this driver software anyway and then click Install. 

23. When the X-Stream installation is completed, reboot the 
oscilloscope. 

Note: Now you must activate Windows® using an Internet 
connection to the Microsoft Web site or by telephone. When 
activating, have the Windows Product Key number handy (it is 
affixed to the rear of the oscilloscope). 

Restarting the Application 

Upon initial power-up, the oscilloscope automatically loads the 
instrument application software. If you exit the application and want to 
reload it, touch the shortcut icon on the desktop: 

 

Note: If you minimize the application, touch the appropriate task bar or 
desktop icon to maximize it:  

 

Restarting the Operating System 

If you need to restart the Windows® operating system, reboot the 
oscilloscope by pressing and holding in the power switch for 10 seconds, 
then turning the power on again. 
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Reference 

WaveRunner 6 Zi Specifications 

Note: Specifications are subject to change without notice. 

Please refer to the LeCroy website at www.lecroy.com or the online help 
on your LeCroy oscilloscope for detailed specification information. 

CERTIFICATIONS 

CE Compliant, UL, and cUL Listed 

CE Declaration of Conformity 

The oscilloscope meets requirements of EMC Directive 2004/108/EEC for 
Electromagnetic Compatibility and Low Voltage Directive 2006/95/EEC 
for Product Safety. 

EMC Directive 

 EN 61326-1:2006 

 EMC requirements for electrical equipment for measurement, 
control, and laboratory use.  

ELECTROMAGNETIC EMISSIONS: 

 EN 55011/A2:2002, Radiated and conducted emissions (Class A)* 

 EN 61000-3-2:2006 Harmonic Current Emissions (Class A) 

 EN 61000-3-3/A2:2005 Voltage Fluctuations and Flickers (Pst = 1)  

ELECTROMAGNETIC IMMUNITY: 

 EN 61000-4-2:2001** Electrostatic Discharge. 

(4 kV contact, 8 kV air, 4 kV vertical/horizontal coupling planes) 

 EN 61000-4-3:2006** RF Radiated Electromagnetic Field. 

(3 V/m, 80-1000 MHz; 3 V/m, 1400 MHz - 2 GHz; 1 V/m, 2 GHz - 
2.7 GHz) 

 EN 61000-4-4:2004** Electrical Fast Transient/Burst. 

(1 kV on power supply lines, 0.5 kV on I/O signal data and control 
lines) 

http://www.lecroy.com/
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 EN 61000-4-5:2006** Surges. 

(1 kV AC Mains, L-N, L-PE, N-PE) 

 EN 61000-4-6:2007** RF Conducted Electromagnetic Field. 

(3 Vrms, 0.15 MHz - 80 MHz) 

 EN 61000-4-11:2004† Mains Dips and Interruptions. 

(1 cycle voltage dip, 100% short interruption) 

  

* In order to conform to Radiated Emissions standards, use properly 
shielded cables on all I/O terminals. 

** Meets Performance Criteria "B" limits during the disturbance; product 
undergoes a temporary degradation or loss of function of performance 
which is self recoverable. 

† Meets Performance Criteria "C" limits during the disturbance; product 
undergoes a temporary degradation or loss of function of performance 
which requires operator intervention or system reset. 

 WARNING  

This is a Class A product. In a domestic environment this product may 
cause radio interference, in which case the user may be required to take 
appropriate measures. 

Low-Voltage Directive 

EN 61010-1:2001 

Safety requirements for electrical equipment for measurement, control, 
and laboratory use. 

The oscilloscope has been qualified to the following EN 61010-1 limits: 

 Installation Categories II (Mains Supply Connector) and I 
(Measuring Terminals). 

 Pollution Degree 2 (Normally only dry non-conductive pollution 
occurs. Occasionally a temporary conductivity caused by 
condensation must be expected.) 
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 Protection Class I (Provided with terminal for protective ground). 

UL and cUL 

The oscilloscope is UL and cUL listed and conforms to the following 
standards: 

 UL Standard: UL 61010-1 2nd Edition. 

 Canadian Standard: CSA-C22.2 No. 61010-1-04. 
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Contact LeCroy for Support 

Use the following regional contacts to find the appropriate support 
location nearest you. 

Whether you're looking for sales or technical support, our staff can 
provide assistance with installation, calibration, and product knowledge 
regarding a full-range of our software applications and accessories. 

You can also find contact information for our offices on the LeCroy Web 
sites shown for the following regions: 

Contact Your Local LeCroy Office for Sales and Technical Assistance 

United States and Canada - World Wide Corporate Office 

LeCroy Corporation 

700 Chestnut Ridge Road 

Chestnut Ridge, NY, 10977-6499 

Phone (Sales, Applications, and Service): 800-553-2769 (options 1, 2, and 3, 
respectively) or 845-425-2000 

Fax (Sales, Applications, and Service): 845-578-5985 

Email (Sales, Applications, and Service): contact.corp@lecroy.com 

Web Site: www.lecroy.com 

United States - Protocol 
Solutions Group 

LeCroy Corporation 

3385 Scott Boulevard 

Santa Clara, CA, 95054 

Phone (Sales and Service): 800-
909-7211 or 408-727-6600 

Phone (Support): 800-909-
7112 or 408-653-1260 

Fax (Sales, Service, and 
Support): 408-727-0800 

Email (Sales and Service): 
contact.corp@lecroy.com 

Email (Support): 

European Headquarters 

LeCroy Europe 

4, Rue Moïse Marcinhes 

Case postale 341 

1217 Meyrin 1 

Geneva 

Phone (Sales, Service, and Support): + 41 22 719 
2228, +41 22 719 23 23, and +41 22 719 22 77 use 

+44(1276)503 971 for Protocol Analyzers 

Fax (Sales and Service): +41 22 719 22 33 

Email (Sales, Service, and Support): 
contact.sa@lecroy.com, samir.shafik@lecroy.com, 

and applications.indirect@lecroy.com 

Web Site: http://www.lecroy.com/europe 

http://www.lecroy.com/
mailto:contact.corp@lecroy.com
mailto:contact.sa@lecroy.com
mailto:samir.shafik@lecroy.com
mailto:applications.indirect@lecroy.com
http://www.lecroy.com/europe
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Contact Your Local LeCroy Office for Sales and Technical Assistance 

psgsupport@lecroy.com 

Web Site: www.lecroy.com 

  

China 

LeCroy Corporation Beijing Office 
and Service Center 

Rm. 2001 - Office; Rm. 2002 - 
Service Center 

Unit A, Horizon Plaza 

No. 6, Zhichun Road, Haidian 

District 

Beijing 100088, 

China 

Phone: ++86 10 8280 0318 / 
0319 / 0320 

Phone Service: ++86 10 8280 
0245 

Fax (Sales and Support): +86 
10 8280 0316 

Web Site: 
http://www.lecroy.com.cn 

Korea - Seoul 

LeCroy Korea 

10th fl.Ildong Bldg. 

968-5 Daechi-dong, Gangnam-gu 

Seoul 135-280, Korea 

Phone (Sales and Support): ++ 82 2 3452 0400 

Fax (Sales and Support): ++ 82 2 3452 0490 

Web Site: http://www.lecroy.co.kr 

  

Singapore (Oscilloscopes) 

LeCroy Singapore Pte Ltd 

Blk 750C Chai Chee Road #02-08 

Technopark@ Chai Chee 

Singapore 469003 

Phone (Sales and Support): ++ 
65 64424880 

Fax (Sales and Support): ++ 65 
64427811 

Singapore (Protocol Analyzers) 

Genetron Singapore Pte Ltd 

37 Kallang Pudding Road, #08-08 

Tong Lee Building Block B 

Singapore 349315 

Phone (Sales and Support): ++ 65 9760-4682 

  

Taiwan 

LeColn Technology Co Ltd 

Far East Century Park, C3, 9F, 

Tokyo 

LeCroy Japan 

Hobunsya Funchu Bldg, 3F 

mailto:psgsupport@lecroy.com
http://www.lecroy.com/
http://www.lecroy.com.cn/
http://www.lecroy.co.kr/
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Contact Your Local LeCroy Office for Sales and Technical Assistance 

No. 2, Chien-8th Road, 

Chung-Ho City, 

Taipei Hsien, 

Taiwan, R.O.C. 

Phone (Sales and Support): ++ 
886 2 8226 1366 

Fax (Sales and Support): ++ 
886 2 8226 1368 

Email (Sales): 
sales_twn@lecoln.com.tw 

Web Site: 
http://www.lecoln.com.tw 

   

3-11-5, Midori-cho, Fuchu-Shi 

Tokyo, 183-0006 

Japan 

Phone (Sales and Support): ++ 81 4 2402 9400 

Fax (Sales and Support): ++ 81 4 2402 9586 

Web Site: www.lecroy.com/japan 

End-User License Agreement for LeCroy® X-
Stream Software 

IMPORTANT-READ CAREFULLY: THIS END-USER LICENSE AGREEMENT 
("EULA") IS A LEGAL AGREEMENT BETWEEN THE INDIVIDUAL OR ENTITY 
LICENSING THE SOFTWARE PRODUCT ("YOU" OR "YOUR") AND LECROY 
CORPORATION ("LECROY") FOR THE SOFTWARE PRODUCT(S) 
ACCOMPANYING THIS EULA, WHICH INCLUDE(S): COMPUTER 
PROGRAMS; ANY "ONLINE" OR ELECTRONIC DOCUMENTATION AND 
PRINTED MATERIALS PROVIDED BY LECROY HEREWITH 
("DOCUMENTATION"); ASSOCIATED MEDIA; AND ANY UPDATES (AS 
DEFINED BELOW) (COLLECTIVELY, THE "SOFTWARE PRODUCT").  BY 
USING AN INSTRUMENT TOGETHER WITH OR CONTAINING THE 
SOFTWARE PRODUCT, OR BY INSTALLING, COPYING, OR OTHERWISE 
USING THE SOFTWARE PRODUCT, IN WHOLE OR IN PART, YOU AGREE TO 
BE BOUND BY THE TERMS OF THIS EULA.  IF YOU DO NOT AGREE TO THE 
TERMS OF THIS EULA, DO NOT INSTALL, COPY, OR OTHERWISE USE THE 
SOFTWARE PRODUCT; YOU MAY RETURN THE SOFTWARE PRODUCT TO 
YOUR PLACE OF PURCHASE FOR A FULL REFUND.  

mailto:sales_twn@lecoln.com.tw
http://www.lecoln.com.tw/
http://www.lecroy.com/japan
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IN ADDITION, BY INSTALLING, COPYING, OR OTHERWISE USING ANY 
MODIFICATIONS, ENHANCEMENTS, NEW VERSIONS, BUG FIXES, OR 
OTHER COMPONENTS OF THE SOFTWARE PRODUCT THAT LECROY 
PROVIDES TO YOU SEPARATELY AS PART OF THE SOFTWARE PRODUCT 
("UPDATES"), YOU AGREE TO BE BOUND BY ANY ADDITIONAL LICENSE 
TERMS THAT ACCOMPANY SUCH UPDATES.  IF YOU DO NOT AGREE TO 
SUCH ADDITIONAL LICENSE TERMS, YOU MAY NOT INSTALL, COPY, OR 
OTHERWISE USE SUCH UPDATES.   

THE PARTIES CONFIRM THAT THIS AGREEMENT AND ALL RELATED 
DOCUMENTATION ARE AND WILL BE DRAFTED IN ENGLISH.  LES 
PARTIES AUX PRÉSENTÉS CONFIRMENT LEUR VOLONTÉ QUE CETTE 
CONVENTION DE MÊME QUE TOUS LES DOCUMENTS Y COMPRIS TOUT 
AVIS QUI S’Y RATTACHÉ, SOIENT REDIGÉS EN LANGUE ANGLAISE. 

1. GRANT OF LICENSE. 

1.1. License Grant. Subject to the terms and conditions of this 
EULA and payment of all applicable fees, LeCroy grants to you a 
nonexclusive, nontransferable license (the “License”) to: (a) 
operate the Software Product as provided or installed, in object 
code form, for your own internal business purposes, (i) for use in 
or with an instrument provided or manufactured by LeCroy (an 
“Instrument”), (ii) for testing your software product(s) (to be used 
solely by you) that are designed to operate in conjunction with an 
Instrument (“Your Software”), and (iii) make one copy for archival 
and back-up purposes; (b) make and use copies of the 
Documentation; provided that such copies will be used only in 
connection with your licensed use of the Software Product, and 
such copies may not be republished or distributed (either in hard 
copy or electronic form) to any third party; and (c) copy, modify, 
enhance and prepare derivative works (“Derivatives”) of the 
source code version of those portions of the Software Product set 
forth in and identified in the Documentation as “Samples” 
(“Sample Code”) for the sole purposes of designing, developing, 
and testing Your Software.  
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If you are an entity, only one designated individual within your 
organization, as designated by you, may exercise the License; 
provided that additional individuals within your organization may 
assist with respect to reproducing and distributing Sample Code as 
permitted under Section 1.1(c)(ii).  LeCroy reserves all rights not 
expressly granted to you.  No license is granted hereunder for any 
use other than that specified herein, and no license is granted for 
any use in combination or in connection with other products or 
services (other than Instruments and Your Software) without the 
express prior written consent of LeCroy. The Software Product is 
licensed as a single product. Its component parts may not be 
separated for use by more than one user.  This EULA does not 
grant you any rights in connection with any trademarks or service 
marks of LeCroy.  The Software Product is protected by copyright 
laws and international copyright treaties, as well as other 
intellectual property laws and treaties. The Software Product is 
licensed, not sold.  The terms of this printed, paper EULA 
supersede the terms of any on-screen license agreement found 
within the Software Product. 

1.2. Upgrades. If the Software Product is labeled as an "upgrade," 
(or other similar designation) the License will not take effect, and 
you will have no right to use or access the Software Product unless 
you are properly licensed to use a product identified by LeCroy as 
being eligible for the upgrade ("Underlying Product").  A Software 
Product labeled as an "upgrade" replaces and/or supplements the 
Underlying Product.  You may use the resulting upgraded product 
only in accordance with the terms of this EULA. If the Software 
Product is an upgrade of a component of a package of software 
programs that you licensed as a single product, the Software 
Product may be used and transferred only as part of that single 
product package and may not be separated for use on more than 
one computer. 
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1.3. Limitations. Except as specifically permitted in this EULA, you 
will not directly or indirectly (a) use any Confidential Information 
to create any software or documentation that is similar to any of 
the Software Product or Documentation; (b) encumber, transfer, 
rent, lease, time-share or use the Software Product in any service 
bureau arrangement; (c) copy (except for archival purposes), 
distribute, manufacture, adapt, create derivative works of, 
translate, localize, port or otherwise modify the Software Product 
or the Documentation; (d) permit access to the Software Product 
by any party developing, marketing or planning to develop or 
market any product having functionality similar to or competitive 
with the Software Product; (e) publish benchmark results relating 
to the Software Product, nor disclose Software Product features, 
errors or bugs to third parties; or (f) permit any third party to 
engage in any of the acts proscribed in clauses (a) through (e).  In 
jurisdictions in which transfer is permitted, notwithstanding the 
foregoing prohibition, transfers will only be effective if you 
transfer a copy of this EULA, as well as all copies of the Software 
Product, whereupon your right to use the Software product will 
terminate.  Except as described in this Section 1.3, You are not 
permitted (i) to decompile, disassemble, reverse compile, reverse 
assemble, reverse translate or otherwise reverse engineer the 
Software Product, (ii) to use any similar means to discover the 
source code of the Software Product or to discover the trade 
secrets in the Software Product, or (iii) to otherwise circumvent 
any technological measure that controls access to the Software 
Product.  You may reverse engineer or otherwise circumvent the 
technological measures protecting the Software Product for the 
sole purpose of identifying and analyzing those elements that are 
necessary to achieve Interoperability (the "Permitted Objective") 
only if: (A) doing so is necessary to achieve the Permitted 
Objective and it does not constitute infringement under Title 17 of 
the United States Code; (B) such circumvention is confined to 
those parts of the Software Product and to such acts as are 
necessary to achieve the Permitted Objective; (C) the information 
to be gained thereby has not already been made readily available 
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to you or has not been provided by LeCroy within a reasonable 
time after a written request by you to LeCroy to provide such 
information; (D) the information gained is not used for any 
purpose other than the Permitted Objective and is not disclosed 
to any other person except as may be necessary to achieve the 
Permitted Objective; and (E) the information obtained is not used 
(1) to create a computer program substantially similar in its 
expression to the Software Product including, but not limited to, 
expressions of the Software Product in other computer languages, 
or (2) for any other act restricted by LeCroy’s intellectual property 
rights in the Software Product.  "Interoperability" will have the 
same meaning in this EULA as defined in the Digital Millennium 
Copyright Act, 17 U.S.C. §1201(f), the ability of computer 
programs to exchange information and of such programs mutually 
to use the information which has been exchanged.  

1.4.  PRERELEASE CODE. Portions of the Software Product may be 
identified as prerelease code ("Prerelease Code").  Prerelease 
Code is not at the level of performance and compatibility of the 
final, generally available product offering. The Prerelease Code 
may not operate correctly and may be substantially modified prior 
to first commercial shipment. LeCroy is not obligated to make this 
or any later version of the Prerelease Code commercially available. 
The License with respect to the Prerelease Code terminates upon 
availability of a commercial release of the Prerelease Code from 
LeCroy. 

2. SUPPORT SERVICES. 

At LeCroy’s sole discretion, from time to time, LeCroy may provide 
Updates to the Software Product.  LeCroy shall have no obligation 
to revise or update the Software Product or to support any version 
of the Software Product.  At LeCroy’s sole discretion, upon your 
request, LeCroy may provide you with support services related to 
the Software Product ("Support Services") pursuant to the LeCroy 
policies and programs described in the Documentation or 
otherwise then in effect, and such Support Services will be subject 
to LeCroy’s then-current fees therefor, if any.  Any Update or 
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other supplemental software code provided to you pursuant to 
the Support Services will be considered part of the Software 
Product and will be subject to the terms and conditions of this 
EULA.  LeCroy may use any technical information you provide to 
LeCroy during LeCroy’s provision of Support Services, for LeCroy’s 
business purposes, including for product support and 
development.  LeCroy will not utilize such technical information in 
a form that personally identifies you. 

3. PROPRIETARY RIGHTS. 

3.1. Right and Title. All right, title and interest in and to the 
Software Product and Documentation (including but not limited to 
any intellectual property or other proprietary rights, images, icons, 
photographs, text, and "applets" embodied in or incorporated into 
the Software Product, collectively, "Content"), and all Derivatives, 
and any copies thereof are owned by LeCroy and/or its licensors 
or third-party suppliers, and is protected by applicable copyright 
or other intellectual property laws and treaties.  You will not take 
any action inconsistent with such title and ownership.  This EULA 
grants you no rights to use such Content outside of the proper 
exercise of the license granted hereunder, and LeCroy will not be 
responsible or liable therefor. 

3.2. Intellectual Property Protection. You may not alter or remove 
any printed or on-screen copyright, trade secret, proprietary or 
other legal notices contained on or in copies of the Software 
Product or Documentation. 

3.3. Confidentiality. Except for the specific rights granted by this 
EULA, neither party shall use or disclose any Confidential 
Information (as defined below) of the other party without the 
written consent of the disclosing party.  A party receiving 
Confidential Information from the other shall use the highest 
commercially reasonable degree of care to protect the 
Confidential Information, including ensuring that its employees 
and consultants with access to such Confidential Information have 
agreed in writing not to disclose the Confidential Information.  
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You shall bear the responsibility for any breaches of confidentiality 
by your employees and consultants.  Within ten (10) days after 
request of the disclosing party, and in the disclosing party's sole 
discretion, the receiving party shall either return to the disclosing 
party originals and copies of any Confidential Information and all 
information, records and materials developed therefrom by the 
receiving party, or destroy the same, other than such Confidential 
Information as to which this EULA expressly provides a continuing 
right to the receiving party to retain at the time of the request. 
 Either party may only disclose the general nature, but not the 
specific financial terms, of this EULA without the prior consent of 
the other party; provided either party may provide a copy of this 
EULA to any finance provider in conjunction with a financing 
transaction, if such provider agrees to keep this EULA confidential. 
  Nothing herein shall prevent a receiving party from disclosing all 
or part of the Confidential Information as necessary pursuant to 
the lawful requirement of a governmental agency or when 
disclosure is required by operation of law; provided that prior to 
any such disclosure, the receiving party shall use reasonable 
efforts to (a) promptly notify the disclosing party in writing of such 
requirement to disclose, and (b) cooperate fully with the 
disclosing party in protecting against any such disclosure or 
obtaining a protective order.  Money damages will not be an 
adequate remedy if this Section 4.3 is breached and, therefore, 
either party shall, in addition to any other legal or equitable 
remedies, be entitled to seek an injunction or similar equitable 
relief against such breach or threatened breach without the 
necessity of posting any bond.  As used herein, "Confidential 
Information" means LeCroy pricing or information concerning new 
LeCroy products, trade secrets (including without limitation all 
internal header information contained in or created by the 
Software Product, all benchmark and performance test results and 
all Documentation) and other proprietary information of LeCroy; 
and any business, marketing or technical information disclosed by 
LeCroy, or its representatives, or you in relation to this EULA, and 
either (i) disclosed in writing and marked as confidential at the 
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time of disclosure or (ii) disclosed in any other manner such that a 
reasonable person would understand the nature and 
confidentiality of the information.  Confidential Information does 
not include information (A) already in the possession of the 
receiving party without an obligation of confidentiality to the 
disclosing party, (B) hereafter rightfully furnished to the receiving 
party by a third party without a breach of any separate 
nondisclosure obligation to the disclosing party, (C) publicly 
known without breach of this EULA, (d) furnished by the disclosing 
party to a third party without restriction on subsequent 
disclosure, or (e) independently developed by the receiving party 
without reference to or reliance on the Confidential Information. 

4. TERMINATION. 

This EULA will remain in force until termination pursuant to the 
terms hereof.  You may terminate this EULA at any time.  This 
EULA will also terminate if you breach any of the terms or 
conditions of this EULA.  You agree that if this EULA terminates for 
any reason, the License will immediately terminate and you will 
destroy all copies of the Software Product (and all Derivatives), 
installed or otherwise, the Documentation, and the Confidential 
Information  (and all derivatives of any of the foregoing) that are 
in your possession or under your control. The provisions of 
Sections 1.3, 4, 6, 7, 8, and 9 will survive any termination or 
expiration hereof. 

5. U.S. GOVERNMENT RESTRICTED RIGHTS. 

If any Software Product or Documentation is acquired by or on 
behalf of a unit or agency of the United States Government (any 
such unit or agency, the "Government"), the Government agrees 
that the Software Product or Documentation is "commercial 
computer software" or "commercial computer software 
documentation" and that, absent a written agreement to the 
contrary, the Government’s rights with respect to the Software 
Product or Documentation are, in the case of civilian agency use, 
Restricted Rights, as defined in FAR §52.227.19, and if for 
Department of Defense use, limited by the terms of this EULA, 



Getting Started Manual 

WR6Zi-GSM-E 198 

pursuant to DFARS §227.7202.  The use of the Software Product or 
Documentation by the Government constitutes acknowledgment 
of LeCroy’s proprietary rights in the Software Product and 
Documentation.  Manufacturer is LeCroy Corporation, 700 
Chestnut Ridge Road, Chestnut Ridge, NY 10977 USA. 

6. EXPORT RESTRICTIONS. 

You agree that you will not export or re-export the Software 
Product, any part thereof, or any process or service that is the 
direct product of the Software Product (the foregoing collectively 
referred to as the "Restricted Components"), to any country, 
person, entity or end user subject to U.S. export restrictions.  You 
specifically agree not to export or re-export any of the Restricted 
Components (a) to any country to which the U.S. has embargoed 
or restricted the export of goods or services, which currently 
include, but are not necessarily limited to Cuba, Iran, Iraq, Libya, 
North Korea, Sudan and Syria, or to any national of any such 
country, wherever located, who intends to transmit or transport 
the Restricted Components back to such country; (b) to any end 
user who you know or have reason to know will utilize the 
Restricted Components in the design, development or production 
of nuclear, chemical or biological weapons; or (c) to any end-user 
who has been prohibited from participating in U.S. export 
transactions by any federal agency of the U.S. government. You 
warrant and represent that neither the BXA nor any other U.S. 
federal agency has suspended, revoked or denied your export 
privileges. It is your responsibility to comply with the latest United 
States export regulations, and you will defend and indemnify 
LeCroy from and against any damages, fines, penalties, 
assessments, liabilities, costs and expenses (including reasonable 
attorneys' fees and court costs) arising out of any claim that the 
Software Product, Documentation, or other information or 
materials provided by LeCroy hereunder were exported or 
otherwise accessed, shipped or transported in violation of 
applicable laws and regulations. 
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7. RISK ALLOCATION. 

7.1. No Warranty. THE SOFTWARE PRODUCT IS NOT ERROR-FREE 
AND THE SOFTWARE PRODUCT AND SUPPORT SERVICES IS/ARE 
BEING PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. 
 LECROY, FOR ITSELF AND ITS SUPPLIERS, HEREBY DISCLAIMS ALL 
WARRANTIES, WHETHER EXPRESS OR IMPLIED, ORAL OR 
WRITTEN, WITH RESPECT TO THE SOFTWARE PRODUCT OR ANY 
SUPPORT SERVICES INCLUDING, WITHOUT LIMITATION, ALL 
IMPLIED WARRANTIES OF TITLE OR NON-INFRINGEMENT, 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
ACCURACY, INTEGRATION, VALIDITY, EXCLUSIVITY, 
MERCHANTABILITY, NON-INTERFERENCE WITH ENJOYMENT, 
FITNESS FOR ANY PARTICULAR PURPOSE, AND ALL WARRANTIES 
IMPLIED FROM ANY COURSE OF DEALING OR USAGE OF TRADE. 
YOU ACKNOWLEDGE THAT NO WARRANTIES HAVE BEEN MADE 
TO YOU BY OR ON BEHALF OF LECROY OR OTHERWISE FORM THE 
BASIS FOR THE BARGAIN BETWEEN THE PARTIES. 

7.2. Limitation of Liability. LECROY’S LIABILITY FOR DAMAGES FOR 
ANY CAUSE WHATSOEVER, REGARDLESS OF THE FORM OF ANY 
CLAIM OR ACTION, SHALL NOT EXCEED THE GREATER OF THE 
AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE PRODUCT 
OR U.S.$5.00; PROVIDED THAT IF YOU HAVE ENTERED INTO A 
SUPPORT SERVICES AGREEMENT WITH LECROY, LECROY’S ENTIRE 
LIABILITY REGARDING SUPPORT SERVICES WILL BE GOVERNED BY 
THE TERMS OF THAT AGREEMENT.  LECROY SHALL NOT BE LIABLE 
FOR ANY LOSS OF PROFITS, LOSS OF USE, LOSS OF DATA, 
INTERRUPTION OF BUSINESS, NOR FOR INDIRECT, SPECIAL, 
INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES OF ANY 
KIND, WHETHER UNDER THIS EULA OR OTHERWISE ARISING IN 
ANY WAY IN CONNECTION WITH THE SOFTWARE PRODUCT, THE 
DOCUMENTATION OR THIS EULA.  SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE EXCLUSION OR 
LIMITATION MAY NOT APPLY TO YOU.  THESE LIMITATIONS ARE 
INDEPENDENT FROM ALL OTHER PROVISIONS OF THIS EULA AND 
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SHALL APPLY NOTWITHSTANDING THE FAILURE OF ANY REMEDY 
PROVIDED HEREIN. 

7.3. Indemnification. You will defend, indemnify and hold 
harmless LeCroy and its officers, directors, affiliates, contractors, 
agents, and employees from, against and in respect of any and all 
assessments, damages, deficiencies, judgments, losses, obligations 
and liabilities (including costs of collection and reasonable 
attorneys’ fees, expert witness fees and expenses) imposed upon 
or suffered or incurred by them arising from or related to your use 
of the Software Product. 

8. GENERAL PROVISIONS. 

8.1. Compliance with Laws. You will comply with all laws, 
legislation, rules, regulations, and governmental requirements 
with respect to the Software Product, and the performance by you 
of your obligations hereunder, of any jurisdiction in or from which 
you directly or indirectly cause the Software Product to be used or 
accessed. 

8.2. No Agency. Nothing contained in this EULA will be deemed to 
constitute either party as the agent or representative of the other 
party, or both parties as joint venturers or partners for any 
purpose. 

8.3. Entire Agreement; Waiver; Severability. This EULA 
constitutes the entire agreement between the parties with regard 
to the subject matter hereof.  No provision of, right, power or 
privilege under this EULA will be deemed to have been waived by 
any act, delay, omission or acquiescence by LeCroy, its agents, or 
employees, but only by an instrument in writing signed by an 
authorized officer of LeCroy.  No waiver by LeCroy of any breach 
or default of any provision of this EULA by you will be effective as 
to any other breach or default, whether of the same or any other 
provision and whether occurring prior to, concurrent with, or 
subsequent to the date of such waiver.  If any provision of this 
EULA is declared by a court of competent jurisdiction to be invalid, 
illegal or unenforceable, such provision will be severed from this 
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EULA and all the other provisions will remain in full force and 
effect. 

8.4. Governing Law;  Jurisdiction; Venue. This EULA will be 
governed by and construed in accordance with the laws of the 
State of New York, USA, without regard to its choice of law 
provisions.  The United Nations Convention on Contracts for the 
International Sale of Goods will not apply to this EULA.  Exclusive 
jurisdiction and venue for any litigation arising under this EULA is 
in the federal and state courts located in New York, New York, 
USA and both parties hereby consent to such jurisdiction and 
venue for this purpose. 

8.5. Assignment. This EULA and the rights and obligations 
hereunder, may not be assigned, in whole or in part by you, 
except to a successor to the whole of your business, without the 
prior written consent of LeCroy.  In the case of any permitted 
assignment or transfer of or under this EULA, this EULA or the 
relevant provisions will be binding upon, and inure to the benefit 
of, the successors, executors, heirs, representatives, 
administrators and assigns of the parties hereto. 

8.6. Notices. All notices or other communications between LeCroy 
and you under this EULA will be in writing and delivered 
personally, sent by confirmed fax, by confirmed e-mail, by 
certified mail, postage prepaid and return receipt requested, or by 
a nationally recognized express delivery service.  All notices will be 
in English and will be effective upon receipt. 

8.7. Headings. The headings used in this EULA are intended for 
convenience only and will not be deemed to supersede or modify 
any provisions. 

8.8. Acknowledgment. Licensee acknowledges that (a) it has read 
and understands this EULA, (b) it has had an opportunity to have 
its legal counsel review this EULA, (c) this EULA has the same force 
and effect as a signed agreement, and (d) issuance of this EULA 
does not constitute general publication of the Software Product or 
other Confidential Information. 
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Windows® License Agreement 

LeCroy's agreement with Microsoft prohibits users from running 
software on LeCroy X-Stream oscilloscopes that is not relevant to 
measuring, analyzing, or documenting waveforms. 
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Thank you for purchasing a 

WaveRunner 6 Zi oscilloscope. 


